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Please read this Operation Guide before using the printer.
o Keep it close to the printer for easy reference.
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Please read the Operation Guide before using the printer.
Keep it close to the printer for easy reference.

The sections of this guide and parts of the printer marked with
symbols are safety warnings meant to protect the user, other in-
dividuals and surrounding objects, and ensure correct and safe
usage of the printer. The symbols and their meanings are indi-
cated below.

A\ WARNING: Indicates that serious injury or even death may
result from insufficient attention to or incorrect compliance with
the related points.

A CAUTION: Indicates that personal injury or mechanical
damage may result from insufficient attention to or incorrect
compliance with the related points.

Symbols
The A symbol indicates that the related section includes safety
warnings. Specific points of attention are indicated inside the

symbol.
A ....... [General warning]

A ....... [Warning of danger of electrical shock]

& ....... [Warning of high temperature]

The © symbol indicates that the related section includes infor-
mation on prohibited actions. Specifics of the prohibited action
are indicated inside the symbol.

® ........ [Warning of prohibited action]
® ......... [Disassembly prohibited]

The @ symbol indicates that the related section includes infor-
mation on actions which must be performed. Specifics of the re-
quired action are indicated inside the symbol.

0 ......... [Alert of required action]

% ........ [Remove the power plug from the outlet]

9 ........ [Always connect the printer to an outlet
with a ground connection]

Please contact your service representative to order a replace-
ment if the safety warnings in the guide are illegible or if the
guide itself is missing. (fee required)

Caution

NO LIABILITY IS ASSUMED FOR ANY DAMAGE CAUSED BY
IMPROPER INSTALLATION.

Notice on Software

SOFTWARE USED WITH THIS PRINTER MUST SUPPORT
THE PRINTER’S EMULATION MODE. The printer is factory-set
to emulate the PCL. The emulation mode can be changed by fol-
lowing the procedures described in Chapter 3.

Notice

The information in this guide is subject to change without notifi-
cation. Additional pages may be inserted in future editions. The
user is asked to excuse any technical inaccuracies or typograph-
ical errors in the present edition.

No responsibility is assumed if accidents occur while the user is
following the instructions in this guide. No responsibility is as-
sumed for defects in the printer’s firmware (contents of its read-
only memory).

This guide, any copyrightable subject matter sold or provided
with or in connection with the sale of the page printer, are pro-
tected by copyright. All rights are reserved. Copying or other re-
production of all or part of this guide, any copyrightable subject
matter without the prior written consent of Kyocera Corporation
is prohibited. Any copies made of all or part of this guide, any
copyrightable subject must contain the same copyright notice as
the material from which the copying is done.

Regarding Tradenames

PRESCRIBE is a registered trademark of Kyocera Corporation.
KPDL and KIR (Kyocera Image Refinement) are trademarks of
Kyocera Corporation.

Diablo 630 is a product of Xerox Corporation. IBM Proprinter
X24E is a product of International Business Machines Corpora-
tion. Epson LQ-850 is a product of Seiko Epson Corporation.

Hewlett-Packard, PCL, and PJL are registered trademarks of
Hewlett-Packard Company. Centronics is a trade name of Cen-
tronics Data Computer Inc. PostScript is a registered trademark
of Adobe Systems Incorporated. Macintosh is a registered trade-
mark of Apple computer, Inc. Microsoft, Windows, and Windows
NT are registered trademarks of Microsoft Corporation. Power-
PC is trademark of International Business Machines Corpora-
tion. CompactFlash is a trademark of SanDisk Corporation.
ENERGY STAR is a U.S. registered mark. All other brand and
product names are registered trademarks or trademarks of their
respective companies.

This Kyocera Mita page printer uses PeerlessPrintXL to provide
the HP LaserJet compatible PCL 6 language emulation. Peer-
lessPrintXL is a trademark of The Peerless Group, Redondo
Beach, CA 90278, U.S.A.

This product was developed using the Tornado™ Real Time Op-
erating System and Tools from Wind River Systems.

AGFA <> This printer contains UFST™ and MicroType® from
Agfa Corporation.



IBM PROGRAM LICENSE AGREEMENT

THE DEVICE YOU HAVE PURCHASED CONTAINS ONE OR
MORE SOFTWARE PROGRAMS (“PROGRAMS”) WHICH BE-
LONG TO INTERNATIONAL BUSINESS MACHINES CORPO-
RATION (“IBM”). THIS DOCUMENT DEFINES THE TERMS
AND CONDITIONS UNDER WHICH THE SOFTWARE IS BE-
ING LICENSED TO YOU BY IBM. IF YOU DO NOT AGREE
WITH THE TERMS AND CONDITIONS OF THIS LICENSE,
THEN WITHIN 14 DAYS AFTER YOUR ACQUISITION OF THE
DEVICE YOU MAY RETURN THE DEVICE FOR A FULL RE-
FUND. IF YOU DO NOT SO RETURN THE DEVICE WITHIN
THE 14 DAYS, THEN YOU WILL BE ASSUMED TO HAVE
AGREED TO THESE TERMS AND CONDITIONS.

The Programs are licensed not sold. IBM, or the applicable IBM
country organization, grants you a license for the Programs only
in the country where you acquired the Programs. You obtain no
rights other than those granted you under this license.

The term “Programs” means the original and all whole or partial
copies of it, including modified copies or portions merged into
other programs. IBM retains title to the Programs. IBM owns, or
has licensed from the owner, copyrights in the Programs.

1. License

Under this license, you may use the Programs only with the de-
vice on which they are installed and transfer possession of the
Programs and the device to another party.

If you transfer the Programs, you must transfer a copy of this li-
cense and any other documentation to the other party. Your li-
cense is then terminated. The other party agrees to these terms
and conditions by its first use of the Program.

You may not:

1) use, copy, modify, merge, or transfer copies of the Program
except as provided in this license;

2) reverse assemble or reverse compile the Program; or

3) sublicense, rent, lease, or assign the Program.

2. Limited Warranty
The Programs are provided “AS 1S.”

THERE ARE NO OTHER WARRANTIES COVERING THE
PROGRAMS (OR CONDITIONS), EXPRESS OR IMPLIED, IN-
CLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRAN-
TIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE.

Some jurisdictions do not allow the exclusion of implied warran-
ties, so the above exclusion may not apply to you.

3. Limitation of Remedies

IBM’s entire liability under this license is the following;

1) For any claim (including fundamental breach), in any form, re-
lated in any way to this license, IBM’s liability will be for actual
damages only and will be limited to the greater of:

a) the equivalent of U.S.$25,000 in your local currency; or
b) IBM’s then generally available license fee for the Program

This limitation will not apply to claims for bodily injury or damag-
es to real or tangible personal property for which IBM is legally
liable.

IBM will not be liable for any lost profits, lost savings, or any in-
cidental damages or other economic consequential damages,
even if IBM, or its authorized supplier, has been advised of the
possibility of such damages. IBM will not be liable for any dam-
ages claimed by you based on any third party claim. This limita-
tion of remedies also applies to any developer of Programs
supplied to IBM. IBM’s and the developer’s limitations of reme-
dies are not cumulative. Such a developer is an intended bene-
ficiary of this Section. Some jurisdictions do not allow these
limitations or exclusions, so they may not apply to you.

4. General

You may terminate your license at any time. IBM may terminate
your license if you fail to comply with the terms and conditions of
this license. In either event, you must destroy all your copies of
the Program. You are responsible for payment of any taxes, in-
cluding personal property taxes, resulting from this license. Nei-
ther party may bring an action, regardless of form, more than two
years after the cause of action arose. If you acquired the Pro-
gram in the United States, this license is governed by the laws of
the State of New York. If you acquired the Program in Canada,
this license is governed by the laws of the Province of Ontario.
Otherwise, this license is governed by the laws of the country in
which you acquired the Program.

Typeface Trademark Acknowledgement

All resident fonts in this printer are licensed from Agfa Corpora-
tion.

Helvetica, Palatino and Times are registered trademarks of Lino-
type-Hell AG.

ITC Avant Garde Gothic, ITC Bookman, ITC ZapfChancery and
ITC Zapf Dingbats are registered trademarks of International
Typeface Corporation.

Agfa Japan License Agreement

1. “Software” shall mean the digitally encoded, machine reada-
ble, scalable outline data as encoded in a special format as
well as the UFST Software.

2. You agree to accept a non-exclusive license to use the Soft-
ware to reproduce and display weights, styles and versions
of letters, numerals, characters and symbols (“Typefaces”)
solely for your own customary business or personal purpos-
es at the address stated on the registration card you return
to Agfa Japan. Under the terms of this License Agreement,
you have the right to use the Fonts on up to three printers. If
you need to have access to the fonts on more than three
printers, you need to acquire a multi-user license agreement
which can be obtained from Agfa Japan. Agfa Japan retains
all rights, title and interest to the Software and Typefaces and
no rights are granted to you other than a License to use the
Software on the terms expressly set forth in this Agreement.

3. To protect proprietary rights of Agfa Japan, you agree to
maintain the Software and other proprietary information con-
cerning the Typefaces in strict confidence and to establish
reasonable procedures regulating access to and use of the
Software and Typefaces.



11.

12.

. You agree not to duplicate or copy the Software or Typefac-

es, except that you may make one backup copy. You agree
that any such copy shall contain the same proprietary notices
as those appearing on the original.

This License shall continue until the last use of the Software
and Typefaces, unless sooner terminated. This License may
be terminated by Agfa Japan if you fail to comply with the
terms of this License and such failure is not remedied within
thirty (30) days after notice from Agfa Japan. When this Li-
cense expires or is terminated, you shall either return to Agfa
Japan or destroy all copies of the Software and Typefaces
and documentation as requested.

. You agree that you will not modify, alter, disassemble, de-

crypt, reverse engineer or decompile the Software.

Agfa Japan warrants that for ninety (90) days after delivery,
the Software will perform in accordance with Agfa Japan-
published specifications, and the diskette will be free from
defects in material and workmanship. Agfa Japan does not
warrant that the Software is free from all bugs, errors and
omissions.

THE PARTIES AGREE THAT ALL OTHER WARRANTIES,
EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF
FITNESS FOR A PARTICULAR PURPOSE AND MER-
CHANTABILITY, ARE EXCLUDED.

. Your exclusive remedy and the sole liability of Agfa Japan in

connection with the Software and Typefaces is repair or re-
placement of defective parts, upon their return to Agfa Ja-
pan.

IN NO EVENT WILL AGFA JAPAN BE LIABLE FOR LOST
PROFITS, LOST DATA, OR ANY OTHER INCIDENTAL OR
CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
CAUSED BY ABUSE OR MISAPPLICATION OF THE
SOFTWARE AND TYPEFACES.

New York, U.S.A. law governs this Agreement.

.You shall not sublicense, sell, lease, or otherwise transfer

the Software and/or Typefaces without the prior written con-
sent of Agfa Japan.

Use, duplication or disclosure by the Government is subject
to restrictions as set forth in the Rights in Technical Data and
Computer Software clause at FAR 252-227-7013, subdivi-
sion (b)(3)(ii) or subparagraph (c)(1)(ii), as appropriate. Fur-
ther use, duplication or disclosure is subject to restrictions
applicable to restricted rights software as set forth in FAR
52.227-19 (c)(2).

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS
AGREEMENT, UNDERSTAND IT, AND AGREE TO BE
BOUND BY ITS TERMS AND CONDITIONS. NEITHER
PARTY SHALL BE BOUND BY ANY STATEMENT OR REP-
RESENTATION NOT CONTAINED IN THIS AGREEMENT.
NO CHANGE IN THIS AGREEMENT IS EFFECTIVE UN-
LESS WRITTEN AND SIGNED BY PROPERLY AUTHOR-
IZED REPRESENTATIVES OF EACH PARTY. BY
OPENING THIS DISKETTE PACKAGE, YOU AGREE TO
ACCEPT THE TERMS AND CONDITIONS OF THIS
AGREEMENT.
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Introduction

The Kyocera Mita page printer has many desirable features,
such as the EcoPrint function that reduces the power consump-
tion and the Auto Media Type Selection function that selects the
media automatically before printing. If you install the option doc-
ument finisher to the printer, you can also make stitching.

This section explains the following topics:

* For More Information...
* Guide to the Operation Guide

1. For More Information...

Item Description

Installation Guide
(paper manual)

Describes procedures from
the printer setup to printing a
test page.

Operation Guide
(this manual)

Guides you through topics
concerning the operations and
maintenance of the printer.

Describes how to install and
set the printer driver. This
guide is contained in the latter
half of this guide.

Describes how to use the
PRESCRIBE commands and
their parameters in detail for
experienced users. This man-
ual is contained in the CD-
ROM supplied with the printer.

Printer Driver Guide

PRESCRIBE
Programming Manual

PDF417 Two-Dimensional Bar | Includes a PDF417 overview
Code Implementation Manual | and explains PRESCRIBE com-
mands for use with two-dimen-
sional barcodes. This manual is
contained in the CD-ROM sup-
plied with the printer.

2. Guide to the Operation Guide

This Operation Guide has the following chapters:

Chapter 1 Names of Parts
This chapter explains the name and function of each part of the
printer.

Chapter 2 How to Load Paper
This chapter explains how to load paper into the paper cassette
and MP tray.

Chapter 3 Using the Operator Panel

This chapter explains the message display, indicators and keys
on the operator panel, and how to make various settings from
the operator panel.

Chapter 4 Troubleshooting
This chapter explains how to handle printer problems that may
occur, such as paper jams.

Chapter 5 Paper Selection
This chapter explains the types of paper that can be used with
the printer.

Chapter 6 Maintenance
This chapter explains how to replace the toner container, waste
toner box, and how to care for your printer.

Appendix A Fonts
This appendix explains about fonts and lists the printer’s internal
fonts.

Appendix B Expansion Memory
This appendix explains how to expand the printer's memory.

Appendix C Host Computer Interface
This appendix explains the pin assignment and specifications for
the printer’s parallel interface and serial interface.

Appendix D Option Units
This appendix introduces the available options for use with the
printer.

Appendix E Specifications
This appendix lists the printer’s specifications.

Glossary
This glossary explains the terminology used in this manual.



IMPORTANT! PLEASE READ FIRST

A Caution Labels

Caution labels have been attached to the printer at the following locations for safety purposes. BE SUFFICIENTLY CAREFUL to avoid
fire or electric shock when removing a paper jam or when replacing toner.

/ Label 2 \

High temperature inside. Do not touch
parts in this area, because there is a g
danger of getting burned. .....................

Label 1
High voltage inside. NEVER touch parts

in this area, because there is a danger of
electric shock. .........c.vveeeiiieiiiiiiiiiinn.

Label 3
Do not incinerate toner
and waste toner box.

Dangerous sparks may
cause burn. ................

Label 4
Moving parts inside. May

cause personal injury. Do g
not touch moving parts. ....

\_ /




A Installation Precautions

H Environment
A\ CAUTION

* Avoid placing the printer on or in locations which are
unstable or not level. Such locations may cause the
printer to fall down or fall over. This type of situation
presents a danger of personal injury or damage to the
o] 101 (= PSR

* Avoid locations with humidity or dust and dirt. If dust or
dirt becomes attached to the power plug, clean the
plug to avoid the danger of fire or electrical shock. .....

« Avoid locations near radiators, heaters, or other heat
sources, or locations near flammable items, to avoid
the danger of fire. ...,

* To keep the printer cool and facilitate changing of
parts and maintenance, allow access space as shown
below. Leave adequate space, especially around the
left cover, to allow air to be properly ventilated out of
the printer. ..o

O

Rear: 210 cm (3-1%/16")

==

e

g

260 cm (23-5/5"

Front: 2100 cm (39-%/s")

» Always use the caster stoppers to stabilize the printer
once it is in place to keep it from moving and/or falling
over and causing iNjUIY. ......cccoeeiiiiiiiere e

Other Precautions

» Adverse environmental conditions may affect the safe

operation and performance of the printer. Install in an

air-conditioned room (recommended room tempera-

ture: around 20 °C, humidity: around 65 % RH) and

avoid the following locations when selecting a site for

the printer.

« Avoid locations near a window or with exposure to di-
rect sunlight.

« Avoid locations with vibrations.

« Avoid locations with drastic temperature fluctuations.

« Avoid locations with direct exposure to hot or cold air.

« Avoid poorly ventilated locations.

If the floor is delicate against casters, when this prod-

uct is moved after installation, the floor material may

be damaged.

H Power Supply/Grounding the Printer
A WARNING

» DO NOT use a power supply with a voltage other than
that specified. Avoid multiple connections in the same
outlet. These types of situations present a danger of
fire or electrical shock. ........cccoocoiiiiiiiiii e

* Plug the power cord securely into the outlet. If metallic
objects come in contact with the prongs on the plug, it
may cause a fire or electric shock. ............cccceennnen.

* Always connect the printer to an outlet with a ground
connection to avoid the danger of fire or electrical
shock in case of an electric short. If an earth connec-
tion is not possible, contact your service representa-
BV, e

Other Precautions
» Connect the power plug to the closest outlet possible
to the printer.

M Handling of Plastic Bags

A WARNING

* Keep the plastic bags that are used with the printer
away from children. The plastic may cling to their nose
and mouth causing suffocation. ...............cccceeis

O



A Precautions for Use

H Cautions when Using the Printer
A WARNING

* DO NOT place metallic objects or containers with wa-
ter (flower vases, flower pots, cups, etc.) on or near

the printer. This type of situation presents a danger of ®
fire or electrical shock should they fall inside. ............

DO NOT remove any of the covers from the printer as
there is a danger of electrical shock from high voltage
parts inside the printer. ........cccccooeiiiiiiiiiiies

DO NOT damage, break or attempt to repair the

power cord. DO NOT place heavy objects on the cord,

pull it, bend it unnecessarily or cause any other type of
damage.

These types of situations present a danger of fire or ®
electrical Shock. .......cooociiiiiiiiii

NEVER attempt to repair or disassemble the printer or

its parts as there is a danger of fire, electrical shock or ®
damage to the laser. If the laser beam escapes, there

is a danger of it causing blindness. ............cccccceen.

If the printer becomes excessively hot, smoke appears

from the printer, there is an odd smell, or any other ab-
normal situation occurs, there is a danger of fire or
electrical shock. Turn the power switch OFF (O) imme-
diately, remove the power plug from the outlet and %
contact your service representative. ................ccoueee.

If anything harmful (paper clips, water, other fluids,
etc.) falls into the printer, turn the power switch OFF
(O) immediately. Next, remove the power plug from
the outlet to avoid the danger of fire or electrical %
shock. Then contact your service representative. ......

*« DO NOT remove or connect the power plug with wet
hands, as there is a danger of electrical shock. .........

* ALWAYS contact your service representative for main-
tenance or repair of internal parts. ...........cccccoeiiee.

A\ CAUTION

* DO NOT pull the power cord when removing it from
the outlet. If the power cord is pulled, the wires may
become broken and there is a danger of fire or electri-

cal shock. (ALWAYS grasp the power plug when re- ®
moving the power cord from the outlet.) .....................

* ALWAYS remove the power plug from the outlet when

moving the printer. If the power cord is damaged, %
there is a danger of fire or electrical shock. ................

« If the printer will not be used for a short period of time
(overnight, etc.), turn the power switch OFF (O).
If it will not be used for an extended period of time (va-
cations, etc.), remove the power plug from the outlet
for safety purposes during the time the printer is not in %
USE. ettt et e et ettt er e sttt s et

* When lifting or moving the printer, pull up the 4 han-
dles on both sides of the printer, then ALWAYS carry
the printer by the designated 4 handles with at least 4 0
people, one person toa handle.............cccccooeiieeen.

» For safety purposes. ALWAYS remove the power
plug from the outlet when performing cleaning oper-
AtIONS. oo

« If dust accumulates within the printer, there is a dan-
ger of fire or other trouble. It is therefore recom-
mended that you consult with your service
representative in regard to the cleaning of internal
parts. This is particularly effective if accomplished
prior to seasons of high humidity. Consult with your
service representative in regard to the cost of cleaning
the internal parts of the printer. ..o

Other Precautions
* DO NOT place heavy objects on the printer or cause
other damage to the printer.

* DO NOT open the front cover, turn off the main switch,
or pull out the power plug during printing.

* During printing, some ozone is released, but the
amount does not cause any ill effect to one’s health. If,
however, the printer is used over a long period of time
in a poorly ventilated room or when printing an ex-
tremely large number of copies, the smell may be-
come unpleasant. To maintain the appropriate
environment for print work, it is suggested that the
room be properly ventilated.

+ DO NOT touch electrical parts, such as connectors or
printed circuit boards. They could be damaged by
static electricity.

* DO NOT attempt to perform any operations not ex-
plained in this handbook.

* CAUTION: Use of controls or adjustments or perfor-
mance of procedures other than those specified
herein may result in hazardous radiation exposure.



H Cautions for Toner Handling
A\ CAUTION

* Do not incinerate toner and toner containers. Danger- ®
0us sparks may cause burn. ...........cccccccvveeveenieeeeenennns

* Never open the toner container or waste toner box. .... ®

* Make sure not to inhale the toner, and not to rub your
eyes or touch your mouth with the hands stained with ®
the toner. And make sure not to stick to your skin. ......

* For the disposal of old toner container and waste toner
box, consult your dealer. Or dispose of the toner or
toner containers in accordance with Federal, state and ®
Local rules and regulations. ..........ccccoiiiiiiiiiiiinennn.

* Keep the toner container and the waste toner box ®
away from children. ...........cccccovieiiiie s

Other Precautions

« If the printer will not be used for an extended period of
time, remove the paper from the cassette, return it to
its original package and reseal it.

10



Names of Parts

Chapter 1
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Chapter 1 Names of Parts

@ Operator panel
Contains the keys and indicators for operating the printer.

® Front cover
Open to replace the toner container or waste toner box.

® Paper cassette 2
Second cassette that holds up to about 500 sheets of stan-
dard paper.

@ Paper guide
Adjust to the length of the paper to be set in the paper cas-
sette.

® Paper stopper
Hold the lever and adjust the paper guide to the width of the
paper to be set in the paper cassette.

(® Paper cassette 1
First cassette that holds up to about 500 sheets of standard
paper.

@ Handles for transport
These handles must be held by at least 4 persons when lift-
ing or moving the printer.

MP (Multi-Purpose) tray
Load paper here when printing onto small-size or special pa-
per.

® Main switch
Turn ON () before starting to print.

Face-down tray
Printed paper is stored here.

@ Toner container
@ Toner container release lever
Operate to replace the toner container.
@ Waste toner box
Waste toner is collected.

Cleaning knob
Pull and push back in after toner container replacement or
when print images become soiled with toner.

] é )

®
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@ Main charger unit
When replacing the toner container, install the grid cleaner to
clean the grid.

Cleaning brush
Used to clean the internal part of the printer.

@ Power cord
Power cord connector
220 to 240 V-models only.

Option unit connector
When using the option device, connect its cable to this con-
nector.
@ Handles for transport
These handles must be held by at least 4 persons when lift-
ing or moving the printer.
@) Left cover 2
Open when a paper jam occurs inside the left cover 2.
@ Lock lever
Pull up to open the left cover 1.
@ Left cover 1
Open when a paper jam occurs.

@) Memory card slot

@ Optional network interface card slot (OPT2)
For optional network interface card.

@ Parallel cable connector
Connect the parallel cable to this connector in the parallel
printing.

©) Network cable connector
Connect the network cable to this connector in the network
printing.

@ Serial cable connector
Connect the serial cable to this connector in the serial print-
ing.

© Optional hard disk unit slot (OPT1/HDD)
For optional hard disk unit.
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1. How to Load Paper

Paper can be loaded into the two paper cassettes and the MP tray.
3 Hold the paper stopper and move it to align with the re-

1.1 Loading Paper into the Paper Cassette quired paper length.

Up to about 500 sheets of standard paper (80 g/mz) can be load-
ed into the each paper cassette.

Inch specifications
Each paper cassette can be set to hold paper of any desired size
from 11 x 17 to 5-1/2 x 8-1/2".

Metric specifications
Each paper cassette can be set to hold paper of any desired size
from A3 to A5R.

1 Pull the paper cassette out toward you as far as it will

go. Do not pull more than one paper cassette out at a 4 Set the paper flush against the left-hand wall of the pa-
time. per cassette.

2 Hold the paper guide and move it to align the paper
guide with the required paper width. Paper sizes are
marked inside the paper cassette.

241
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IMPORTANT

* There is a sticker (4 in the illustration) indicating paper capac-
ity attached to the inside of the paper cassette. Do not load
paper above this limit.

* When loading paper into the paper cassette, make sure that
the print side is facing upward. (The print side is the side fac-
ing upward when the package is opened.)

» Check that the paper guide makes secure contact with the pa-
per. If there is a gap, adjust the position of the paper guide.

« If small-size paper jams occur frequently under high tempera-
ture and high humidity conditions, reduce the number of
sheets to the level line indicated on the sticker 4.

-
UPPER LEVEL

-

5 Set the supplied paper size plate so that the size of the
paper loaded can be checked by looking at the front of
the paper cassette.

6 Gently push the paper cassette back in.

NOTE

Before leaving the printer in disuse for a prolonged period of
time, remove the paper from the paper cassette(s) and seal it in
its original packaging to protect from moisture. Also, when stor-
ing paper in a high temperature and high humidity environment,
seal it in a moisture-proof bag.

1.2 Loading Paper into the MP (Multi-Pur-
pose) Tray

Special paper as well as standard paper can be loaded into the
MP tray. When printing onto transparencies or thick paper, be
sure to use the MP tray.

NOTE

* The number of sheets of standard paper that can be loaded in
the MP tray at a time is approximately 200.
* When using transparencies, load a single sheet at a time.

IMPORTANT

When setting special paper, such as transparencies and thick
paper, into the M tray, select the type of paper by referring to
3.Paper Type on page 5-5.

1 Open the MP tray.

2 Adjust the insert guides to the size of the paper to be
loaded.
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3 Insert the paper along the guides as far as it will go.

IMPORTANT

When loading paper into the MP tray, make sure that the print
side is facing upward. (The print side is the side facing upward
when the package is opened.) If the leading edge of the paper is
curled, straighten it out before loading the paper in the MP tray.

1.3 Setting Envelopes

When using the optional printer function, envelopes can be set
in the MP tray.

1 Open the MP tray.

3 Open the flap of the envelope and set it with the copy
side facing upward. With the flap facing the outside, in-
sert the envelope into the slot along the insert guides
as far as it will go.

NOTE

Incorrectly loading envelopes can result in printing in the wrong
orientation or on the wrong side.

2-3
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This chapter explains the following topics:

» Understanding the Operator Panel
* Using the Operator Panel

1. Understanding the Operator Panel

The operator panel has an LCD message display, indicators, and eight keys.

Operation Indicators (See page 3-2)
I

Message Display

(See page 3-2) Om -.ll-% - /=
~ READY DATA  ATTENTION _-vas——
\

- |

--- A4 PLAIN
Paper Type Indicator
INTERFACE ~ SIZE TYPE

/ F’Q DlZi (See page 3-3)
Paper Size Indicator

=1 A > (See page 3-3)
L) L) (L=

{ 5 GO
() () ()
\¥ MENU V  ENTER
Interface Indicator CANCEL

yReady =
e

(See page 3-2)

Keys (See page 3-3)

3-1
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1.1 Operation Indicators

The following indicators light up during normal operation and
when the printer needs attention.

Indicator

Description

O m
READY

Flashing: Indicates when an error occurs
that you can clear by yourself.

Lit: Indicates that the printer is on-line.
The printer prints received data.

Off: Indicates that the printer is off-line.
Data can be received but will not be printed.
Also indicates when printing is automatical-
ly stopped due to occurrence of an error.

M.

Flashing: Indicates data transfer is taking
place.
Lit: Indicates either that data is being proc-

DATA essed, or that data is being written to the
memory card.
Flashing: Indicates when the printer needs
maintenance attention or the printer is
,’ L warming up (Please wait).

ATTENTION Lit: Indicates when a problem or an error
occurs that you can clear by yourself. (For
example, paper jam occurs.)

(DFlashing: Indicates when no paper is de-
tected.
Fast-Flashing: Indicates that a paper
jam is occurring.
Lit: Indicates that the MP tray is select-
ed.

‘—((/\_ | ©@Flashing: Indicates when the cassette or

® Om |= paper is not detected, or when the paper

—| is loading.
@ Fast-Flashing:Indicates that a paper
J jam is occurring.

Lit: Indicates that the cassette is select-
ed.

®Flashing: Indicates that there is paper
jam in the optional finisher.
Lit: Indicates that the document finisher
is being selected.

1.2 Message Display

The message display gives information in the form of short mes-
sages. The eight messages listed below are displayed during
normal warm-up and printing.

Other messages that may appear when the printer needs the op-
erator’s attention are explained on page 4-4.

Message

Meaning

Self test

The printer is self-testing after power-up.

Please wait

The printer is warming up and is not
ready. When the printer is switched on for
the first time after the toner container is
installed, (Adding toner)also appears.

Ready The printer is ready to print.

Processing The printer is receiving data, generating
graphics, reading a memory card/hard
disk, or printing.

Sleeping The printer is in Sleep mode. The printer

wakes from Sleep mode whenever a key
on the operator panel is pressed, the cov-
er is opened or closed, or data is re-
ceived. The printer then warms up and
goes online. The time that the printer
takes to enter Sleep mode depends on
the Sleep Timer setting.

Cancelling data

Jobs inside the printer are being can-
celed. To cancel a job, see the table on
page 3-3.

Waiting

The printer is waiting for the end-of-job
command before printing the last page.
Pressing the GO key allows you to obtain
the last page immediately.

FormFeed TimeOut

The printer is printing the last page after
a waiting period.

1.3 Interface Indicator

The interface Indicator shows the interface that is currently used.
It uses the following abbreviations:

PAR
SER
NET
OPT

Standard bi-directional parallel interface
Serial interface (RS-232C)

Network interface

Option network interface card

--- No interface is active.

Each interface has a timeout time of 30 seconds during which
the other interface should wait to receive a print job. Even if a
print job has been completed on the interface, you should wait
for this period until the other interface begins printing the job.
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1.4 Paper Size Indicator

This Indicator shows the paper size of the current paper cassette.
The following abbreviations are used to indicate the paper sizes.

MD?::Iaagye Paper Size MD?::fagye Paper Size
A3 ISO A3 DL ISO DL*

A4 ISO A4 c5 ISO C5*

A5 ISO A5 b5 ISO B5*

A6 ISO AG* EX Executive*

B5 JIS B5 #6 Commercial 6-3/4*
B6 JIS B6* #9 Commercial 9*

LT Letter HA Japanese Postcard*®
LG Legal OH Return Postcard*
MO Monarch* CU Custom Size

BU Business* c4 ISO C4

B4 B4 02 Oficio Il

LD Ledger ST Statement

FO Folio Y2 Youkei2*

Y4 Youkei4*

* With only the MP tray feeding

NOTE

While the printer is processing data, the SIZE display indicates
the paper size selected by the application software.

1.5 Paper Type Indicator

This shows the paper type defined for the current paper cas-
sette. Automatic cassette switching is available according to the

paper type.

The paper type can be specified at the operator panel. See Cus-
tomizing Paper Type on page 3-45.

The following abbreviations are used to indicate the paper type.

1.6 Keys

The operator panel keys are used to configure the printer.
Note that certain keys have the secondary function.

NOTE

Settings made with these keys effect only the interface currently

in use.

Key

Function

» Switches the printer on-line and off-line.
* Prints and feeds out one page.

CANCEL

» Cancels a printing job.

To cancel, proceed as follows:

1 Checkif Processingis displayed in
the message display.

2 Press the CANCEL key.

Print Cancel? appears in the
message display and then interface
to be canceled appears.

Parallel

Serial

Network

Option (appears only when an option
network interface card is installed)

3 Select the interface to cancel using
the A or v key and then press the
ENTER key. Printing from the select-
ed interface will stop. Cancelling
data appears in the message dis-
play and printing stops after the cur-
rent page is printed.

* Resets numeric values, or cancels a
setting procedure.

* Used to stop the sounding of the alarm
buzzer indicating an error.

MENU

» Used to select the emulation, font, char-
acter code set; to read an memory card,
and more.

* When pressed during mode selection,
terminates the setting and the printer re-
turns to the Ready condition.

Used to access a desired item or enter
numeric values. In some of the control
procedures, the <1 and > keys are used
to enter or exit a sub item.

{ O

Used to access a desired item or to enter
numeric values. In some of the control
procedures, the <t and > keys are used
to enter or exit a sub item.

e

Used as the <t key in the mode selection
function.

MD‘:::fa%e Paper Type MD?:;aa%e Paper Type
None Auto ROUGH Rough
PLAIN Plain LETTERHEA | Letterhead
TRNSPRNCY | Transparency* |COLOR Color
PREPRINT Preprinted PREPUNCH | Prepunched
LABELS Labels* ENVELOPE |Envelope*
BOND Bond CARDSTOCK | Cardstock*
RECYCLED Recycled CUSTOM1 Custom 1 (to 8)
VELLUM Vellum* (to 8)

* With only the MP tray feeding

3-3

* Used as the > key in the mode selec-
tion function.

* Displays online help messages on the
message display when paper jam errors
occur. When pressed in the Ready con-
dition, displays explanations of online
help messages. When pressed while
the online help is displayed, cancels the
online help.

ENTER

Finalizes numeric values and other se-
lections.
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2. Using the Operator Panel

This section explains how to use the menu selection system. The MENU key on the operator panel allows you to use the menu to set
or change the printer environment such as the number of copies to print, emulation, etc., to your specific needs. Settings can be made
when Ready is indicated on the printer message display.

The printer obeys the most recently received printer settings sent from the application software, or from the printer driver, which take
priority over operator panel settings.

2.1 Menu Selection System

The following is the hierarchy diagram of the menu selection system of the printer. The vertical transition is made with the A and Vv keys
and horizontal transition is made with the > and <1 keys. To change or finalize configuration on an item, use the ENTER key.

I:l These items will not appear unless the printer is installed with the applicable option.

Ready
PAR A4 PLAIN

MENU Key
Print
Menu Map

Print |

Status Page
# >Quick Copy

>Private/Stored IH

e-MPS >

>Print VMB Data

>List of VMB

>List of
Code JOB

>e—MP$ ; > >>Quick Copy
Configuration 32

>>Temp. Code JOB
Size 0500MB

>>Perm. Code JOBm

Size 0500MB

>>VMB Slze

0500MB

Continued on the next page
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Continued

Interface
Parallel
Intertace
Serial
Intertace
Network
Intertace
Option

>Parallel I/F
Auto

>Baud rate
9600

| |
>Data Bits
8

|>Data Bits
7

>Stop Bits
1

|>Stop Bits
2

>Parity
None

>Protocol
DTR (pos.)&XON

>Barcode Mode
Off
|>Barcode Mode

Oon

L1 = = L1 L_J1 ‘= =

>NetWare
Off
>NetWare
| On

>TCP/IP
Off
>TCP/TIP
| Oon

>Ether Talk
Off
>Ether Talk
| On

>Network Status
Page Ooff
>Network Status
| Page On

>0PT. StatusPage
Off
| SOPT- StatusPaga—I

Oon

Continued on the next page

3-5

>>NetWare Frame
Auto

>>DHCP
OFF

OOO 000.000.000

>>Subnet Mask
000.000.000.000

>>Gateway
000.000.000.000

J
)
>>Ip Address m
J
J
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Continued

Emulation
PCL 6

>Code Set

IBM PC-8 “
>KC-GL >
Pen Width

>>Pen (1) Width
01 dot(s) I

>KC-GL Page Set
[SPSZ

>Print KPDL Errs
of

>Print KPDL Errs
Off

>Alt.
PCL 6

Emulation

KPDL
mulation >

KPDL (AUTO)

Emulation

Emulation >
Line Printer
mulation

IBM Printer

>Code Set
IBM US

>Code Set
DIALO US
>Code Set
LQ US I
>Font Select >
Internal

>Fon elec
Option

Emulation >
DIABLO US

Emulation >
EPSON LQ-850

>>Courier

Regular

SSCourier
Dark

>>Letter Gothic
Regular

>>Letter Gothic
Dark

>>Size
012.00 point(s)

>List of
Internal Fonts

>List of >>Pitch

Option Fonts 10.00 cpi

>Zoom
[CS]—[CS] I

>Orientation
Portrait

>Orientation
Landscape

>Page Protect
Auto

>Page Protect
on

>LF Action

LF only I
>CR_Action

CR only “

Continued on the next page
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Continued

Print Quality > >KIR Mode
On

>KTIR Mode

Off
I

>EcoPrint Mode
Off

|>EcoPr1nt Mode

On
I

>Resolution

Fast 1200 mode

= LT L 1T

>Print Density
03

| Opt. ROM > >Read Data

>List of
Partition

|Hard Disk > H>Read Data

>Write Data

>Delete Data

>List of
Partition

RAM DISK Mode

>RAM Disk Size
0008 MByte

>read Data

>Write Data

>Delete Data

>List of
Partition

Memory Card > H>Read Fonts

>Read Data

>Write Data

>Delete Data

>Format
I

>List of
Partition

Continued on the next page
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Continued

>MP Tray Mode
Cassette

Paper Handling >M

>MP Tray Mode
First

>MP Tray Size
A4l

| |
>MP Tray Type
Plain

>Cassettel Size >

>>Unit
mm

inch

| |
>Cassette 1 Type
Plain

|>>Un1t

>Feed Select
Cassette 1

||
>Duplex Mode
None

| |
>Stack Select
Face-down tray

>Stitch Adjust >

]:E’EE"ETEE_T_

>>Ad/Letter
000

>>B4

ooo|

>>A3/Ledger
000

>Override A4/LT
Off

>0Override A4/LT
Oon

>Type Adjust >

Custom 1

>>Paper Weight
Normal
T

=

T
| |
>>Duplex Path
Enable

>Reset Type
Adjust

>>Duplex Path
Disable

Continued on the next page
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Continued
Life Counters > >Total Print
0123456
>New Toner
Installed
Others > >MSG Language
English
T T .

>Form Feed
Time Out 030sec.

>Sleep Timer > >>Sleep Mode
030 min. On
I >>Sleep Mode
Off
>Print HEX-DUMP |
>Printer Reset |
>Resource Prot.
Off
T
T
||
>Buzzer
Oon
>Buzzer
Ooff
>Auto Continue > >>Auto Continue
Mode Off Timer 030sec.
>Auto Continue >
Mode On
>Service > >>Print

1

Status Page

>>Print
Event Log

>>Developer

>>Drum

3-9
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2.2 Using the Menu Selection System

This section explains the procedure for using the menu selection
system. The menu selection system is activated by the MENU
key while the printer is Ready.

2.2.1 Printing the Menu Map

The printer prints a full list of menu selections. Note that menus
indicated on the list may vary depending on which option units
are installed on the printer.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Print Menu
Map appears.

Print

Menu Map

3 Press the ENTER key. A question mark (?) appears.

Print

Menu Map ?

4 Press the ENTER key again. The printer prints a menu
map.

O} KYOCERE
“"‘; m FS-9500DN Page Printer
\ MENU MAP

2.2.2 Printing Status Page

If you want to check the printer’s current status, including mem-
ory available and option settings, you can find the information
you need on the status page.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Print Status
Page appears.

Print

Status Page

3 Press the ENTER key. A question mark (?) appears.

Print

Status Page °?

4 Press the ENTER key again. The printer prints a status
page.
NOTE

For a full description of the status, see the following Printing the
Service Status page.

The following is a sample status page. The numbers below refer
to the contents explained on the next page.

O} KYOCERA
vlm'!a &af}sq FS-9500DN Page Printer
| STATUS PAGE

Teleaed

Hardware Information Memory

] Installed Options

Network Status Emulation

I N NN

[ Error Log
J
Toner Gauge
\ ; ] T©
0 100
Interfaces
d1®
( KIR Test pattern ON +®

When the Network Status is turned on, the Network Interface
Status Page will be printed after the Printer Status. (See page
3-20.)

3-10
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NOTE
ltems and values on the status page may vary depending on the
printer’s firmware version.

@ Software Version
This information shows the firmware version and date of is-
sue of the printer.

® Hardware Information
This information shows various printer settings, such as the
size and type of the paper in the paper cassettes.

® Memory
This shows the amount of total memory installed in the print-

er, the amount of currently available memory, and the current
status of the RAM disk. See Setting RAM Disk Size on
page 3-34.

@ Page Information
This shows the print resolution, number of copies, and the to-
tal page count.

® Installed Options
This shows the option(s) installed in the printer.

® Network Status
This shows the IP address, Subnet Mask address, and De-
fault Gateway address for the network interface.

@ Emulation
This shows all available emulations of the printer. The printer
is shipped from the factory with PCL 6 emulation selected as
the default.

Error Log
This shows the last three instances of the following four
types of errors, listing them in the order of their occurrence:
KPDL Error Press GO;Memory overflow Press GO;
Print overrun Press GO; File not found Press
GO. The most recent error is displayed on the top line of the
Error Log. For error remedies, see Maintenance Messages
on page 4-4. Error information is cleared when the printer’s
power is turned off.

® Toner Gauge
This shows the approximate level of remaining toner. When
the value is 100, the toner container is full.

Interface Information
This information shows the default font and the default emu-
lation for all interfaces installed in the printer.

@ KIR Test Pattern
KIR is the Kyocera’s original smoothing function. This test
pattern shows the effect of the KIR (Kyocera Image Refine-
ment) system.

2.2.3 e-MPS

e-MPS is an abbreviation for ‘enhanced-Multiple Printing Sys-
tem’ which implements the following functions that are available
from the printer driver:

» Job Retention
+ Job Storage

3-11

In either job mode, when printing a document, the print data is
transferred from the computer to the printer then stored on the
printer’s hard disk. Since copies of the document are printed us-
ing the stored data, printing is performed faster with less compu-
ter spooling time and less network traffic.

NOTE

To use the e-MPS system, an optional hard disk must be in-
stalled in the printer. For details, see Appendix D Option
Units.

B Job Retention

Job Retention has four modes as summarized below. These
modes are selected when you choose on the printer driver
through the application software:

Proof-and-Hold

To later print addi- | To proof the first
tional copies copy before printing
multiple copies

Quick Copy

Primary function

Storing started Printer driver Printer driver

Retrieved by Operator panel Operator panel

Default number of | Same as storing One less

copies printed at re-

trieval
Maximum number | 32,expandable to 32,expandable to
of jobs stored* 50 50
PIN security No No
Data after printing | Retained Retained
Data when power | Deleted Deleted
off
Private Print Stored Job

To hold the docu-
ment in printer to store documents
prevent unauthor- | such as fax cover
ized access pages

Primary function To electronically

Storing started Printer driver Printer driver

Retrieved by Operator panel Operator panel

Default number of | Same as storing One
copies printed at re-
trieval

Maximum number | Private jobs are de- | Depends on the
of jobs stored* leted automatically | hard disk capacity
once it is retrieved.

PIN security Yes Yes (Option)
Data after printing | Deleted Retained
Data when power | Deleted Retained

off

*Jobs in excess will cause the earlier ones to be deleted.
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B Job Storage

Job storage stores print jobs either temporarily or permanently,
or in virtual mailboxes, as you click an appropriate radio button
on the printer driver when printing from a computer. If you select
Temporary or Permanent job storage, you can choose to have a
unique number and barcode automatically assigned to each job
as it is stored in the printer. This barcode appears on the printed
document. The barcode reader can be used to reprint the docu-
ment by reading the barcode from the original document or from
a List of Code Jobs. For details on this list, see Printing a List of
Code Jobs on page 3-15.

Job storage requires a hard disk installed in the printer. Howev-
er, printing barcoded job IDs on documents is possible using the
RAM disk feature of the printer. On how to use the RAM disk, see
Operating a RAM Disk on page 3-34.

B Virtual Mailbox

Virtual mailbox is part of Job Storage, which stores print jobs on
the hard disk without printing. It enables you to retrieve jobs later
from the operator panel, the Print Disk Manager utility (in the CD-
ROM), or the barcode reader.

Each mailbox may be used by an individual who desires to share
the printer in this mode. By default, each mailbox is numbered
from ‘Tray 001,” “Tray 002," ... etc. To ‘post’ a job in one of these
mailboxes, you assign a numbered or named mailbox on the
printer driver when printing.

To retrieve the stored job for printing, see Retrieving Jobs from
Virtual Mailbox (VMB) on page 3-15.

NOTE

The virtual mailbox can be used in PCL 6 emulation only.

Using Quick Copy

This mode enables you to print the requested number of copies
of a job, simultaneously storing the job on the hard disk. When
additional copies are required, you can reprint the required
number of copies from the printer operator panel. To print a job
as a quick copy job, see Printer Driver Guide.

The default number of print jobs that can be stored on the hard
disk is 32. This value can be increased to up to 50 from the e-MPS
Configuration menu. For details, see Changing e-MPS Configu-
ration on page 3-16. When the number of jobs reaches the limit,
the oldest job will be overwritten by the new one.

When the printer is turned off, all stored jobs will be deleted.

M Printing Additional Copies using Quick Copy
To print additional copies of a job stored in the printer:

1 Press the MENU key.

2 Press the A or v key repeatedly until e-MPS > ap-
pears.

e-MPS >

3 Press the > key.

4 Press the A or v key repeatedly until >Quick Copy
appears followed by the user name (Harold, in this
example). The user name is assigned at printing using
the printer driver.

>Quick Copy

Harold

5 Press the ENTER key. A blinking question mark (?) ap-
pears before the user name.

>Quick Copy

o
?Harold
A

6 Press the A or v key to display the desired user name,
Arlen, in this example.

>Quick Copy

?Arlen

7 Press the ENTER key. The job name entered in the
printer driver (Report, in this example) appear with a
blinking question mark (?) before the letters.

>Arlen

Mo
?Report
:\

8 Press the A or Vv key to scroll to the desired job title.

9 Press the ENTER key. The number of copies to be print-
ed can be set. To increase the copy count, press the A
key; to decrease the copy count, press the v key.

>Report
R P 00
CoPle;.s 1

1 0 Press the ENTER key to finalize the copy count. The
printer prints the specified number of copies for the job.

H Deleting a Quick Copy Job

All quick copy jobs are automatically deleted when the printer is
turned off. If you desire to explicitly delete a stored quick copy
job, proceed as follows:

1 Follow steps 1 through 8 in the above section to dis-
play the title of the job to be deleted.

2 When the title of the job to be deleted is displayed, e.g.
Report, below, press the ENTER key. The cursor below
the copy count starts to blink.

>Report

Copies 0

3-12
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3 Press the Vv key repeatedly until Delete appears be-
low the title.

>Report
N |

Delete

¢ N

»

4 Press the ENTER key. The stored quick copy job is de-
leted.

Using Proof-and-Hold

When you print multiple copies, this mode first prints one copy
so that you can proof it before continuing to print the remaining
copies. Since you can proof the printouts before printing the re-
maining copies, wastage of paper can be reduced.

The printer prints one copy and, at the same time, saves the print
job on the hard disk. You can also change the number of copies
when resuming printing from the operator panel.

When the printer is turned off, all stored jobs will be deleted.

B Printing Remaining Copies of a Proof and Hold Job

Printing a Proof-and-Hold job on the operator panel is similar to
printing a quick copy job. To print remaining copies of a job held
in the printer:

1 Press the MENU key.

2 Press the A or v key repeatedly until e-MPS > ap-
pears.

e-MPS >

3 Press the > key.

4 Press the A or v key repeatedly until >Quick Copy
appears followed by the user name (Harold, in this
example). The user name is assigned at printing using
the printer driver.

>Quick Copy

Harold

5 Press the ENTER key. A blinking question mark (?) ap-
pears before the user name.

>Quick Copy

\l,
?Harold

AR

6 Press the A or Vv key to display the desired user name,
Arlen, in this example.

>Quick Copy

?Arlen

3-13

7 Press the ENTER key. The job name entered in the
printer driver (Report, in this example) appears with a
blinking question mark (?) before the letters.

>Arlen
q

?
’y
1

Report
epor
\p

8 Press the A or Vv key to scroll to the desired job title.

9 Press the ENTER key. The number of copies to be
printed can be set. To increase the copy count, press
the A key; to decrease the copy count, press the v
key.

>Report

Copies odi’

KN
]

1 0 Press the ENTER key to finalize the copy count. The
printer prints the specified number of copies for the job.

Printing a Private Job

In private printing, you can specify that a job is not printed until
you release the job from the operator panel. At sending the job
from the application software, you can specify a 4-digit access
code in the printer driver. The job is released for printing by en-
tering the access code on the operator panel. Thus, this function
ensures confidentiality of the print job.

When the printer is turned off, all the print jobs will be deleted.

B Releasing a Private Job
1 Press the MENU key.

2 Press the A or v key repeatedly until e-MPS > ap-
pears.

e-MPS >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Private/
Stored appears. The name entered in the printer driver
(Harold, in this example) also appears.

>Private/Stored

Harold

5 Press the ENTER key. A blinking question mark (?) ap-
pears before the user name.

>Private/Stored

\l,
?Harold

21N
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10

11

Press the A or v key to display the desired user name
(Arlen, in this example).

>Private/Stored

?Arlen

Press the ENTER key. The user name and the job
name (Agenda, in this example) entered in the printer
driver appear with a blinking question mark (?).

>Arlen

Mo
?Agenda
':\

Press the A or v key to display the desired job title.

Press the ENTER key. The ID input line appears. Enter
the four-digit access code entered in the printer driver
and press the ENTER key. To enter the ID, Press the <
or > key to move the cursor to the number to be
changed and then enter the correct number by press-
ing the A or V key.

>Agenda
|
ID 00007

23N
]

You can set the number of copies to be printed. To in-
crease the copy count, press the A key; to decrease
the copy count, press the Vv key.

>Agenda

odls

Copies

IEN
|

Press the ENTER key to finalize the copy count. The
printer prints the specified number of copies for the job.

H Deleting a Private Job

1
2

Follow steps 1 through 8 in the above section.

When the title of the job to be printed is displayed
(Agenda, in this example), press the ENTER key. En-
ter the four-digit access code entered in the printer
driver and press the ENTER key.

>Agenda

Copies

Press the Vv key repeatedly until Delete appears for
the number of copies.

>Agenda

Delete

¢
¢ N

-
=

4

Press the ENTER key. The private job is deleted from
the hard disk.

Storing a Print Job

You can download a job to the hard disk without printing it. This
allows you to store print jobs that are frequently needed such as
fax cover pages, check lists, and order forms, for printing at any
later time using the operator panel.

The print jobs are not deleted even when the printer is turned off.

B Releasing a Stored Job

To print a stored job through the operator panel:

1

Press the MENU key.

Press the A or Vv key repeatedly until e-MPS > ap-
pears.

e-MPS >

Press the > key.

Press the A or v key repeatedly until >Private/
Stored appears. The name entered for User Name in
the printer driver (Harold, in this example) also ap-
pears.

>Private/Stored

Harold

Press the ENTER key. A blinking question mark (?) be-
fore a user name appears.

>Private/Stored
SV
?Harold

AR

Press the A or V key to display the desired user name
(Arlen, in this example).

>Private/Stored

?Arlen

Press the ENTER key. The user name and the job
name entered in the printer driver (Agenda, in this ex-
ample) appear with a blinking question mark (?) before
the letter.

>Arlen
S

?Agenda
2

Press the A or v key to display the desired job title.

3-14
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9 Press the ENTER key. If you entered an access code
for the printer driver, the ID input line appears. Enter
the four-digit access code entered in the printer driver.

To enter the ID, Press the <t or > key to move the cur-
sor to the number to be changed and then enter the
correct number by pressing the A or Vv key.

>Agenda

I
D 00007
I?\

1 0 Press the ENTER key. You can specify the number of
copies to print. To increase the copy count, press the A
key; to decrease the Vv key.

>Agenda

Copies O@i’

PIFEN
]

1 1 Press the ENTER key to finalize the copy count. The
printer prints the specified number of copies for the job.

>Agenda
?Copies O@!'

PIEN
|

B Deleting a Stored Job
1 Follow steps 1 through 8 in the above section.

2 When the title of the job to be printed is displayed
(Agenda, in this example), press the ENTER key.

>Agenda

Copies O@i’

PIFEN
]

3 Press the Vv key repeatedly until Delete appears for
the number of copies.

>Agenda
N |

Delete

¢ N

<

4 Press the ENTER key. The stored job is deleted from
the hard disk.

Printing a List of Code Jobs

If you select Permanent Job Storage on the printer driver, you
can have a List of Code Job printed using the operator panel.
The List of Code Job may be used to read the barcode ID for
the stored job you want to reprint by using a barcode reader.
See Appendix D Option Units.

A sample Code Job List is shown on page 3-15.

1 Press the MENU key.

3-15

2 Press the A or v key repeatedly until e-MPS > ap-
pears.

e-MPS >

3 Press the > key.

4 Press the A or v key repeatedly until >List of Code
JOB appears.

>List of

Code JOB

5 Press the ENTER key. A question mark (?) appears.

>List of

Code JOB *?

6 Press the ENTER key again. The printer prints a Code
Job list as shown below.

O} KYOCERE
~Jnita_ m FS-9500DN Page Printer
l PERMANENT CODE JOB LIST

Retrieving Jobs from Virtual Mailbox (VMB)

To retrieve the jobs posted in the virtual mailbox, proceed as fol-
lows.

1 Press the MENU key.

2 Press the A or v key repeatedly until e-MPS > ap-
pears.

e-MPS >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Print VMB
Data appears. The virtual mailbox number will also ap-
pear.

>Print VMB Data

Tray001:
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If you have named the virtual mailbox with an alias on the
printer driver, the alias (Richard, in this example) will follow
the number:

>Print VMB Data

Tray001l:Richard

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Print VMB Data
EI'
?
TrayOO,l.\

6 Press the ENTER key. The document in the mailbox is
printed and automatically deleted from the mailbox.

B Printing a List of VMB

A Virtual Mailbox list includes the jobs currently stored in the
mailboxes.

1 Press the MENU key.

2 Press the A or v key repeatedly until e-MPS > ap-
pears.

e-MPS >

3 Press the > key.

4 Press the A or v key repeatedly until >List of VMB
appears.

>List of VMB

5 Press the ENTER key. A question mark (?) appears.

>List of VMB ?

6 Press the ENTER key again. The printer prints a list of jobs
currently posted in the virtual mailboxes as shown below.

O K4OCERA
'g\"i'; EC@ FS-9500DN Page Printer
l VIRTUAL MAIL BOX LIST

Changing e-MPS Configuration
You can change the following parameters for e-MPS operation:

* Maximum number of Quick Copy/Proof-and-Hold jobs
* Maximum space assigned to temporary code jobs

* Maximum space assigned to permanent code jobs

* Maximum space assigned to virtual mailboxes

NOTE

The total amount of storage area specified must not exceed the
total size of the hard disk. Otherwise, you may only be able to
accommodate a smaller number of print jobs than specified.

B Changing the Maximum Number of Quick Copy/Proof-
and-Hold Jobs

This changes maximum number of Quick Copy/Proof-and-Hold
jobs from 0 to 50. The default is 32.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until e-MPS > ap-
pears.

e-MPS >

3 Press the > key.

4 Press the A or v key repeatedly until >e-MPS Con-
figuration > appears.

>e-MPS >

Configuration

5 Press the > key.

6 Press the A or Vv key repeatedly until >>Quick Copy
appears.

>>Quick Copy
32

7 Press the ENTER key. A blinking cursor (_) appears.

>>Quick Copy

34

8 Press the A or v key to increase or decrease the value
at the blinking cursor. The value can be set between 0
and 50. Use the > and <1 keys to move the cursor
right and left.

3-16
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9 When the desired maximum number of jobs is set,
press the ENTER key.

1 0 Press the MENU key. The display returns to Ready.

B Maximum Space Assigned to Temporary Code Jobs

This changes the hard disk space that holds temporary code
jobs. You can change the maximum space from 0 to 9999
(megabytes). The actual maximum size depends on the size of
free hard disk space, however. The default size is 1/6 of the to-
tal hard disk space, rounded off in units of 50 MB. For example,
if the total hard disk space is 3.2 GB, the default size is 500 MB.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until e-MPS > ap-
pears.

e-MPS >

3 Press the >> key.

4 Press the A or v key repeatedly until >e-MPS Con-
figuration > appears.

>e-MPS >

Configuration

5 Press the > key.

6 Press the A or Vv key repeatedly until >>Temp. Code
JOB Size appears.

>>Temp. Code JOB

Size 0500MB

7 To change the maximum disk space, press the ENTER
key. A blinking cursor (_) appears.

>>Temp. Code JOB
1
size  0506MB

VIR
L]

8 Press the A or v key to increase or decrease, respec-
tively, the value at the blinking cursor. Use the > and
<1 keys to move the cursor right and left.

9 When the desired size is displayed, press the ENTER
key.

1 0 Press the MENU key. The display returns to Ready.
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Bl Maximum Space Assigned to Permanent Code Jobs

This changes the hard disk space that holds permanent code
jobs. You can change the maximum space from 0 to 9999
(megabytes). The actual maximum size depends on the size of
free hard disk space, however. The default size is 1/6 of the to-
tal hard disk space, rounded off in units of 50 MB. For example,
if the total hard disk space is 3.2 GB, the default size is 500 MB.

1 Press the MENU key.

2 Press the A or v key and select e-MPS >.

e-MPS >

3 Press the > key.

4 Press the A or Vv key repeatedly until >e-MPS Con-
figuration > appears.

>e—-MPS >

Configuration

5 Press the > key.

6 Press the A or v key and select >>Perm. Code JOB
Size.

>>Perm. Code JOB

Size 0500MB

7 Press the ENTER key, the message display shows a
blinking cursor (_).

>>Perm. Code JOB

I
Size 0508mB
VAR

8 Press the A or ¥ key to increase or decrease, respec-
tively, the value at the blinking cursor. Use the > and <
keys to move the cursor right and left.

9 When the desired size is displayed, press the ENTER
key.

1 0 Press the MENU key and the message display returns
to Ready.
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Bl Maximum Space Assigned to Virtual Mailboxes (VMB)

This changes the hard disk space for virtual mailboxes. You can
change the maximum space from 0 to 9999 (megabytes). The
actual maximum size depends on the size of free hard disk
space, however. The default size is 1/6 of the total hard disk
space, rounded off in unit of 50 MB. For example, if the total
hard disk space is 3.2 GB, the default size is 500 MB.

1 Press the MENU key.

2 Press the A or Vv key until e-MPS > appears.

e-MPS >

3 Press the > key.

4 Press the A or v key and select >e-MPS Configu-
ration >.

>e-MPS >

Configuration

5 Press the > key.

6 Press the A or v key and select >>VMB Size.

>>VMB Size

0500MB

7 To change the maximum size, press the ENTER key.
The message display shows a blinking cursor ( ).

>>VMB Size

03b6um

8 Press the A or v key to increase or decrease, respec-
tively, the value at the blinking cursor. Use the > and <
keys to move the cursor right and left.

9 When the desired size is displayed, press the ENTER
key.

1 0 Press the MENU key to exit the menu selection.

2.2.4 Changing the Interface Parameters

The printer is equipped with both a parallel and serial interface
or a network interface. Various printing environment parameters
such as the default emulation can be changed independently on
different interfaces by using the printer's menu selection sys-
tem. Select the interface to apply the changes in the procedure
described below.

NOTE

This interface selection described below does not select which
interface data will be received from. The printer automatically
selects an interface.

B Changing Parallel Interface Modes

The parallel interface mode of this printer supports a bi-direction-
al/high-speed mode. Normally, this interface is used under the
default setting Nibble (high). For details, see Appendix C Host
Computer Interface. After setting the interface, be sure to reset
the printer or turn the power off at least once. The new setting
will be enabled thereafter.

1 Press the MENU key.

2 Press the A or v key repeatedly until Interface >
appears. One of the interface names shown below ap-
pears, indicating the current interface.

Parallel (default)
Serial
Network
Option (only when an optional network interface
card is installed)

3 Press the ENTER key. A blinking question mark (?) ap-
pears.

Interface >
L
?Parallel
I\

If Parallel is not displayed, press the A or Vv key
repeatedly until Parallel appears.

4 Press the ENTER key again.
5 Press the > key. The message display changes to the
communication mode menu.

6 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Parallel I/F

Noo ,
?ﬁlbble (high)
[ ]

3-18
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7

8

Press the A or v key to display the desired mode. The
display changes as shown below. Press the ENTER
key.

Nibble (high) (default)
AUTO

Normal

High speed

Press the MENU key. The message display returns to
Ready.

B Changing Serial Interface Modes

You can set the baud rate, data bits, stop bits, parity, and proto-
col for the serial interface.

1

3-19

Press the MENU key.

Press the A or v key repeatedly until Interface >
appears. One of the interface names shown below ap-
pears, indicating the current interface.

Parallel (default)

Serial

Network

Option (only when an optional network interface
card is installed)

Press the ENTER key. A blinking question mark (?) ap-
pears.

Interface

N,
?Parallel

TAY

Press the A or Vv key repeatedly until Serial ap-
pears.

Interface

?Serial

Press the ENTER key again.

Press the > key. Each time the A or V key is pressed,
the setting item and current setting change as shown
below.

Definable baud rates:
1200, 2400, 4800, 9600
9600 (default), 19200,

>Baud Rate

38400,57600, 115200
ty

Definable stop bits: 7, 8
(default)

>Data Bits

8

ty

Definable data bits: 1 (de-

>Stop Bits
fault), 2

1

ty

>Parity Definable parity: None
(default), Odd, Even, Ig-
None nore
SProtocol Definable protocol: DTR

(pos.) & XON (default),

DTR (pos.) &XON DTP (positive), DTR (neg-

ative), XON/XOFF, ETX/

T ¢ ACK

>Barcode Mode If set to On when the option
barcode reader is installed,
Off the mode of the serial inter-
face will be the barcode
mode.

Display the setting item to be changed and press the
ENTER key. A question mark (?) appears.

The following example explains how to change the
baud rate. The settings for other items can be changed
in a similar manner.

>Baud Rate

? 9600

Press the A or v key to display the desired setting.
The baud rate can be selected from 1200, 2400, 4800,
9600 (default), 19200, 38400, 57600, and 115200.

NOTE

Some computers may not be compatible with a baud
rate of 115200 bps. If you set the baud rate to 115200
and communication problems occur, lower the baud
rate.
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10

Display the desired baud rate and press the ENTER
key.

Press the MENU key. The message display returns to
Ready.

B Changing Network Interface Parameters

This printer is equipped with the network interface.

For details on networking, refer to the “Quick Configuration

Guide”.

1

Press the MENU key.

Press the A or v key repeatedly until Interface >
appears. One of the interface names shown below ap-
pears, indicating the current interface.

Parallel (default)

Serial

Network

Option (only when an optional network interface
card is installed)

Press the ENTER key. A blinking question mark (?) ap-
pears.

Interface
N,
?Parallel

TS

Press the A or v key repeatedly until Network ap-
pears.

Interface
4

v
?Network
=\

Press the ENTER key again.

Press the > key. Each time the A or v key is pressed,
the display changes as shown below.

>NetWare

On

ty

>TCP/IP

On

ty

>EtherTalk

Off

ty

>Network Status

If turns ON, print the
standard Network Inter-

Page On face Status Page after
the Printer Status Page.
T ¢ See page 3-10.

If turns ON, print the op-

> . .
Opt. StatusPage tional Network Interface

On Status Page after the

Printer Status Page.
See page 3-10.

The following example explains how to activate TCP/IP
protocol to connect the printer in the network. You can
select Netware or EtherTalk in a similar manner.

>TCP/IP >

On

If TCP/IP is currently displays Of £, select On using the
A or V key. Press the ENTER key again.

>TCP/IP
N
? Off

v

>TCP/IP >

On

3-20
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8 Press the > key. Each time the A or v key is pressed,
the item changes as shown below.

>>DHCP

Off

ty

>>IP Address

000.000.000.000

ty

>>Subnet Mask

000.000.000.000

ty

>>Gateway

000.000.000.000

9 Display the item to be set and press the ENTER key.
For DHCP, a question mark (?) appears. For IP Ad-
dress, Subnet Mask, and Gateway, the cursor ()
blinks.

1 0 For DHCP, select On or Of f using the A or Vv key. For
IP Address, Subnet Mask, and Gateway addresses,
press the A or v key to change the number (000 to
255) where the cursor is blinking. You can use the <
and > key to move the cursor right and left.

To obtain these addresses, consult your network
administrator.

1 1 Press the ENTER key.

1 2 Press the MENU key. The message display returns to
Ready.

B Printing a Network Interface Status Page

You can print out a status page for the network interface. The
network interface status page shows the firmware version, the
network addresses, and other information under various network
protocols about the network interface. The default setting is On
(print). The network interface status page will be printed out after
the printer status page.

NOTE

Printing out a network interface status page may not be possi-
ble with some optional network interface cards. For details, see
the manual for the network interface.
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Press the MENU key.

Press the A or Vv key repeatedly until Interface >
appears.

Interface >

Parallel

Press the ENTER key. A blinking question mark (?) ap-
pears.

Interface

Ny
?Parallel
=\

Press the A or Vv key repeatedly until Network ap-
pears.

Interface

N
?Network

ALY

Press the ENTER key again. The question mark (?)
disappears

Interface >

Network

Press the > key and then press the A or v key repeat-
edly until the message display indicates >Network
Status Page.

>Network Status

Page On

The default setting is On. If it is set to Of f, change it as
follows. Press the ENTER key. A blinking question
mark (?) appears.

>Network Status

L,
Page ? On
21N

Select On using the A or V key.

>Network Status
\l,

Page ? Off

21N

Press the ENTER key again.

>Network Status

Page Off
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1 0 Press the MENU key. The message display returns to

Ready.

-
0y KYOCERE
~Jnita_ m FS-9500DN Page Printer

[ NETWORK STATUS PAGE

Network Status Page

2.2.5 Changing the Emulation

The emulation mode for the current interface can be changed.

1

Press the MENU key.

Press the A or v key repeatedly until Emulation ap-
pears. One of the emulation names shown below ap-
pears, indicating the current emulation.

PCL 6 (default)
KC-GL

KPDL

KPDL (AUTO)
Line Printer
IBM Proprinter
DIABLO 630
EPSON LQ-850

Press the ENTER key. A blinking question mark (?) ap-
pears.

Emulation
Mo
?PCL 6

AR

Press the A or Vv key repeatedly until the desired emu-
lation mode appears.

Press the ENTER key. The > key allows access to sub
item >Code set

6 Press the MENU key. The message display returns to
Ready.

After changing the emulation, you have the option to
change the character code set. Available character
code sets vary depending on the current emulation.

KPDL (AUTO) Emulation

KPDL is the Kyocera’s implementation of the PostScript lan-
guage. The KPDL (AUTO) emulation enables the printer to au-
tomatically change the emulation mode according to the data
received when printing.

In addition to KPDL (AUTO) emulation, you can use the operator
panel to set another emulation mode that is used very often. The
default setting is PCL 6.

1 Press the MENU key.

2 Press the A or V key repeatedly until Emulation >
appears.

Emulation >

PCL 6

3 Press the ENTER key. A blinking question mark (?) ap-
pears.

Emulation
4
?

e
PCL 6
\

4 Press the A or v key repeatedly until KPDL (AUTO)
appears.

Emulation

?KPDL (AUTO)

5 Press the ENTER key.

6 Press the > key. When > Alt. Emulation is dis-
played, press the A or v key. The names of alternative
emulations appear.

PCL 6 (default)
KC-GL

Line Printer
IBM Proprinter
DIABLO 630
EPSON LQ-850

7 Press the ENTER key. A blinking question mark (?) ap-
pears.

Alt. Emulation
AN
)

4
PCL 6
Y
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8
9

Press the A or v key repeatedly until the desired alter-
native emulation appears.

Press the ENTER key.

1 0 Press the MENU key. The message display returns to

Ready.

Auto Printing of KPDL Error

The printer can be set to print error data during KPDL emulation.
If this is set to On, error data will be printed only when trouble oc-
curs during printing. The factory default setting is Of £.

1
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Press the MENU key.

Press the A or v key repeatedly until Emulation >
appears.

Emulation >

PCL 6

Press the ENTER key. A blinking question mark (?) ap-
pears.

Emulation
4
?

’
PCL 6
LY

Select KPDL or KPDL (AUTO) using the A or v key.

Emulation

P
?KPDL

ALY

Press the ENTER key.

Press the > key. The message display changes to that
shown below. If >Print KPDL Errs is displayed
when the KPDL (AUTO) emulation is selected, press
the A or v key to change it.

>Print KPDL Errs

Off

Press the ENTER key. A blinking question mark (?) ap-
pears.

>Print KPDL Errs
s\,
?20ff

ALY

Select On using the A or V key.

>Print KPDL Errs

s,
?20n

ALY

9

Press the ENTER key.

1 0 Press the MENU key. The message display returns to

Ready.

KC-GL Pen Width

The KC-GL emulation mode enables you to set the pen widths
in dots, for pen numbers 1 to 8, and the KC-GL page size.

1

Press the MENU key.

Press the A or v key repeatedly until Emulation ap-
pears on the message display.

Emulation >

PCL 6

If the current emulation is other than KC-GL, press the
ENTER key. A blinking question mark (?) appears.

Emulation

Mo
PCL 6

?
':\

Press the A or v key repeatedly until KC-GL appears.

Emulation

?KC-GL

Press the ENTER key.

Emulation >

KC-GL

Press the > key to move to the >KC-GL Pen Width
submenu.

>KC-GL >

Pen Width

Press the > key.

>>Pen (1) Width
01 dot (s)

Press the A or v key repeatedly until the desired pen
number of 1 to 8 appears.

When the desired pen number is displayed, press the
ENTER key.
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10

11

12

13

To change the pen width, press the > key, then press
the ENTER key. A blinking cursor appears at the width
value.

>>Pen (1) Width

I
327 dot (s)

VAR
T

Press the A or Vv key repeatedly until the desired pen
width in dots (00 to 99) appears. When the desired pen
width is displayed, press the ENTER key.

To set the KC-GL page size, press the <1 key, then
press the A or Vv key until >KC-GL Page Set is dis-
played.

To change the page size, press the ENTER key. A
blinking question mark (?) appears.

>KC-GL Page Set

Mo
? [SPSZ]

AR

Press the 3 or 4 key repeatedly until the desired page
size (A2, A1, AO, B3, B2, B1, BO, and SPSZ) appears.
When selecting SPSZ, printing will be done with the
paper size specified by the PRESCRIBE SPSZ
command. For details, see Programming Manual in the
CD-ROM.

Press the ENTER key to set the page set you just se-
lected.

1 4 Press the MENU key. The display returns to Ready.

2.2.6 Setting the Default Font

You can select the default font for the current interface. In addi-
tion to the internal fonts, all fonts that are downloaded to the
printer memory, or fonts stored on a memory card, hard disk, or
option ROM, can be selected as the default font.

In this menu, you can also set the type and pitch for Courier and
Letter Gothic; as well as print a font list.

Selecting the Default Font

1
2

Press the MENU key.

Press the A or v key repeatedly until Font > appears.

Font >

Press the > key to select an internal font, press the A
or V key repeatedly until Internal appears.

>Font Select >

Internal

To select an option font, press the ENTER key while

> Font Select > is displayed. Press the A or v key
repeatedly until the message display indicates
Option.This operation is possible only when option
fonts are installed in the printer.

Press the > key.

>> T000

The letter before the number indicates the type of font
as follows:

Letter Description

Internal fonts

Soft (down load) fonts

Fonts in an option memory card
Fonts in a RAM disk or hard disk
Fonts in an option ROM

o|T|IZlw

Press the ENTER key. A blinking question mark (?) ap-
pears.

iz
>>21000
l|\

Press the A or v key repeatedly until the desired font
number appears. For font numbers of the internal
fonts, see List of Fonts on page A-1.

>Font Select >

Internal

When the desired font is displayed, press the ENTER
key.

Press the MENU key. The message display returns to
Ready.
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B Changing Type for Courier/Letter Gothic

Courier or Letter Gothic font type can be selected as Regular or
Dark. For example, to change the type of Courier, proceed as
follows:

1 Press the MENU key.

2 Press the A or V key repeatedly until Font > appears.

Font >

3 Press the > key.

4 Check that Internal is displayed and press the >
key.

>Font Select >

Internal

5 Press the A or v key repeatedly until >Courier ap-
pears.

>>Courier

Regular

6 Press the ENTER key. A blinking question mark (?) ap-
pears.

>>Courier
ao
? Regular
=\

7 Select Regular or Dark using the A or V key.
8 Press the ENTER key.

9 Press the MENU key and the message display returns
to Ready.

B Changing the Font Size

You can change the size of the default font. If the default font is
a fixed-pitch font such as Courier or Letter Gothic, the character
pitch can be changed instead of the font size.

1 Press the MENU key.

2 Press the A or v key repeatedly until Font > appears.

Font >
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Press the > key.

Check that Internal is displayed and press the >
key.

>Font Select >

Internal

Press the A or v key repeatedly until >Size appears.

>Size

012.00 point (s)

Press the ENTER key. A blinking cursor () appears.

>Size

I
012700 point (s)

VAN
T

Press the A or v key to increase or decrease the value
of the figure where the cursor is blinking. The font size
can be set between 4 and 999.75 points, in 0.25-point
increments. You can use the > and <1 key to move the
cursor right and left.

When the desired size is displayed, press the ENTER
key.

Press the MENU key. The message display returns to
Ready.

B Setting the Character Pitch for Courier/Letter Gothic

You can set the character pitch for fixed-pitch fonts when the de-
fault font is Courier or Letter Gothic.

1

Press the MENU key.

Press the A or v key repeatedly until Font > appears.

Font >

Press the > key.

Check that Internal is displayed and press the >
key.

>Font Select >

Internal
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9

Press the A or Vv key repeatedly until >Pitch ap-
pears.

>Pitch

10.00 cpi

Press the ENTER key. A blinking cursor () appears.

>Pitch
00 cpi

=

Press the A or v key to increase or decrease the value
of the figure where the cursor is blinking. The character
pitch can be set between 0.44 and 99.99 characters
per inch, in 0.01 character-per-inch increments. You
can use the > and <1 keys to move the cursor right and
left.

When the desired size is displayed, press the ENTER
key.

Press the MENU key. The message display returns to
Ready.

Printing a List of Fonts

To help in selecting fonts, you can print a list of the fonts includ-
ing option fonts.

1

Press the MENU key.

Press the A or V key repeatedly until Font > appears.

Font >

Press the > key.

Press the A or v key repeatedly until List of In-
ternal Fonts appears. List of Option Fonts
appears.

(Internal Fonts)

>List of

Internal Fonts

(Optional Fonts)

>List of

Option Fonts

5 Press the ENTER key. A question mark (?) appears.

(Internal Fonts)

>List of

Internal Fonts?

(Optional Fonts)

>List of

Option Fonts ?

6 Press the ENTER key again. Processing appears,
then Ready. The printer prints a list of fonts with a short
sample and font ID (number) for each font.

List of Fonts

2.2.7 Using Page Set Menus

In Page Set menus, you can set the number of copies, the page
orientation, and other settings regarding pagination.

Setting the Number of Copies

You can set the number of copies of each page to be printed for
the current interface. The number of copies can be set between
1 and 999. The number of copies can be set whenever the mes-
sage display indicates Ready.

1 Press the MENU key.
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2 Press the A or v key repeatedly until Page set > ap-
pears.

Page Set >

3 Press the > key.

4 Press the A or v key repeatedly until >Copies ap-
pears.

>Copies

001

5 Press the ENTER key. A blinking cursor () appears.

>Copies

0034
I|\

6 Press the A or v key to increase or decrease the value
of the figure where the cursor is blinking. It can be set
between 1 and 999. You can use the > and < keys to
move the cursor right and left.

7 When the desired size is displayed, press the ENTER
key.

8 Press the MENU key. The message display returns to
Ready.

Selecting the Reduced Print

You can print with the reduced size. This menu is used to set the
source paper size and the paper size to use after reduction.

NOTE

Printed results when making reductions differ from equivalent
size printing. Sometimes the line width of characters may not be
consistent or lines may appear in figures or image patterns.

Bring up the Zoom menu. The following display will appear.

>Zoom

[CS]—[CS]

\— Target size indicator

Source size indicator

Source size indicator...This is the paper size before reduction.
This must be the same as the paper size set for print data from
the computer.

Target size indicator...This is the paper size after reduction.
This must be the same as the paper size set for the paper cas-
sette.
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The message display will show the messages given in the fol-
lowing table.

Source size indicator Target size indicator
[CS] [CS]
Current cassette size [CS]98%
[1LG] [LG]
Legal size (8-1/2 x 14 inches) | [1L.G] 98%
[LT] [LT]
Letter size (8-1/2 x 11 inches) | [A4]

LT]98%
[LD] [LD]
Ledger size [LD]98%
(12 x 15-1/2 inches)
[ST] [ST]
[02] [02]
[FO] [FO]
[A5] [A5]
(14.8 x 21 cm) [A5]98%
[B5] [B5]
(18.2 x 25.7 cm) [A5]
[B5]98%
[A4] [A4]
(21 x 29.7 cm) [LT]
[B5]
[A5]
[A4]198%
[B4] [B4]
(25.7 x 36.4 cm) [B5]
[A4]
[B4]198%
[A3] [A3]
(29.7 x 42cm) [A4d]
[B4]
[A3]98%

1 Press the MENU key.

2 Press the A or v key repeatedly until Page Set > ap-
pears.

Page Set >

3 Press the > key.

4 Press the A or v key repeatedly until >zoom appears.

>Zoom

[CS]—>[CS]
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5 Press the ENTER key. A blinking cursor (_) appears
under the paper size.

>Zoom

2415 1cs)
23N

6 Press the A or v key to select source size. Both sizes
change will simultaneously.

7 Press the > key to move the cursor to the target size.

8 To make a reduced print, press the A or v key to select
the target size.

>Zoom

o\

INREL

9 Press the ENTER key.
1 0 Press the MENU key. The message display returns to
Ready.

Selecting the Printing Orientation

You can select the portrait or landscape page orientation. The
page orientation can be set whenever the message display indi-
cates Ready.

A >

Portrait Landscape

1 Press the MENU key.

2 Press the A or v key repeatedly until Page Set > ap-
pears.

Page Set >

3 Press the > key.

4 Press the A or v key repeatedly until >0Orientation
appears.

>Orientation

Portrait

8

Press the ENTER key. A blinking question mark (?) ap-
pears.

>Orientation

N ,
? Portrait
:\

Select Portrait or Landscape using the A or V key.
Press the ENTER key.

Press the MENU key. The message display returns to
Ready.

Page Protect Mode

Although Auto is the default setting and this menu does not usu-
ally appear, Page Protect will be forcibly set to On if a Print
overrun Press GO error occurs due to insufficient printer
memory. Be sure to return this setting to Auto in order to main-
tain high printer memory efficiency. This can be done as follows.

1

Press the MENU key.

Press the A or Vv key repeatedly until Page Set > ap-
pears.

Page Set >

Press the > key.

Press the A or Vv key repeatedly until >Page Pro-
tect appears.

>Page Protect

On

Press the ENTER key. A blinking question mark (?) ap-
pears.

>Page Protect

Press the A or v key repeatedly until Auto appears.

>Page Protect

? Auto

Press the ENTER key.

Press the MENU key. The message display returns to
Ready.
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Linefeed (LF) Action

This procedure instructs the printer what to do when it receives
a linefeed code (character code 0AH).

1

8

Press the MENU key.

Press the A or v key repeatedly until Page Set > ap-
pears.

Page Set >

Press the > key.

Press the A or v key repeatedly until >L.LF Action ap-
pears.

>LF Action

LF only

Press the ENTER key. A blinking question mark (?) ap-
pears.

>LF Action
o

LF only

?
TR

Press the A or vV key repeatedly until desired linefeed
action appears.

LF only A linefeed is performed. (default)
CR and LF A linefeed and carriage return are
performed.

Ignore LF The linefeed is ignored.
When the desired action is displayed, press the

ENTER key.

Press the MENU key. The message display returns to
Ready.

Carriage-Return (CR) Action

This procedure instructs the printer what to do when it receives
a carriage-return code (character code ODH).

1
2

3
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Press the MENU key.

Press the A or v key repeatedly until Page Set > ap-
pears.

Page Set >

Press the > key.

4 Press the A or v key repeatedly until >CR Action ap-
pears.

>CR Action

CR only

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>CR Action
s,
? CR only
=\

6 Press the A or Vv key repeatedly until desired carriage-
return action appears.

CR only A carriage-return is performed. (Default)
CR and LF A carriage-return and linefeed are
performed.

Ignore CR The carriage-return code is ignored.

7 When the desired action is displayed, press the
ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Wide A4

Turn this On to increase the maximum number of characters that
can be printed in a line for A4 page (78 characters at 10 pitch)
and Letter size page (80 characters at 10 pitch). This setting is
effective only in PCL 6 emulation.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Page Set > ap-
pears.

Page Set >

3 Press the > key.

4 Press the A or Vv key repeatedly until >wide A4 ap-
pears.

>Wide A4

Off

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Wide A4

N
? Off

TR




Chapter 3 Using the Operator Panel

6 Select On or Of £ using the A or V¥ key.
7 Press the ENTER key.

8 Press the MENU key. The message display returns to
Ready.

2.2.8 Setting the Print Quality

You can make the following settings to enhance the print quality:
Kyocera Image Refinement (KIR), a software algorithm for in-
creasing printout quality; EcoPrint, a printing mode that reduces
toner consumption during printing; printing resolution; and Ad-
justment of the Print Density.

KIR (Kyocera Image Refinement)

This printer incorporates the KIR (Kyocera Image Refinement)
smoothing function. At a resolution of 600 dpi this function pro-
vides high print quality by providing the software enhancement
of print resolution.

With KIR of £ With KIR on (default)

NOTE

Set the print density to 3 when setting the KIR mode. For details
on print density, see page 3-31. You can monitor the KIR test
pattern, the last line on a status page, to make the optimum KIR
mode setting.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Print Quali-
ty > appears.

Print Quality >

3 Press the > key.

4 Press the A or Vv key repeatedly until >KIR Mode ap-
pears.

>KIR Mode

On

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>KIR Mode

6 Select On or Of £ using the A or V key.
7 Press the ENTER key.

8 Press the MENU key. The message display returns to
Ready.

EcoPrint

The EcoPrint enables you to reduce the amount of toner con-
sumed on the page so as to save your printing costs. You can
set EcoPrint mode 0On, as follows. (The factory default setting is
0ff.) The EcoPrint mode setting is On when the printing image
becomes lighter, yet very readable.

5

M/
3

4

EcoPrintsettingis 0f £
(default)

EcoPrint setting is On

NOTE

The EcoPrint setting has no effect on the print speed.

1 Press the MENU key.

2 Press the A or v key repeatedly until Print Quali-
ty > appears.

Print Quality >

3 Press the > key.

Press the A or v key repeatedly until >EcoPrint
Mode appears.

>EcoPrint Mode

Off
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5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>EcoPrint Mode

N
? Off

6 Select On or Of £ using the A or ¥ key.
7 Press the ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Resolution

You can set the default print resolution in three ways: 300 dpi,
600 dpi and Fast 1200 mode. The clarity of printed characters
and graphics becomes sharper in this order. (The factory setting
is Fast 1200 mode.)

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Print Quali-
ty > appears.

Print Quality >

3 Press the > key.

4 Press the A or v key repeatedly until >Resolution
appears.

>Resolution

Fast 1200 mode

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Resolution
N
?\Fast 1200 mode

6 Select Fast 1200 mode or 300 dpi, 600 dpi using the A
or V key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Adjusting the Print Density

The print density can be adjusted in five steps: from 01 (light) to
05 (dark). The factory setting is 03.
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1 Press the MENU key.

2 Press the A or v key repeatedly until Print Quali-
ty > appears.

Print Quality >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Print Den-
sity appears.

>Print Density

03

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Print Density

6 Select the print density from five steps from 01 (light) to
05 (dark) using the A or ¥ key.

7 Press the ENTER key.

8 Press the MENU key. The message display returns to
Ready.

2.2.9 Operating an Option Hard Disk
By installing the option hard disk into the printer, the e-MPS

function can be used. The printer's menu selection system al-
lows you to perform the following operations on the hard disk.

If the option hard disk is not formatted, the >Format menu
will automatically appear on the message display.

* Reading data

» Writing data

* Deleting data

* Printing of list of partitions

Reading Data

Data stored on a hard disk can be read. To read data on a hard
disk, proceed as follows.

1 Press the MENU key.
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7

Press the A or v key repeatedly until Hard Disk >
appears.

Hard Disk >

Press the > key.

Press the A or v key repeatedly until >Read Data ap-
pears. The data name also appears.

>Read Data

DataHOO01

Press the ENTER key. A blinking question mark (?) ap-
pears before the data name.

>Read Data
N,

?DataH001

A

Press the A or v key to display the desired data name.

Press the ENTER key. Processing appears and the
reading of data from the hard disk starts.

Writing Data

When writing to a hard disk, a name is assigned to the file auto-
matically. You can use the procedure explained later in this sec-
tion to print a list of data names for confirmation. To write data
onto a hard disk, proceed as follows.

First check that the hard disk is properly formatted. Otherwise,
the >Write Data message to be explained below will not be
shown on the message display.

1

Press the MENU key.

Press the A or v key repeatedly until Hard Disk >
appears.

Hard Disk >

Press the > key.

Press the A or v key repeatedly until >Write Data
appears.

>Write Data

Press the ENTER key. A question mark (?) appears.

>Write Data ?

Press the ENTER key. Processing appears, then
Waiting.

In this state, send the file from the computer to the
printer.

The file is written onto the hard disk and given a
destination name (also referred to as a partition name)
which the printer automatically assigns one after
another as follows:

DataHO0O01 (first data),
DataHO002 (second data),
DataHO003 (third data)...

In the example above, if the file TEST.TXT is the first
data to be written onto the hard disk, the destination
name will be DataH001.

As the printer receives data, the message display
changes to Processing, then when the end of the
data is received, the message display changes to
Waiting.

Check that the message display has changed to
Waiting, then press the GO key. This writes file to the
hard disk and instructs the printer to automatically print
out a hard disk write information page as shown below.

BYKYOCERA
~Jita_ m FS-9500DN Page Printer
l WRITE INFORMATION |

\/\

Partition Type:

Type of data written (currently

only type 2 is supported).

The destination name of data

written to the hard disk.

Write Partition Length: The size of the written data on
the memory hard disk.

Others: Error information.

Partition Name:

When the hard disk write information page is printed,
the message display returns to Ready.

If the writing was not completed successfully, an error
code appears on the message display. For details, see
Error Messages on page 4-6. If this happens, press the
GO key. The message display returns to Ready.
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Repeat above steps until you have transferred all data
(files) that you want to write to the hard disk. Each time
you finish writing data, a hard disk write information
page is printed from the printer showing the information
explained in step 8 above, but pertaining only to the
data just written. To see all data contained in the hard
disk at once, print a list of data names as explained.
See Printing a List of Data Names on page 3-33.

Deleting Data

Itis possible to use the printer to delete data from a hard disk one
by one. To delete data from a hard disk, proceed as follows.

Check that the hard disk contains data. Otherwise, the >Delete
Data menu will not appear on the message display.

1

Press the MENU key.

Press the A or V key repeatedly until Hard Disk >
appears.

Hard Disk >

Press the > key.

Press the A or Vv key repeatedly until >Delete Data
appears. The data name also appears.

>Delete Data

DataHO001

Press the ENTER key. A blinking question mark (?) ap-
pears before the data name.

>Delete Data

o
?DataH001
A

Press the A or V key to display the desired data name.

Press the ENTER key. Processing appears and the
data is deleted from the hard disk. The message dis-
play returns to Ready.

Printing a List of Data Names

The printer prints a list of all data names (referred to as parti-
tions) stored in a hard disk for reference. To print a list of data
names for the hard disk, proceed as follows.

1
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Press the MENU key.

w

Press the A or v key repeatedly until Hard Disk >
appears.

Hard Disk >

Press the > key.

Press the A or v key repeatedly until >List of Par-
titions appears.

>List of

Partitions

Press the ENTER key. A question mark (?) appears.

>List of

Partitions ?

Press the ENTER key. Processing appears and the
printing of the list starts.

O KYOCERA
~Jnita_ m FS-9500DN Page Printer
[ PARTITION LIST |

Device Information

The printout (example above) includes the following
information;

Device Name/Number: HARD DISK/0 is indicated for
the hard disk.

Capacity: The total capacity of the hard disk in
bytes.

Used Space: The total size of the data stored in the
hard disk in bytes.

Free Space: The size of the capacity remaining in

the hard disk for storing further data,

including the amount of memory that

the printer uses for its system.
Partiton Name: The name of the written data
assigned automatically by the printer.
The size of the written data in bytes.
The type of the written data i.e.,
whether it is host data (Data) or font
data (Font).

Partition Size:
Partition Type:

When the list of file names (partition list) for the hard
disk is printed, the message display returns to Ready.

It also prints out the Directory Status List to confirm the
directory or data that is written in PJL or KPDL
(PostScript).
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2.2.10 Operating a RAM Disk

The RAM disk is a memory space shared within the printer mem-
ory that can temporarily store print jobs. The RAM disk can be
used only for electronic sorting. The stored print job can then be
used to print multiple copies of the job reducing the total amount
of time required to print the whole job. It acts similarly to the hard
disk except that the data is effective only when the printer is pow-
ered up.

To set up the RAM disk, the option hard disk must not be in-
stalled.

To use the RAM disk, activate and enter the desired size of the
RAM disk in the manner described below. The maximum RAM
disk size can be calculated as follows:

Maximum RAM size = Total printer memory minus 24 MB

For example, if the total memory installed in your printer is 32 MB
(Default), you can set 8 MB of RAM disk. If you attempt to set the
RAM disk size beyond this restriction, the printer automatically
rounds it down so that the size is always 24 MB less than the to-
tal printer memory. Once the RAM disk size is set, the printer
must be reset.

To activate RAM disk in the printer's memory, first you must use
the printer's menu selection system. The printer's menu selec-
tion system allows you to perform the following operations on the
RAM disk.

« Setting RAM disk size

* Reading data

* Writing data

« Deleting data

* Printing of list of partitions

By default, the RAM disk is not activated (Off). To confirm the
RAM disk size or activate the RAM disk, proceed as follows:

Setting RAM Disk Size
1 Press the MENU key.

2 Press the A or V key repeatedly until RAM Disk Mode
> appears.

RAM Disk Mode

Off

3 Press the ENTER key. A blinking question mark (?) ap-
pears.

RAM Disk Mode
Ny
? Off

TS

Press the A or v key to select On.

>RAM Disk Mode
s,
? On

PARY

Press the ENTER key. A blinking question mark (?) dis-
appears and > appears on the right side.

RAM Disk Mode >

On

Press the > key.

Press the A or v key repeatedly until >RAM Disk
Size appears. The data size also appears.

>RAM Disk Size

0008 MByte

Press the ENTER key. A blinking cursor (_) appears.

>RAM Disk Size

|
0008’ MByte
PraN
Press the A or v key to display the desired size.
Definable RAM disk size: 0001 to 1024 (display of size

varies depending on the installed RAM size.)

Press the ENTER key. The selected RAM disk size is
activated.

Press the MENU key. The message display returns to
Ready.
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Reading Data

Data stored on a RAM disk can be read. To read data on a RAM
disk, proceed as follows.

1 Press the MENU key.

2 Press the A or vV key repeatedly until RAM Disk
Mode > appears.

RAM Disk Mode >

On

3 Press the > key.

4 Press the A or v key repeatedly until >Read Data ap-
pears. The data name also appears.

>Read Data

DataHO0O01

5 Press the ENTER key. A blinking question mark (?) ap-
pears before the data name.

>Read Data

o
?\DataHOOl

6 Press the A or v key to display the desired data name.

7 Press the ENTER key. Processing appears and the
reading of data from the RAM disk starts.

Writing Data

When writing onto a RAM disk, a name is assigned to the file au-
tomatically. You can use the procedure explained later in this
section to print a list of data names for confirmation.

1 Press the MENU key.

2 Press the A or v key repeatedly until RAM Disk
Mode > appears.

RAM Disk Mode >

On

3 Press the > key.

4 Press the A or v key repeatedly until >Write Data
appears.

>Write Data
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Press the ENTER key. A question mark (?) appears.

>Write Data ?

Press the ENTER key. Processing appears, then
Waiting.

In this state, send the file from the computer to the
printer.

The file is written onto the RAM disk given a
destination name (also referred to as a partition name)
which the printer automatically assigns one after
another as follows:

DataHO001 (first data)
DataHO002 (second data)
DataHO003 (third data)...

In the example above, if the file TEST.TXT is the first
data to be written onto the RAM disk, the destination
name will be DataH001.

As the printer receives data, the message display
changes to Processing, then when the end of the
data is received, the message display changes to
Waiting.

Check that the message display has changed to
Waiting, then press the GO key. This writes the file to
the RAM disk and instructs the printer to automatically
print out a RAM disk write information page as shown
below.

O] KYOCERA
~Juifa_ m FS-9500DN Page Printer
l WRITE INFORMATION |

|
\/\

Partition Type: Type of data written (currently
only type 2 is supported).
Partition Name: The destination name of data

written to the card.

Write Partition Length: The size of the written data on
the memory card.

Others: Error information.

When the RAM disk write information page is printed,
the message display returns to Ready.

If the writing was not completed successfully, an error
code appears on the message display. For details, see
Error Messages on page 4-6. If this happens, press the
GO key. The message display returns to Ready.
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9 Repeat above steps until you have transferred all data
(files) that you want to write to the RAM disk. Each time
you finish writing data, a RAM disk write information
page is printed from the printer showing the information
explained in step 8 above, but pertaining only to the
data just written. To see all data contained in the RAM
disk at once, print a list of data names as explained.
See Printing a List of Data Names on page 3-33.

Deleting Data

It is possible to use the printer to delete data from a RAM disk
one by one. To delete data from a RAM disk, proceed as follows.

Check that the RAM disk contains data. Otherwise, the >De-
lete Data will not appear on the message display.

1 Press the MENU key.

2 Press the A or v key repeatedly until RAM Disk
Mode > appears.

RAM Disk Mode >

On

3 Press the > key.

4 Press the A or Vv key repeatedly until >Delete Data
appears. The data name also appears.

>Delete Data

DataHO0O01

5 Press the ENTER key. A blinking question mark (?) ap-
pears before the data name.

>Delete Data

Ny
?DataH001
[AY

6 Press the A or v key to display the desired data name.

7 Press the ENTER key. Processing appears and the
data is deleted from the RAM disk. The message dis-
play returns to Ready.

Printing a List of Data Names

The printer prints a list of all data names (referred to as parti-
tions) stored in a RAM disk for reference. (Printing a list is also
available for a font card.) To print a list of data names for the
RAM disk, proceed as follows.

1 Press the MENU key.

2 Press the A or v key repeatedly until RAM Disk
Mode > appears.

RAM Disk Mode >

On

3 Press the > key.

4 Press the A or v key repeatedly until >L.ist of Par-
titions appears.

>List of

Partitions

5 Press the ENTER key. A question mark (?) appears.

>List of

Partitions °?

6 Press the ENTER key. Processing appears and the
printing of the list starts.

OYKHOCERE
mifa

m FS-9500DN Page Printer
| PARTITION LIST |

Device Information

Partition Information ]

See Printing a List of Data Names on page 3-33 for
details on device information.

2.2.11 Operating a Memory Card

The printer is equipped with a slot for a memory card. By insert-
ing a memory card into the printer, the following operations be-
come available. For details about the handling of the memory
card, see Appendix D Option Units.

» Reading font data

* Reading data

» Writing data

* Deleting data

» Formatting memory card
* Printing of list of partitions
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Reading Font Data

If a memory card with the font data is already inserted into the
slot when the printer is turned on, the fonts are automatically
read into the printer. To re-read fonts into the printer from a
memory card, proceed as follows.

1 Press the MENU key.

2 Press the A or V key repeatedly until Memory Card >
appears.

Memory Card >

3 Press the > key.

4 Press the A or v key repeatedly until >Read Fonts
appears.

>Read Fonts

5 Press the ENTER key. A question mark (?) appears.

>Read Fonts ?

6 Press the ENTER key. Processing appears and the
reading of data from the memory card starts.

>Read Fonts

Processing

7 Press the MENU key to return to Ready.

Reading Data

Data stored on a memory card can be read. To read data on a
memory card, proceed as follows.

1 Press the MENU key.

2 Press the A or v key repeatedly until Memory Card >
appears.

Memory Card >

3 Press the > key.
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4 Press the A or v key repeatedly until >Read Data
appears. The data name also appears.

>Read Data

DataS001

5 Press the ENTER key. A blinking question mark (?) ap-
pears before the data name.

>Read Data
N
?

V4é
DataS001
AY

6 Press the A or v key to display the desired data name.

7 Press the ENTER key. Processing appears and the
reading of data from the memory card starts.

Writing Data

Data can be written to a memory card until no space is left for
storing. When writing to a memory card, a name is assigned to
the file automatically. You can use the procedure explained later
in this section to print a list of data names for confirmation.

To write data to a memory card, proceed as follows.

First check that the memory card is properly formatted. Other-
wise, the >Write Data message to be explained below will not
be shown on the message display.

If the memory card inserted in the memory card slot is not for-
matted, the >Format will automatically appear on the display.

See Formatting on page 3-38.

1 Press the MENU key.

2 Press the A or v key repeatedly until Memory Card >
appears.

Memory Card >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Write Data
appears.

>Write Data

5 Press the ENTER key. A question mark (?) appears.

>Write Data ?
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Press the ENTER key. Processing appears, then
Waiting.

In this state, send the file from the computer to the
printer.

The file is written onto the memory card given a
destination name (also referred to as a partition name)
which the printer automatically assigns one after
another as follows:

DataS001 (first data),
DataS002 (second data),
DataS003 (third data)...

In the example above, if the file TEST.TXT is the first
data to be written onto the memory card, the
destination name will be DataS001.

As the printer receives data, the message display
changes to Processing, then when the end of the
data is received, the message display changes to
Waiting.

Check that the message display has changed to
Waiting, then press the GO key. This writes the file to
the memory card and instructs the printer to automati-
cally print out a memory card write information page as
shown below.

BYKYOCERE
il _ m FS-9500DN Page Printer
l WRITE INFORMATION |

\/\

Partition Type:

Type of data written (currently
only type 2 is supported).

The destination name of data
written to the card.

Write Partition Length: The size of the written data on
the memory card.

Error information.

Partition Name:

Others:

When the memory card write information page is print-
ed, the message display returns to Ready.

If the writing is not completed successfully, an error
code appears on the message display. For details, see
Error Messages on page 4-6. If this happens, press the
GO key. The message display returns to Ready.

9 Repeat above steps until you have transferred all data
(files) that you want to write to the memory card. Each
time you finish writing data, a memory card write informa-
tion page is printed from the printer showing the informa-
tion explained in step 8 above, but pertaining only to the
data just written. To see all data contained in the memory
card at once, print a list of data names as explained. See
Printing a List of Data Names on page 3-39.

Deleting Data

Itis possible to use the printer to delete data from a memory card
one by one.

To delete data from a memory card, proceed as follows. Check
that the memory card contains data. Otherwise, the >Delete

Data menu will not appear on the message display.

1 Press the MENU key.

2 Press the A or V key repeatedly until Memory Card >
appears.

Memory Card >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Delete Data
appears. The data name also appears.

>Delete Data

DataS001

5 Press the ENTER key. A blinking question mark (?) ap-
pears before the data name.

>Delete Data

\No
?DataS001
:\

6 Press the A or v key to display the desired data name.

7 Press the ENTER key. Processing appears and the
data is deleted from the memory card. The display re-
turns to Ready.

Formatting
Formatting allows data to be written to the card. A new memory

card must be formatted before it can be used in the printer.
Formatting deletes any existing data on the memory card.

To format a memory card, proceed as follows.

1 Press the MENU key.
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2

Press the A or v key repeatedly until Memory Card >
appears.

Memory Card >

Press the > key.

Press the A or Vv key repeatedly until >Format ap-
pears.

>Format

Press the ENTER key. A question mark (?) appears.

>Format 2

Press the ENTER key. Processing appears and for-
matting of the memory card starts.

When the formatting is successfully completed, the
printer automatically prints out a format information

page.

O} KHOCERE
~Jnita_ m FS-9500DN Page Printer
l FORMAT INFORMATION

\/_\

The format information page includes the following
items;

Capacity: The total size of the memory card.

Used Space: The space the printer uses for its sys-
tem.

Free Space: The space remaining in the memory

card for storing data.

When the memory card format information is printed,
the message display returns to Ready.

Printing a List of Data Names

The printer prints a list of all data names (referred to as parti-
tions) stored in a memory card for reference. (Printing a list is
also available for a font card.) To print a list of data names for the
memory card, proceed as follows.

1
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Press the MENU key.

Press the A or v key repeatedly until Memory Card >
appears.

Memory Card >

Press the > key.

Press the A or V key repeatedly until >List of Par-
titions appears.

>List of

Partitions

Press the ENTER key. A question mark (?) appears.

>List of

Partitions ?

Press the ENTER key. Processing appears and the
printing of the list starts.

BYKYOCERE
~Jita_ m FS-9500DN Page Printer
[ PARTITION LIST |

Device Information

Partition Information 1

The printout (example above) includes the following
information.

Device Name/Number: CARD/A is indicated for the
memory card.

Capacity: The total capacity of the memory card
in bytes.
Used Space: The total size of the data stored in the

memory card in bytes.

The size of the capacity remaining in

the memory card for storing further

data, including the amount of

memory that the printer uses for its

system.

Partition Name: The name of the written data
assigned automatically by the printer.

Partition Size:  The size of the written data in bytes.

Partition Type: The type of the written data i.e.,
whether it is host data (Data) or font
data (Font).

Free Space:

When the list of file names (partition list) for the
memory card is printed, the message display returns to
Ready.
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2.2.12 Paper Handling

You can change the MP tray mode, the paper size and type for
each paper source, the sorter mode, the paper source, and pa-
per destinations.

MP Tray Mode

The MP tray can be used in one of two modes: cassette mode or
first mode. The MP tray can hold approximately 200 sheets of
paper (A4 size, 0.11 mm thickness).

H Cassette Mode

The cassette mode provides faster printing speed than the first
mode. Approximately 200 sheets of paper can be continuously
fed in this mode. (This is the factory setting.)

M First Mode (Automatic Manual Feeding)

The printer automatically feeds any paper placed on the MP tray
even if another paper source is selected. After all paper in the
MP tray is printed, paper will be fed from the paper source origi-
nally selected.

1 Press the MENU key.

2 Press the A or v key repeatedly until Paper Han-
dling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key repeatedly until >MP Tray Mode
appears.

>MP Tray Mode

Cassette

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>MP Tray Mode
N

V4
? Cassette
| ]

6 Select First or Cassette using the A or v key.
7 Press the ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Setting the MP Tray Size

When using the MP tray in the cassette mode, you should set
the MP tray size to the paper size that is used to format the job
to print. If they do not match, printing will not be made on the
correct size paper when automatic paper size selection is made
by the application (printer driver). The factory setting is A4 or
Letter size.

For more details about the paper sizes that can be fed from the
MP tray, see Chapter 5 Paper Selection.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper Han-
dling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key repeatedly until >MP Tray Size
appears.

>MP Tray Size

A4

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>MP Tray Size
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6 Press the A or Vv key to display the desired MP tray
size. The display changes as shown below.

A4
Executive
Letter-R
Letter
Legal
Ledger

A3

B4

Custom

c4

Oficio II
Statement
Folio
Youkei 2
Youkei 4
Hagaki
OufukuHagaki
Monarch
Business
Comm. #9
Comm.#6 3/4
DL

C5

A6

B6

A5

B5

B5-R

ISO B5
A4-R

7 Press the ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Setting the MP Tray Type

You can automatically select the paper cassette according to
the selection made by the application (printer driver). The facto-
ry default setting is P1ain.

For more details about the paper types that can be fed from the
MP tray, see Paper Size Unit Selection on page 3-42.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper Han-
dling > appears.

Paper Handling >

3 Press the > key.
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4 Press the A or v key repeatedly until >MP Tray Type
appears.

>MP Tray Type

Plain

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>MP Tray Type
N, ,
? Plain
:\

6 Press the A or v key to display the desired MP tray
type. The display changes as shown below.

Plain
Transparency
Preprinted
Labels

Bond
Recycled
Vellum

Rough
Letterhead
Color
Prepunched
Envelope
Cardstock
Custom (1to8)

7 When the desired MP tray type is displayed, press the
ENTER key.

8 Press the MENU key and the message display returns
to Ready.

Cassette Paper Size Display

The paper loaded in the cassette will be automatically detected
and its size can be displayed in the LCD. To display the correct
size, the paper must be properly loaded in the cassette.

(For details of loading paper, see Chapter 2 How to Load Pa-
per.)

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper Han-
dling > appears.

Paper Handling >

3 Press the > key.
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4 Press the A or Vv key repeatedly until >Cassette
Size appears. The paper size is also displayed.

>Cassettel size

A4

NOTE

* Casette3 Size >orCassette4 Size > appears
when an option paper feeder (PF-70) is installed.

* Casette3 Size > appears when an option paper
feeder (PF-75) is installed.

If option paper feeders are added, Cassettel Size
and Cassette2 Size will appear for the standard pa-
per cassette and Cassette3 Size, and Cassetted
Size will appear for the option paper feeders.

5 Press the MENU key. The message display returns to
Ready.

Paper Size Unit Selection

The paper size unit (metric or inch system) used in the LCD can
be selected beforehand. At the time of Ready or when selecting
the size display, the unit for some paper may be replaced with
the counterpart as shown in the following table.

metric Inch
A3 Ledger (LD)
B4 Legal (1LG)
A4 Letter (LT)
A4-R (n4) Letter-R (LT)
B5 Letter-R (LT)
B5-R (B5) Statement (ST)
A5 Statement (ST)
Folio Legal (1LG)

( ) abbreviated display

For example, when placing the letter size paper in the cassette
while “mm” unit is selected. “A4” will be displayed in the LCD. To
correct the display, use the following procedures.

NOTE

You can set the option paper feeder PF-70 using the same pro-
cedures, but when using the paper feeder PF-75, you cannot se-
lect the paper size and unit.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper
Handling appears.

Paper Handling >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Cassettel
size appears.

>Cassettel size

5 Press the > key. >>Unit appears.

>>Unit

mm

6 Press the ENTER key. A blinking question mark (?) ap-
pears.

>>Unit

7 Press the A or v key to select mm or inch.
8 Select mm or inch, and then, press the ENTER key.

9 Press the MENU key. The message display returns to
Ready.

Setting the Cassette Paper Type

Make this setting to match the paper type fed from the paper
cassette of the printer. If the paper type is set correctly, you can
perform printing using the media type selection function from the
application (printer driver). The factory default setting is Plain.
For more details about the paper types that can be fed from the
paper cassette, see Paper Type on page 5-5.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until pPaper
Handling > appears.

Paper Handling >

3 Press the > key.

Press the A or v key repeatedly until >Cassette 1
Type appears. The paper type also displayed.

>Cassette 1 Type

Plain
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NOTE

*>Cassette 3 Type or >Cassette 4 Type ap-
pears when an option paper feeder (PF-70) is in-
stalled.

* >Cassette 3 Type appears when an option paper
feeder (PF-75) is installed.

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Cassette 1 Type
N ,
? Plain
:\

6 Press the A or v key to display the desired cassette
type. The display changes as shown below.

Plain
Preprinted
Bond
Recycled
Rough
Letterhead
Color
Prepunched
Custom (1l to 8)

7 When the desired cassette type is displayed, press the
ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Selecting the Paper Source

You can select from which paper source printing will be per-
formed. If no option units are installed, the only selections are
the paper cassette and MP tray of the printer. If option paper
feeders are installed, they can also be selected.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper Han-
dling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Feed Select
appears.

>Feed Select

Cassettel
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5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Feed Select
N,
? Cassettel

6 Press the A or Vv key to display the desired paper
source. The display changes as shown below accord-
ing to the installed option units.

Cassettel (Printer’'s standard upper cassette when
option paper feeders are installed)

Cassette2 (Printer's standard lower paper cas-
sette)

MP tray (printer’s MP tray)

Cassette3 (Option upper paper feeder)

Cassetted (Option lower paper feeder)

7 When the desired paper source displayed, press the
ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Setting Duplex Printing

Using the duplex unit, you can automatically print on both sides
of the paper. The duplex unit is installed underneath the printer.

M Binding Setups

The term binding refers to the manner in which printed pages of
paper are joined together (by gluing, stitching, etc.) in book
form. The two possible types of binding are long-edge binding,
in which pages are joined together along their long edge; and
short-edge binding, in which they are joined together along their
short edge. In selecting a binding type, you must also consider
the orientation of the printed page. You can use long-edge or
short-edge binding with either landscape or portrait printing.

Depending on the binding type and print orientation, the duplex
unit provides four types of binding setups. These are: (1) por-
trait, long-edge, (2) portrait, short edge, (3) landscape, long-
edge, and (4) landscape, short-edge. The figure below shows
these binding setups.

(M ) L_ Portrait,
short-edge
Portrait, ——
long-edge
Landscape
(3) short-edge
Landscape, | (4)
long-edge
- 2
Binding Setups

To select duplex printing and binding setup from the operator
panel, proceed as follows.



Chapter 3 Using the Operator Panel

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper
Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key repeatedly until >Duplex Mode
appears.

>Duplex Mode

None

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Duplex Mode

N
?None
=\

6 Press the A or v key to display the desired duplex
mode. The display changes as shown below.

None (default)
Short edge bind
Long edge bind

7 When the desired duplex mode is displayed, press the
ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Selecting the Output Device

You can select whether printouts will be received by the print-
er’s face-down output tray or to the optional document finisher’s
output tray.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper
Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key repeatedly until >Stack
Select appears.

>Stack Select

Finisher F-down

5 Press the ENTER key. A blinking question mark (?) ap-
pears. The selected output device will be displayed.

>Stack Select
Ne oo
?Finisher F-down

:\

6 Press the A or Vv key to display the desired destination.
The output tray changes as shown below.

Face-down tray
Finisher F-up
Finisher F-down

7 When the desired paper source displayed, press the
ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Adjusting the Stitch Positions

When installing the option document finisher DF-75, adjust the
stitch positions using the following procedures. In the default
settings, the stitch position is set in the center of the paper. De-
pending on the paper, a certain amount of deviation will occur.
In this case, also use this menu to adjust the stitch position.

The adjustment can be done by moving the stitch position ad-
justment gear in the document finisher.

For example, select the range from -57 to +57 (1 = approxi-
mately 0.14 mm) to move the stitch position approximately 8
mm as shown in the following figure. The default setting is 000
(center of the paper.)

Default stitch position
(center of the paper)

<4—

Feed direction
-57 +57
(Approx. 8 mm)  (Approx. 8 mm)
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1 Press the MENU key.

2 Press the A or Vv key repeatedly until pPaper
Handling > appears.

Paper Handling >

3 Press the > key. >Stitch Adjust > appears.

>Stitch Adjust >

4 Press the > key. >>A4 /Letter appears.

>>A4/Letter
000

5 Press the A or v key to select A4 /Letter, B4 or A3/
Ledger.

6 When the desired paper size is displayed, press the EN-
TER key. A blinking cursor (_) appears under the value.

>>A4 /Letter

0644

I|\

7 Press the A or v key to increase or decrease, respec-
tively, the value at the blinking cursor. Use the > and <
keys to move the cursor right and left.

Definable value: -057 to 057

8 When the desired value is displayed, press the ENTER
key.

9 Press the MENU key. The message display returns to
Ready.

Overriding A4 and Letter Size Difference

This selects whether to enable or disable the difference between
A4 size and Letter size. Under the default setting of 0f £, the pa-
per size of the paper source is matched to the paper size format-
ting the jobs. If these differ, a corresponding error message is
displayed. When this is set to On, printing is performed even if the
actual paper size differs from the paper size formatting the jobs.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper
Handling > appears.

Paper Handling >
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3 Press the > key.

4 Press the A or v key repeatedly until >Override
A4 /LT appears.

>Override A4/LT

Off

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>0Override A4/LT

N,
? Off

:\

6 Select On or Of £ using the A or V key.
7 Press the ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Customizing Paper Type

The following describes the procedure used to set a user-de-
fined paper type for the printer. Eight custom user settings may
be registered. After having been set, any of these may be called
up when setting the paper type for a paper source.

The paper weight and duplex path can be set (see Setting the
Paper Weight on page 3-46, and Setting the Duplex Path on
page 3-46) after selecting the paper type to be customized as
follows. For how to reset the customized settings, see Resetting
the Type Adjust on page 3-46.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Paper
Handling > appears.

Paper Handling >

3 Press the > key.

4 Press the A or v key repeatedly until >Type Adjust
> appears.

>Type Adjust >

Custom 1
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8

Press the ENTER key. A blinking question mark (?) ap-
pears.

>Type Adjust >
N,
? Custom 1
| ]

Press the A or Vv key to display the desired paper type.
The display changes as shown below.

Custom (1 to 8)
Plain
Transparency
Preprinted
Labels

Bond
Recycled
Vellum

Rough
Letterhead
Color
Prepunched
Envelope
Cardstock

When the paper type to be customized is displayed,
press the ENTER key.

Press the > key and proceed to Setting the Paper
Weight on the following page.

B Setting the Paper Weight

You can set the paper thickness for your custom paper type to
be customized.

1

Display the custom paper type (see Customizing Paper
Type on page 3-45) and press the > key.

Press the A or Vv key repeatedly until >>Paper
Weight appears.

>>Paper Weight

Normal

Press the ENTER key. A blinking question mark (?) ap-
pears.

>>Paper Weight
N,
? Normal
| ]

Press the A or v key to display the desired paper
thickness. The display changes as shown below. For
details of the default setting for each paper type, see
Paper Type on page 5-5.

Normal

Heavy (Thick)
Extra Heavy
Light (Thin)

6

When the desired paper thickness displayed, press the
ENTER key.

Press the MENU Key. The message display returns to
Ready.

B Setting the Duplex Path

If the paper type is set to Custom, you can set whether or not to
enable duplex printing as follows. The default setting is Enable.

1

6

Display the custom paper type (see Customizing Paper
Type on page 3-45) and press the > key.

Press the A or v key repeatedly until >>Duplex
Path appears.

>>Duplex Path

Enable

Press the ENTER key. A blinking question mark (?) ap-
pears.

>>Duplex Path
N,
? Enable
\

Select Enable or Disable using the A or v key. For
details of the default setting for each paper type, see
Paper Type on page 5-5.

Press the ENTER key.

Press the MENU key. The message display returns to
Ready.

Resetting the Type Adjust

Resets the custom setting that are set in Customizing Paper
Type on page 3-45.

1

Press the MENU key.

Press the A or Vv key repeatedly until Paper
handling > appears.

Paper Handling >

Press the > key.

Press the A or v key repeatedly until >Reset Type
Adjust appears.

>Reset Type

Adjust

3-46



Chapter 3 Using the Operator Panel

5 Press the ENTER key. A question mark (?) appears.

>Reset Type

Adjust ?

6 Press the ENTER key. All the customized paper weight
and duplex path settings will be reset to the default.
The message display returns to Ready.

B Verifying the Total Printed Pages and Resetting the Ton-
er Counter

You can display the total number of pages printed by your print-
er for confirmation whenever necessary. The total number of
printed pages can also be checked on the status page. More-
over, for proper maintenance scheduling, it will be necessary to
reset the toner counter using this menu each time a new toner
container is installed.

B Verifying the Total Printed Pages

This procedure only displays the total number of printed pages.
The number cannot be changed.

1 Press the MENU key.

2 Press the A or VvV key repeatedly until Life
Counters > appears.

Life Counters >

3 Press the > key.

4 Press the A or v key until >Total Print appears.

>Total Print

0123456

5 Press the MENU key. The message display returns to
Ready.

B Resetting the Remaining Toner Counter

When the toner container is replaced, reset the toner counter as
follows so that an accurate toner gauge measurement is indi-

cated on the status page. Note that if this operation is per-

formed when the toner container is not replaced, the toner

gauge measurement will not be indicated correctly. Also refer to

the Installation Guide supplied with the toner kit when replacing

the toner container.

1 Press the MENU key.
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2 Press the A or Vv key repeatedly until Life
Counters > appears.

Life Counters >

3 Press the > key.

4 Press the A or Vv key repeatedly until >New Toner
Installed appears

>New Toner

Installed

5 Press the ENTER key. A question mark (?) appears.

>New Toner

Installed ?

6 Press the ENTER key. The toner counter is reset.

7 Press the MENU key. The message display returns to
Ready.

2.2.13 Other Modes

The modes described in the following pages can be accessed in
the Others submenu. To enter the Others submenu, press the
> key while Others > is displayed.

The following submenus can be displayed by pressing the >
key and then the A or v key.

» Message Language Selecting

» Automatic Form Feed Timeout Setting
* Sleep Timer Setting

* Received Data Dumping

* Printer Resetting

» Resource Setting

* Alarm (Buzzer) Setting

* Auto Continue Setting

* Service Menu (for service personnel)

Message Language Selecting

You can select the language of the messages on the message
display by following the procedure given below.

1 Press the MENU key.
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8

1
2

Press the A or Vv key repeatedly until Others > ap-
pears.

Others >

Press the > key.

Press the A or Vv key repeatedly until >MSG
Language appears. The default message language is
English.

>MSG Language

English

To change the language, press the ENTER key. A
blinking question mark (?) appears.

>MSG Language

N, ,
English

?
ALY

Press the A key. The display cycles through the avail-
able selections in the following order (The V¥ key cycles
in the reverse order):

English
Francais
Deutsch
Italiano
Nederlands

Press the ENTER key.

Press the MENU key. The message display returns to
Ready.

Automatic Form Feed Timeout Setting

When the printer receives no data for a certain time, it times out
and releases the current interface: it prints whatever data it has
in its buffer and feeds out the page. You can adjust the time-out
time as follows:

Press the MENU key.

Press the A or Vv key repeatedly until Others > ap-
pears.

Others >

8

Press the > key.

Press the A or v key repeatedly until >Form Feed
Time Out appears. The default setting is 30 seconds.

>Form Feed

Time Out 030sec.

Press the ENTER key. A blinking cursor (_) appears.

>Form Feed

Time out 03éec.

77"

Press the A or v key to increase or decrease the value
of the figure where the cursor is blinking and set the
desired time. The time can be set between 0 and 495
seconds, in 5-second increments. (The printer does not
timeout with the value set to 0.) You can use the > and
<1 keys to move the cursor right and left.

Display the desired time and press the ENTER key.

Press the MENU key. The message display returns to
Ready.

Sleep Timer Setting

The printer has a sleep timer to conserve power when the print-
er is not printing, processing, or receiving data. You can adjust
the timer value, the length of time the printer waits before enter-
ing sleeping mode in the absence of data.

1
2

Press the MENU key.

Press the A or v key repeatedly until Others > ap-
pears.

Others >

Press the > key.

Press the A or Vv key repeatedly until >S1eep Timer
> appears. The default setting is 030 min.

>Sleep timer >

030 min.

Press the ENTER key. A blinking cursor () appears.

>Sleep timer >
O3h’min.

’I‘
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6

7
8

Press the A or v key to increase or decrease the value
of the figure where the cursor is blinking and set the
desired time. The timer can be set between 5 and 240
min, in 5-minute increments. You can use the > and <
keys to move the cursor right and left.

Press the ENTER key.

Press the MENU key. The message display returns to
Ready.

B Turning Off the Sleep Timer

You can turn off the sleep timer function by following the proce-
dure given below.

1
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Press the MENU key.

Press the A or v key repeatedly until Others > ap-
pears.

Others >

Press the > key.

Press the A or v key repeatedly until >Sleep Timer
>appears.

>Sleep timer >

030 min.

Press the > key and display >>Sleep Mode.

>>Sleep Mode

On

Press the ENTER key. A blinking question mark (?) ap-
pears.

>>Sleep Mode

Select Of f using the A or V key.

>>Sleep Mode
s

? Off

AN

Press the ENTER key.

Press the MENU key. The message display returns to
Ready.

Received Data Dumping

It is possible to print data received by the printer as hexadeci-
mal code for the purposes of debugging programs and files.

1

8

Press the MENU key.

Press the A or V key repeatedly until Others > ap-
pears.

Others >

Press the > key.

Press the A or Vv key repeatedly until >Print HEX-
DUMP appears.

>Print HEX-DUMP

Press the ENTER key. A question mark (?) appears.

>Print HEX-DUMP?

Press the ENTER key again. Processing appears for
a second, and then Waiting appears.

Processing

v

Waiting

Send data to be dumped to the printer. The message
Processing will be displayed while receiving the da-
ta.

Once the dumped data you require has been printed, it
is possible to cancel the printing of any further dumped
data by taking the printer offline by pressing the GO
key and then pressing the CANCEL key.

Once all data has been received, the message Wait-
ing will appear. Press the GO key to finish printing.

Printer Resetting

The procedure described below resets the printer’s temporary
conditions, such as the current unit of measurement, page ori-
entation, font, character code set, margins, etc., set by com-
mands to their default values.
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1 Press the MENU key.

2 Press the A or Vv key repeatedly until Others > ap-
pears.

Others >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Printer
Reset appears.

>Printer Reset

5 Press the ENTER key. A question mark (?) appears.

>Printer Reset ?

6 Press the ENTER key again. self test appears
while the printer is resetting itself, then Please wait
followed by Ready.

Self test

v

Please wait

Ready

Resource Protection

When you switch from the PCL 6 emulation to another, all
downloaded fonts and macros are lost. Resource protection
preserves these PCL resources in memory so that they are in-
tact when you change the emulation back to PCL 6.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Others > ap-
pears.

Others >

3 Press the > key.

4 Press the A or v key repeatedly until >Resource
Prot. appears.

>Resource Prot.

Off

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Resource Prot.

N o
? Off

:\

6 Press the A or v key to display the desired mode. The
display changes as shown below.

Of f (default)
Permanent
Perm / Temp

7 When the desired mode is displayed, press the ENTER
key.

8 Press the MENU key. The message display returns to
Ready.

Alarm (Buzzer) Setting

In addition to the message displayed when the paper supply is
exhausted, or when paper jamming occurs, an audio warning is
made to sound. This is useful, for example, when the printer is
in a location some distance from the user.

The audio alarm is set to on when leaving the factory. If the
alarm is set to O£ £, it is made not to sound.

1 Press the MENU key.

2 Press the A or v key repeatedly until Others > ap-
pears.

Others >

3 Press the > key.

4 Press the A or v key repeatedly until > Buzzer ap-
pears.

>Buzzer

On
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5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Buzzer

6 Select On or Of £ using the A or ¥ key.
7 Press the ENTER key.

8 Press the MENU key. The message display returns to
Ready.

Auto Continue Setting

If an error that still allows you to continue printing occurs
(Memory overflow Press GO, Print overrun Press
GO, KPDL error Press GO,and File not found Press
GO), the next received data is automatically printed after a set
period of time elapses. For example, if the printer is shared over
a network as a network printer and one person causes one of
the above errors, after the set period of time elapses, the data
sent from the next person is printed. The factory setting is off.

For setting the auto continue recovery time, see the next sec-
tion.

1 Press the MENU key.

2 Press the A or v key repeatedly until Others > ap-
pears.

Others >

3 Press the > key.

4 Press the A or Vv key repeatedly until Auto
Continue > appears.

>Auto Continue >

Mode Off

5 Press the ENTER key. A blinking question mark (?) ap-
pears.

>Auto Continue

\l,
Mode ? Off

6 Select On or Of £ using the A or ¥ key.
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7 Press the ENTER key.

8 Press the MENU key. The message display returns to
Ready.

B Setting the Auto Continue Recovery Time

Follow the procedure given below to change the recovery time
for Auto Continue.

1 Press the MENU key.

2 Press the A or Vv key repeatedly until Others > ap-
pears.

Others >

3 Press the > key.

4 Press the A or Vv key repeatedly until Auto
Continue Mode > appears.

>Auto Continue >

Mode On

5 Press the > key and display >>Auto Continue
Timer.

6 Press the ENTER key. A blinking cursor ( ) appears.

>>Auto Continue

OSQGec.
71N

Timer

7 Press the A or v key to increase or decrease the value
of the figure where the cursor is blinking and set the
desired time. The time must be set between 000 and
495 seconds, in 5-second increments. If set to 000,
printing will be continued immediately without allowing
any time interval. You can use the > and <1 keys to
move the cursor right and left.

8 Display the desired time and press the ENTER key.

9 Press the MENU key. The message display returns to
Ready.

Service Menu

The service menu contains maintenance operations to be per-
formed by service personnel. The Print Status Page, De-
veloper, and Drum menus appear; however, in general, you
will only need to use the Print Status Page menus.
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B Printing the Service Status Page 8 Press the ENTER key. The message display indicates
The service status page contains printer settings information Processing and printing starts.

that is more detailed than the standard status page and is there-

fore for mostly service purposes. To print a service status page, |I o) NETWORK STATUS PAGE Fs.g5001)1v|-|

proceed as follows;
EEEEN Page 1ot 4

1 Press the MENU key.

2 Press the A or v key repeatedly until Others > ap-
pears.

Others >

3 Press the > key.

4 Press the A or Vv key repeatedly until >Service > ap-
pears.

>Service >

5 Press the > key.

6 Press the A or v key repeatedly until >>Print Sta- -
tus Page appears.
The network interface status page will be printed after
S>Print the printer service status page.

Status Page

7 Press the ENTER key. A question mark (?) appears.

>>Print

Status Page ?
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Chapter 4

Troubleshooting

This chapter explains how to handle printer problems that may occur. If a problem cannot be corrected, contact your Kyocera Mita dealer.

This chapter explains the following topics:

* General Guide
* Print Quality Problems

* Indicators and Messages

* Correcting a Paper Jam

1. General Guide

If some kind of problem should occur, check the following before concluding the printer is broken;

Symptom

Check Items

Corrective Action

The printer will not print
from the computer.

Checkthe (O READY Off Look through the items below and check anything that
indicator. seems appropriate.
Flashing An error has occurred. Check the message display, and
then take measures seeing Indicators and Messages on
page 4-4.
Lit See the appropriate item below.
Check the ! ATTENTION Flashing
indicator. See Indicators on page 4-4.
Lit

A maintenance message appears in the

message display.

See Maintenance Messages on page 4-4.

Print quality is not good.

See Print Quality Problems on page 4-2.

Paper is jammed.

See Correcting a Paper Jam on page 4-8.

Nothing lights on the
operator panel even
when power is turned on
and the fan makes no
noise.

Check thatthe power cord is properly plugged

into the power outlet.

Turn off the printer’s power, plug in the power cord
securely, and try turning on the printer’s power again.

Check that the main switch is really in the ON (| ) position.

The printer prints a status
page, but data from the
computer is not being
printed normally.

Check the interface cable.

Connect both ends of the interface cable securely. Try
replacing the printer cable. For details on the parallel
interface for this printer, see Appendix C Host Computer
Interface.

Check program files and application

software.

Try printing another file or using another print command. If
the problem occurs only with a specific file or application,
check the printer settings for that application.

If you still cannot correct a printer problem even after checking the above, please contact your Kyocera Mita dealer.
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2. Print Quality Problems

As the following table shows, there are many possible causes of print quality problems, such as blank output. The troubleshooting pro-
cedure for each type of problem is explained below. If you still cannot solve the problem, contact your Kyocera Mita dealer.

Printed Results

Corrective Action

Completely blank printout

Check the toner container.

Open the printer front cover and check that the toner container is
correctly installed in the printer. See Toner Container Replacement on
page 6-1.

All-black printout

Check the main charger unit.
Open the printer front cover and check that the main charger unit is
correctly installed.

Dropouts, horizontal streaks, stray dots

ABC
123

ABC

123

ABC
123

Clean the charger wire.
Open the printer front cover. Pull the cleaning knob slowly in and out a
few times. See Toner Container Replacement on page 6-1.

Refresh drum.

See the following procedures in the operator panel and try cleaning the

drum surface using the printer’s built-in cleaning system.

1. Press the MENU key, and then press the A or ¥ key to display
>Others.

2. Pressthe> key, and then press the A or V keytodisplay >Service >.

3. Press the > key, and then press the A or v key to display >>Drum.
And then press the ENTER key twice.

4. The message display shows Please wait, and thenthe drum starts
turning and stops after approx.3 minutes. The printer reverts to
Ready.

Black or white vertical streaks

ABC
123

ABC
123

Check the operator panel.

Ifthe Toner low TK-70 message is displayed and the ! ATTENTION
indicator is flashing, install a new toner kit. See Toner Container
Replacement on page 6-1.

Clean the charger wire.
Open the printer front cover. Pull the cleaning knob slowly in and out a
few times. See Toner Container Replacement on page 6-1.

(Continued on next page)
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Printed Results

Corrective Action

Faint or blurred printing

ABC
123

ABC
123

ABC
123

Check the EcoPrint setting.
When this setting is On, switch it to Of £ on the operator panel. (See
Setting the Print Quality on page 3-30.)

Check the operator panel.

* Ifthe Toner low TK-70 message is displayed and the
! ATTENTION indicator is flashing, install a new toner kit. See Toner
Container Replacement on page 6-1.

»  Setthe print density from the operator panel to a higher level than the
current setting. See Adjusting the Print Density on page 3-31.

* Make sure the paper type setting is correct. See Paper Type on
page 5-5.

Clean the charger wire.
Open the printer front cover. Pull the cleaning knob slowly in and out a
few times. See Toner Container Replacement on page 6-1.

Grey background.

ABC
123

Refresh drum.

See the following procedures in the operator panel and try cleaning the

drum surface using the printer's built-in cleaning system.

1. Press the MENU key, and then press the A or v key to display >0Others.

2. Pressthe > key, and then pressthe A or v key to display >Service >.

3. Press the > key, and then press the A or V¥ key to display >>Drumn.
And then press the ENTER key twice.

4. The message display shows Please wait, and then the drum starts
turning and stops after approx.3 minutes. The printer reverts to Ready.

Check the operator panel.

Ifthe Toner low TK-70 message is displayed and the ATTENTION
indicator is flashing, install a new toner kit. See Toner Container
Replacement on page 6-1.

Check the print density.
Display the print density menu from the operator panel and select a
lighter density setting. See Adjusting the Print Density on page 3-31.

Clean the charger wire.
Open the printer front cover. Pull the cleaning knob slowly in and out a
few times. See Toner Container Replacement on page 6-1.

Check the charger unit installation.

Open the printer front cover and check that the main charger unitis
correctly installed and seated as far as it will go. See Toner Container
Replacement on page 6-1.

Dirt on the top edge or back of the paper

ABC
123

123

Check the paper chute and the ramp.

Open the printer left cover and check for toner on the paper ramp. Clean
the paper ramp using a soft, dry, lint-free cloth. See Toner Container
Replacement on page 6-1.

Check the transfer roller.

Open the printer left cover 1 and
check the transfer roller.

If the transfer roller is dirty with toner,
try printing several pages.

Transfer Roller

Characters out of position.

ABC

192

Check the file or program.

Check whether the problem is being caused by a PRESCRIBE
command error. If the problem occurs only with a specific file or program,
the most likely cause is an error in a parameter to a command or
command syntax.
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3. Indicators and Messages

The tables on the following pages indicate how to respond to problems indicated by the operator panel indicators and messages.

3.1 Indicators

Indicator Condition Description
Flashing An error occurs that you can clear by yourself.
Q - Lit The printer is on-line. The printer is ready to print.
READY
off The printer is off-line. The printer stores but does not print received data. Also indicates when
printing is automatically stopped due to occurrence of an error.
_.@] - Flashing Data transfer is taking place.
DATA Lit Either data is being processed, or data is being written onto the option memory card or hard disk.
' Flashing The printer needs maintenance attention or the printer is warming up (Please wait).
|
b Lit A problem or an error occurs that you can clear by yourself. (For example, a paper jam occurs.
ATTENTION p y yy ( p paper] )
Off Operations are normal.

3.2 Maintenance Messages

The following table lists maintenance messages that you can deal with by yourself. If Call service person appears, turn off the
printer, disconnect the power cord, and contact your Kyocera Mita dealer.

Message

Corrective Action

Add paper (paper
source)

The paper has run out. Supply paper according to the paper source displayed (paper cassette, MP
tray, or optional paper feeder).

Messages indicating the printer status (Ready, Please wait, Processing*, Waiting, and
FormFeed Time Out*)are displayed alternately.
* These messages will not appear when the number of copies is set to 2 or more.

Add staples

No staples are installed in the stapler. Set it in the stapler.

Call service
###4#:0123456

#### represents a mechanical error (#=0, 1, 2, ...).Callfor service.
The printer does not operate when this message is displayed.

The total number of pages printed is also indicated, e.g.

0123456.

Call service
Fé###:

F##H# represents a controller error (#=0, 1, 2, ...).Callforservice.
The printer does not operate when this message is displayed.

Call service
person FO

This message means an error in data communications between the printer controller and the operator
panel. Call for service.
The printer does not operate when this message is displayed.

Chad box full

The punch unit chad box of the option document finisher is full. Discard the chads.

Check chad box
Press GO

The punch unit waste box of the DF-70 document finisher is full or is not installed correctly. Check if the
box is properly installed, and then discard the chads if the box is full. Press the GO key to resume
printing.

Clean printer
Press GO

Clean the inside of the printer. See Toner Container Replacement on page 6-1.

This message will be displayed when replacing the toner container after the message Replace
toner Clean printer is displayed. After cleaning the inside of the printer, press the GO key and
the printer will be ready for printing.

Close finisher
cover

Close the option document finisher cover.
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Message Corrective Action
Close Close the printer front cover.
front cover
Close left Close the printer left cover. If left cover of the option paper feeder is open, 2 or 3 is displayed.
cover 1 (-3)

Close reverse
adapter

Close the reverse adapter cover of the option document finisher.

Face-down tray
paper full

A
N

The face-down tray has become full (approx. 500 pages). You must remove all printed pages from the
face-down tray. When the printer senses that the face-down tray is empty again, it will continue printing
into the face-down tray.

Finisher tray 1(2)
paper full

The finisher tray is full. When removing the paper, printing will be resumed, “1” indicates the upper tray,
while “2” indicates the lower tray.

Finisher
path error

The option document finisher is not installed correctly. Install it correctly.

Install MK

The maintenance kit (MK-700 for FS-9100DN/MK-701 for FS-9500DN) needs to be replaced.

Replace the maintenance kit since the total number of printed pages has reached 500,000. Call for
service. The maintenance kit includes a drum unit, developer unit and so on.

Load Cassette 1(to4)
(paper size)/(paper type)*

*(paper size) and (papertype)
are displayed flashing
alternately.

A
N

There is data for printing that matches with a paper cassette setting (paper size, paper type), but there
is no paper in the paper cassette.

Set paper into the paper source as displayed on the operator panel, and press the GO key to restart
printing. However, the paper source numbers (3 to 4)are only displayed when there is an option
paper feeder installed.

Or, if you want to print from a different paper source press the A or v key to display Use
alternative? and you can change the source for paper feeding.

After selecting a paper source and pressing the MENU key, Paper Handling > appears. By
pressing the > key, the paper type settings menu appears. After setting the correct paper type, press
the ENTER key and printing starts.

Load MP tray
(paper size)/(paper type)

*(paper size) and (papertype)

There is no paper cassette set (paper size, paper type) that matches with the data for printing, so
printing is done from the MP tray. Set paper into the MP tray that matches the paper size and type
shown on the display and press the GO key to restart printing.

Or, if you want to print from a different paper source press the A or ¥ key to display Use
alternative? and you can change the source for paper feeding.

are displayed flashing After selecting a paper source and pressing the MENU key, Paper Handling > appears. By

alternately. pressing the A key, the paper type settings menu appears. After setting the correct paper type, press
i< | the ENTER key and printing starts.

Missing The punch unit chad box of the DF-70 is not installed correctly. Install it correctly.

chad box

Missing Install the toner container. See Toner Container Replacement on page 6-1.

toner container The printer does not operate when this message is displayed.

Missing The stapler unit is not installed correctly in the document finisher. Install it correctly.

stapler unit

Missing waste Install the waste toner box. See Toner Container Replacement on page 6-1. The printer does not

toner box operate when this message is displayed.

Option interface A failure has occurred with the option network interface card.

Error ## Check the option network interface card installed in the printer.

Paper jam Open the front cover or left cover and correct the paper jam (or paper mis-feeding in the paper

A A cassette). The location of the paper jam is also indicated in place of the #’s. Online help messages

which are useful for correcting the paper jam will be displayed by pressing the B key. (See Correcting

42| aPaperJamon page 4-8.)

¥ < :Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.
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Message

Corrective Action

Replace toner
Clean printer

A
/N

Replace the toner container using a new toner kit. The printer does not operate when this message is
displayed. See Toner Container Replacement on page 6-1.

Replace waste
toner box

Replace the old waste toner box with the new one which is included in theTK-70 toner kit. The message
will also be shown if the waste toner box has become full. The waste toner box should be replaced
when the message display eventually shows Toner 1ow TK-70.See Toner Container Replacement
on page 6-1.

Toner low
TK-70

Replace the toner container using a new toner kit. See Toner Container Replacement on page 6-1.

Warning
image adapt

Printing job cannot be done in current resolution because there is not enough internal memory. Try
adding more memory or changing resolution. See Appendix B Expansion Memory.

Warning
Low memory

The printer’s internal memory is running low due to the number of fonts and macros downloaded. Print
a status page to see how much user memory is left, and try deleting unnecessary fonts and macros.

3.3 Error Messages

The following table lists error messages that can be dealt with by the user.

Message

Corrective Action

File not found
Press GO

A
/N

VMB: A VMB tray that was specified for output does not contain any jobs, or the VMB tray is not being
used. Confirm the VMB tray.

If Auto Continue is set to On, printing will be automatically resumed after a preset period of time. See
Auto Continue Setting on page 3-51.

Format error
Memory card

This message appears when the printer is in the ready state and the memory card is not formatted, and
therefore cannot be read or written.

Format error
Hard disk

Initialization (formatting) of the hard disk is required. Initialize the hard disk.

Hard disk err ##
Press GO

A
/N

Look at the error code given in place of ## and refer to the corresponding description given below.

01: hard disk format error. If this error recurs even if the power has been turned off and then on,
reformat the hard disk.

02: Thedisk system is not installed. Recheck the requirements for using the system and the
devices.

04: Thereis no available hard disk space. Delete unnecessary files, etc., to free up space.

05: The specified file does not exist in the hard disk.

06: Thereis no memory available to the hard disk system. Increase the available memory.

10: Formatting is not possible because host data is being spooled on the hard disk.Wait until the
hard disk is ready, and then format.

20: The hard disk was installed in the incorrect slot (OPT2). Reinstall the hard disk in a different slot
(OPT1/HDD).

85: VMB; Alias error (the alias setting was lost, or the VMB tray corresponding to the alias does not
exist). Set the alias again.

97: Code job; The number of permanent code jobs reached the limit value, and no more can be
saved. Either delete some unnecessary jobs, etc., or increae the limit.

99: Aprintjob for the specified ID does not exist in the hard disk.

I/F occupied

This message is displayed when you attempt to use the printer’s operator panel to change the
environmental settings on the interface from which data are presently being received.

ID error

The ID entered for a private job, or a stored job is not correct. Check the ID that is set using the printer
driver.

i< :Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.

(Continued on next page)
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Message

Corrective Action

Insert the same
memory card

You have inserted the wrong memory card when the Insert again message was displayed.
Remove the wrong memory card from the printer’'s memory card slot and insert the correct memory
card. The printer again reads it from the beginning of the data.

KPDL error ##
Press GO

A
/1N

Current print processing cannot continue. To print out an error report, display > Print KPDL errs
from the mode select menu, and select On. Press the GO key to resume printing. You can abandon
printing by the CANCEL key.

If Auto Continue is set to On, printing will be automatically resumed after a preset period of time. See
Auto Continue Setting on page 3-51.

Memory card err
Insert again

The memory card is accidentally removed from the printer’s memory card slot during reading. If you
continue reading the memory card, insert the same memory card into the slot again. The printer again
reads it from the beginning of the data.

Note: We recommend that you follow the reading procedure from the beginning to ensure
correct reading of the memory card.

Memory overflow
Press GO

A
N

The total amount of data received by the printer exceeds the printer’s internal memory. Try adding
more memory (expansion DIMM). Press the GO key to resume printing. You can abandon printing by
the CANCEL key.

If Auto Continue is set to On, printing will be automatically resumed after a preset period of time. See
Auto Continue Setting on page 3-51.

MemoryCard err##
Press GO

A
N

This message appears when an error occurs during access to the memory card using the
PRESCRIBE RWER command or from the printer’s operator panel. Look at the error code given in
place of ## and refer to the corresponding description given below.
01: The memory card does not meet specifications. This memory card cannot be used by this
printer. Inserta memory card which can be used by this printer.
(See Memory Card (CF) on page D-2.)
02: The memory card is not installed. Recheck the requirements for using the memory card.
04: The capacity of the memory card is insufficient. Clean up files.
05: Specified file not on memory card.
06: No memory for use by memory card. Expand printer memory.

Print overrun
Press GO

A
71N

The data transferred to the printer was too complex to print on a page. Press the GO key to resume
printing. (The page may break in some pages.)
You can abandon printing by the CANCEL key.

Note: After this message is displayed, page protect mode will be On. To maintain optimum use
of memory during printing, display >Page protect from the operator panel, and re-
select Auto. See Page Protect Mode on page 3-28.

If Auto Continue is set to On, printing will be automatically resumed after a preset period of time. See
Auto Continue Setting on page 3-51.

RAM disk error ##
Press GO

A
N

Look at the error code given in place of ## and refer to the corresponding description given below.
01: Formaterror. Try turning the power off and on again.

02: RAMdisk modeis Of f. Turn RAM disk mode On.

04: Nodisk space. Clean up files.

05: Specified file is not on disk.

06: No memory for use by disk system. Expand printer memory.

Virtual mailbox
full

The storage area for the VMB is full. Print out accumulated VMB data.

i< :Alarm buzzer sounds when an error occurs. Press the CANCEL key to stop the alarm buzzer.
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4. Correcting a Paper Jam

The Paper jam message is displayed on the message display
when paper becomes stuck in the paper transport system, the
paper feed timing is incorrect, or paper fails to feed at all. The
jam can be corrected by removing the paper.

The printer goes off-line when the Paper jam message is dis-
played.

When a paper jam occurs, a paper jam message and the paper
jam location are indicated on the message display. Details of the
messages and paper jam locations are as follows:

Paper jam message Pager jam location

Description Reference Page

Paper jam
Cassette 1(2)

Paper is jammed at the paper cassette or inside the
A printer. “1” appears with upper cassette, while "2" with 4-9
lower cassette.

Paper jam
Cassette 3(4)

Paper is jammed at the option paper feeder cassette.
B When installing the paper feeder PF-70, “3” appears with 4-9
upper cassette, while “4” with lower cassette.

See document

Paper jam

Remove the paper jammed in the paper stacker. (For

Finisher C details, see the operation guide for document finisher) flnlshgr DF'7.5
Operation Guide
Paper jam D Paper is jammed inside the MP transport. 4-9
MP Transport
Paper Jjam E Paper is jammed at the MP tray. 4-9
MP Tray
. . See document
Paper jam Paper is jammed at the reverse adapter of document .
F L finisher DF-75
Reverse adapter finisher DF-75. Operation Guide
P , Paper is jammed in the left cover section. “3” appears
SPEs el G when jam occurs in the left cover section of the paper 4-10

Left cover 1 (to 3) feeder

When the jammed paper has been removed, open and close the
printer’s front cover. Then the printer automatically warms up,
goes on-line, and continues printing. Depending on the point at
which the jam occurred, the printer may or may not print the
jammed page.

If paper jams occur frequently, try using a different type of paper,
replace with paper from another ream, turn the stack of paper
over, or turn the paper the other way around. Also, look for tiny
pieces of paper that may have been torn off and overlooked
when the jammed paper was removed.

If you cannot solve the problem by changing the paper, there
may be a problem with the printer. Contact your service repre-
sentative.

NOTE
When pulling the paper, pull it gently so as not to tear it. Torn
pieces of paper are difficult to remove and may be easily over-
looked, deterring the jam recovery.

Online help messages

With the online help message function, this printer can display
the procedure to correct a paper jam on the message display.
When a paper jam message is displayed, press the key.

Pressing the v key at the online help message display shows
the next step; pressing the A key shows the previous step. To
exit the online help message display, press the key. The pre-
viously shown paper jam message appears.
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4.1 Jam in Paper Cassette

The following procedure also applies to the optional paper feeder.

1 Pull out the paper cassette.

2 Remove the jammed paper while taking care not to
tear it. If the paper has been torn, remove all the scraps
from the inside the printer.

3 Close the paper cassette.

4.2 Jam at the MP Tray

Paper is jammed at the MP tray. Remove the jammed paper us-
ing the procedure given below.

1 Remove the paper jammed at the MP tray.

4-9

3

5

If the jammed paper remains at the MP tray, pull up the

lever and remove the jammed paper.

* If the mised paper cannot be removed, go to the next
step.

Push the lever (gray colored) to raise the duplex unit
and remove the jammed paper.
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6 Open the front cover. 11 Remove the jammed paper.

\\ AL

=7 =iE]
A
7 & )

> g
R — g
S|
IS}

7 Turn the knob clockwise to release the jammed paper 12 If the paper has been torn, remove the MP transport
from the MP transport tray section. tray.

/ @QJJ
ot

9 Pull out the MP transport tray. 1 4 Replace the MP transport tray in its original position.

1 5 Close the front cover.

4.3 Jam in Left Cover 1

A cAUTION

» Take care not to leave any small pieces of paper in the
printer when removing paper jams as this may result in fire.

« The printer’s fixing unit is extremely hot. Take sufficient care
when working in this area, as there is a danger of getting
burned.

1 0 Open the MP transport tray cover.
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5 Close left cover 1.

1 Pull up the lock lever and open left cover 1.

4.4 Jam in Left Cover 2

N
S U~ [ Open left cover 2.
7 iy :
N =)
- \ S

3 Push the lever (gray colored) to raise the duplex unit
and remove the jammed paper.

2

3 Close left cover 2.

4.5 Paper Jam at the Option Document Finisher

Paper is jammed at the option document finisher. Remove
jammed paper referring to the Document Finisher Operation

Guide.
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Chapter 5

Paper Selection

This chapter explains the following topics:

» General Guidelines
 Special Paper
* Paper Type

1. General Guidelines

The printer is designed to print on high-quality copier bond paper
(the kind used in ordinary dry copier machines), but it can also
accept a variety of other types of paper within the limits specified
below.

NOTE

The manufacturer assumes no liability for problems that occur
when paper not satisfying these requirements is used.

Selection of the right paper is important. Using the wrong paper
can result in paper jams, misfeeding, curling, poor print quality,
and paper waste, and in extreme cases can damage the printer.
The guidelines given below will increase the productivity of your
office by ensuring efficient, trouble-free printing and reducing
wear and tear on the printer.

1.1 Paper Availability

Most types of paper are compatible with a variety of machines.
Paper intended for xerographic copiers can also be used with
the printer.

There are three general grades of paper: economy, standard,
and premium. The most significant difference between grades is
the ease with which they pass through the printer. This is affect-
ed by the smoothness, size, and moisture content of the paper,
and the way in which the paper is cut. The higher the grade of
paper you use, the less risk there will be of paper jams and other
problems, and the higher the level of quality your printed output
will reflect.

Differences between paper from different suppliers can also af-
fect the printer’'s performance. A high-quality printer cannot pro-
duce high-quality results when the wrong paper is used. Low-
priced paper is not economical in the long run if it causes printing
problems.

Paper in each grade is available in a range of basis weights (de-
fined later). The traditional standard weights are 16, 20, and 28
pounds (60 to 105 g/mz).

1.2 Paper Specifications

The following table summarizes the basic paper specifications.
Details are given on the following pages.

Item Specification

Weight Cassette: 60 to 105 g/m2
(16 to 28 Ib/ream)

MP tray: 60 to 200 g/m?
(16 to 53 Ib/ream)

Thickness 0.086t0 0.110 mm (3.4 to 4.3 mils)

Dimensional accuracy +0.7 mm (+£0.0276 inches)

Squareness of corners 90° +0.2°
Moisture content 4106 %
Direction of grain Long grain

Pulp content 80 % or more

1.3 Selecting the Right Paper

Laser printing is a process involving laser light, electrostatic dis-
charge, toner, and heat. In addition, as the paper passes through
the printer it undergoes considerable sliding, bending, and twist-
ing motions. A high-quality printing paper matching the printer’s
requirements withstands all these stresses, enabling the printer
to turn out clean, crisp printed copies consistently.

Remember that all paper is not the same. Some of the factors to
consider when selecting paper for the printer are as follows:

Condition of the Paper

Avoid using paper that is bent at the edges, curled, dirty, torn,
embossed, or contaminated with lint, clay, or paper shreds.

Use of paper in these conditions can lead to illegible printing,
misfeeding, and paper jams, and can shorten the life of the print-
er. In particular, avoid using paper with a surface coating or other
surface treatment. The paper should have as smooth and even
a surface as possible.

5-1



Chapter 5 Paper Selection

MP tray Size Cassette or MP tray Size
Monarch 3-7/8 x 7-1/2 inches Ledger 11 x 17 inches
Business 4-1/8 x 9-1/2 inches Legal 8-1/2 x 14 inches
Commercial 9 3-7/8 x 8-7/8 inches Letter 8-1/2 x 11 inches
Commercial 6-3/4 3-5/8 x 6-1/2 inches Statement 5-1/2 x 8-1/2 inches
International DL 11 x22cm Folio 210 x 330 mm
International C5 16.2x22.9cm ISO A3 297 x 420 mm
ISO A6 105 x 148 mm ISO A4 210 x 297 mm
JISB6 128 x 182 mm ISO A5 148 x 210 mm
International B5 17.6 x25cm JIS B4 257 x 364 mm
Executive 7-1/4 x 10-1/2 inches JISB5 182 x 257 mm

International C4 229 x 324 mm

oficio Il 8-1/2 x 13 inches
Hagaki 100 x 148 mm
Oufuku Hagaki 148 x 200 mm
Youkei 2 114 x 162 mm
Youkei 4 105 x 235 mm

Paper with other sizes (custom sizes) can also be fed from the MP
tray. The minimum size paper for manual feed is 88 x 148 mm (3-
1/2 x 5-13/16 inches), fed lengthwise. The maximum size is 297 x
450 mm (11-11/16 x 17-3/4 inches).

Composition

Do not use paper that has been coated or surface-treated and
contains plastic or carbon. The heat of fusing can cause such
paper to give off harmful fumes.

Bond paper should contain at least 80 % pulp. Not more than
20 % of the total paper content should consist of cotton or other
fibers.

Paper Size

Cassettes and an MP tray are available for the paper sizes listed
in the table above. The dimensional tolerances are +0.7 mm
(£0.0276 inches) for the length and width. The angle at the cor-
ners must be 90° £0.2°.

Smoothness

The paper should have a smooth, uncoated surface. Paper with
a rough or sandy surface can cause voids in the printed output.
Paper that is too smooth, however, can cause multiple feeding
and fogging problems. (Fogging is a gray background effect.)

Basis Weight

Basis weight is the weight of a standard quantity of paper. In the
traditional system, the standard quantity is a ream consisting of
500 sheets measuring 17 x 22 inches each. In the metric system
the standard quantity is 1 square meter.

Paper that is too light or too heavy can cause misfeeding, jams,
and premature wear of the printer. Uneven paper weight can
cause multiple feeds, print defects, poor toner fusing, blurring,
and other print quality problems. The proper weight is 60 to 105
g/m2 for the paper cassette, and 60 to 200 g/m2 for the MP tray.

Thickness (Caliper)

Thick paper is referred to as high-caliper paper and thin paper as
low-caliper paper. The paper used with the printer should be nei-
ther extremely thick nor extremely thin. If you are having prob-
lems with paper jams, multiple feeds, and faint printing, the
paper you are using may be too thin. If you are having problems
with paper jams and blurred printing, the paper may be too thick.
The proper thickness is 0.086 to 0.110 mm (3.4 to 4.3 mils).

Moisture Content

Moisture content is defined as the percent ratio of moisture to the
dry mass of the paper. Moisture can affect the paper’s appear-
ance, feedability, curl, electrostatic properties, and toner fusing
characteristics.

The moisture content of the paper varies with the relative humid-
ity in the room. When the relative humidity is high and the paper
absorbs moisture, the paper edges expand, becoming wavy in
appearance. When the relative humidity is low and the paper los-
es moisture, the edges shrink and tighten, and print contrast may
suffer.
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Wavy or tight edges can cause misfeeding and alignment anom-

alies. The moisture content of the paper should be 4 to 6%. To

ensure the proper moisture content, it is important to store the

paper in a controlled environment. Some tips on moisture control

are:

« Store paper in a cool, dry location.

» Keep the paper in its wrapping as long as possible. Rewrap
paper that is not in use.

« Store paper in its original carton. Place a pallet, etc., under the
carton to separate it from the floor.

» After removing paper from storage, let it stand in the same
room as the printer for 48 hours before use.

* Avoid leaving paper where it is exposed to heat, sunlight, or
damp.

Paper Grain

When paper is manufactured, it is cut into sheets with the grain
running parallel to the length (long grain) or parallel to the width
(short grain). Short grain paper can cause feeding problems in
the printer. All paper used in the printer should be long grain.

Other Paper Properties

Porosity: Refers to the density of the paper structure; that is,
how openly or compactly the fibers are bonded.

Stiffness: Limp paper can buckle inside the printer, while paper
that is too stiff may bind. Either way the result is a paper jam.

Curl: Most paper has a natural tendency to curl in one direction.
The paper should be loaded so that the natural curl is downward,
to counteract the upward curl imparted by the printer. Printed
sheets will then come out flat. Most paper also has a top and bot-
tom surface. Loading instructions are usually given on the paper
package.

NOTE

If the paper is considerably curled in one direction, e.g. when the
paper was used to print on one side, try to roll the paper in the
opposite direction to counteract the curl. Printed sheets will then
come out flat.

Electrostatic properties: During the printing process, the paper
is electrostatically charged to attract the toner. The paper must
be able to release this charge so that printed sheets do not cling
together in the output tray.

Whiteness: The contrast of the printed page depends on the
whiteness of the paper. Whiter paper provides a sharper, bright-
er appearance.

Quality control: Uneven sheet size, corners that are not
square, ragged edges, welded (uncut) sheets, and crushed edg-
es and corners can cause the printer to malfunction in various
ways. A quality paper supplier should take considerable care to
ensure that these problems do not occur.

Packaging: Paper should be packed in a sturdy carton to pro-
tect it from damage during transport. Quality paper obtained
from a reputable supplier is usually properly packaged.

2. Special Paper

This section explains printing on special paper. The page printer
can use the following types of special paper. In this case, set the
media type according to the table below.

Paper type to be used Media type to be selected
Colored paper Color
Preprinted paper Preprinted
Overhead projector Transparency
transparencies
Postcards Cardstock
Envelopes Envelope
Label Labels

When using the above types of paper, be sure to use products
that are specified for use with photocopiers and/or page printers.
Feed paper other than colored paper or preprinted paper from
the MP (multi-purpose) tray. Use paper that is sold specifically
for use with copiers (heat-fusing type). Label paper and enve-
lopes should not be placed in the cassette.

Since the composition and quality of special paper vary consid-
erably, special paper is more likely than white bond paper to give
trouble during printing. No liability will be assumed if moisture,
etc., given off in printing on special paper causes harm to the
machine or operator.

NOTE

Before purchasing any type of special paper, test a sample on
the printer and check that print quality is satisfactory.

Specifications for each type of special paper are given below.

2.1 Transparency (Overhead Projection Film)

Transparency must be able to withstand the heat of fusing during
the printing process. It should satisfy the conditions given in the
table below.

Item Specification

Tolerance of heat Must tolerate at least 190 °C

(374 °F)

Thickness 0.100t00.110mm (3.9t0 4.3
mils)

Material Polyester

Dimensional accuracy +0.7 mm (£0.0276 inches.)

Squareness of corners 90°+0.2°

If transparency jams frequently, pull the top of the sheet very
gently as it leaves the printer.
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2.2 Adhesive-Backed Labels

The basic rule for printing on adhesive labels is that the adhesive
must never come into contact with any part of the printer. Adhe-
sive paper sticking to the drum or rollers will damage the printer.
Label paper must be manually fed.

Label paper has a structure comprised of three layers, as shown
in the figure below. The top sheet is printed on. The adhesive
layer consists of pressure-sensitive adhesives. The carrier sheet
(also called the linear or backing sheet) holds the labels until
use. Due to the complexity of its composition, adhesive-backed
label paper is particularly likely to give trouble in printing.

Top sheet (White
bond paper)
Adhesive

Carrier sheet

Adhesive label paper must be entirely covered by its top sheet,
with no spaces between the individual labels. Labels with spaces
in between are apt to peel off, causing serious paper jam prob-
lems.

Some label paper is manufactured with an extra margin of top
sheet around the edge. Do not remove the extra top sheet from
the carrier sheet until after printing is finished.

Acceptable Unacceptable
«— TOp
sheet
Carrier
sheet =

The table below lists the specifications for adhesive label paper.

Item Specification

Weight of top sheet 44t074 g/m2 (12 to 20 Ib/ream)

Composite weight 104 to 151 g/m2 (28 to 40 Ib/ream)

Thickness of top sheet 0.086t0 0.107 mm (3.9 to 4.2 mils)

Composite thickness 0.115t0 0.145 mm (4.5t0 5.7 mils)

Moisture content 4 to 6 % (composite)

Envelopes

The printer can print on envelopes using paper with a basis
weight of 60 to 79 g/m2 (16 to 21 Ib/ream). Envelopes must be
manually fed.

An envelope is a more complex object than a single sheet of pa-
per. For this reason, it may not be possible to obtain consistent
print quality over the entire envelope surface.

Many envelopes have a diagonal grain orientation (See Paper
Grain on page 5-3). This orientation is more likely to wrinkle and
crease on its way through the printer. Before purchasing enve-
lopes for use with the printer, test a sample to verify the enve-
lope’s suitability.

Do not use envelopes that have an encapsulated liquid adhe-
sive.

Avoid long printing runs consisting of envelopes only. Extensive
envelope printing can cause premature printer wear. To avoid
jamming due to curled envelopes, do not leave more than ap-
proximately 10 printed envelopes stacked in the paper trays dur-
ing multiple envelope printing.

Colored Paper

Colored paper should satisfy the same conditions as white bond
paper, listed in Paper Specifications on page 5-1. In addition, the
pigments used in the paper must be able to withstand the heat
of fusing during the printing process (up to 200 °C or 392 °F).

Preprinted Paper

Preprinted paper should have a bond paper base. The preprint-
ed ink must be able to withstand the heat of fusing during the
printing process, and must not be affected by silicone oil.

Do not use paper with any kind of surface treatment, such as the
type of paper commonly used for calendars.

Recycled Paper

Select recycled paper that meets the same specifications as the
white bond paper (see Paper Specifications on page 5-1) except
whiteness.

NOTE

Before purchasing recycled paper, test a sample on the printer
and check that the print quality is satisfactory.
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3. Paper Type

The printer is capable of printing under the optimum setting for

the type of paper being used.

Setting the paper type for the paper source from the printer's op-
erator panel will cause the printer to automatically select the paper

source and print in the mode best suited to that type of paper.

A different paper type setting can be made for each paper source
including the MP tray. Not only can preset paper types be select-
ed, but it is also possible for you to define and select customized

paper types. See Customizing Paper Type on page 3-45.

The following types of paper can be set.

Paper
source Duplex path
MP Pé‘apse_r Paper av;wapbtlgagnly
. tray sette Weight in Cassette

Media mode)

Type

Plain Yes Yes Normal Yes

Transparency| Yes No Extra No
Heavy

Preprinted Yes Yes Normal Yes

Labels Yes No Normal No

Bond Yes Yes Normal Yes

Recycled Yes Yes Normal Yes

Vellum Yes No Light (Thin) No

Rough Yes Yes Normal Yes

Letterhead Yes Yes Normal Yes

Color Yes Yes Normal Yes

Prepunched Yes Yes Normal Yes

Envelope Yes No Heavy No
(Thick)

Cardstock Yes No Heavy No
(Thick)

Custom 1 Yes Yes Normal Yes

(to 8)

*

Yes: Can be stored No: Cannot be stored
This is a paper type defined and registered by the user. Up to eight

types of user settings may be defined. For details on Customizing
Paper Type on page 3-45.
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This chapter explains how to replace the toner container and the
waste toner box and how to clean the internal parts of the printer.

When you replace the toner container, make sure to clean the in- Replace the toner container using the following procedures.
ternal parts of the printer.

1. Toner Container Replacement

The toner container in the printer should be replaced as soon as
the message display shows Toner low TK-70 or soon after.
If you continue to use the printer, eventually the toner supply will
be exhausted at which point the printer will stop printing and the
Replace toner Clean printer message will be shown in-
structing you to install a new toner kit.

1.2 Replenishing Toner

1 Open the printer front cover all the way.

1.1 Toner Container Replacement Interval

Assuming an average toner coverage of 5 % and Ecoprint mode

turned off, the toner container will need replacing approximately

once every 40,000 pages.*

* For a new printer with a toner kit installed for the first time, the
number of copies that can be printed will be approximately
20,000.

2 Push the lock lever (blue colored) up and gently re-
move the toner container until its handle appears.

Toner Kits to be Used
Name: TK-70 (40,000 pages)
Contents: Toner container
Waste toner box
Wiper cloth
Grid cleaner
2 plastic bags (for disposal of the old toner container
and waste toner box)
Installation Guide

NOTE
NOTE Do not pull the toner container all the way as it can fall
* Be sure to distance items such as floppy disks during toner off and the toner spots the floor.

container replacement.

* Be sure to clean the inside of the printer when replacing the
toner container.

* Use of original Kyocera Mita toner kits is highly recommended
to prevent printer trouble and ensure the long life of the printer.
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3 Grasp the handle on the toner container, push the lock 7 Grasp the handle on the toner container and insert the
lever up again and gently lift the toner container. toner container along the rail of the printer.

4 Seal up the old toner container with the supplied plastic
bag and dispose of it.

When inserting, be sure that the gear side of the
toner container faces the printer. Leave the front
cover open to allow insertion of the waste toner
box.

"N Gear Side ———>\ L)

To the Printer

5 Lightly tap the new toner on the top 5 to 6 times.

8 Hold the toner container by hands and fully insert it into
the printer.

6 Thoroughly shake the toner container (in the direction
of the arrow) ten times or more to loosen and mix the
toner inside. 9

ure.
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10

11

12

6-3

Remove the seal from the rear of the old waste toner
box, and then close the opening of the box with the
seal. Seal up the old waste toner box with the supplied
plastic bag and dispose of it.

Gently pull the cleaning knob as far as it will go, push
and pull it several times, and then push it back in.

Take out the new grid cleaner from the protective bag,
and then remove the cap from the grid cleaner.

13 Pull the main charger approximately 5 cm (2 inches)
out.

1 4 While avoiding the main charger roller (A) to be in con-
tact with the grid cleaner pad, push and pull the main
charger several times. (Do not push the main charger
all the way in. Otherwise, water from the pad will cause
the main charger unit to become we and this may affect
printing.)

When the grid is clean, remove the grid cleaner from
the printer and dispose of it. The grid cleaner is not re-
usable.

1 5 Fit the new waste toner box to the printer.




Chapter 6 Maintenance

1 6 Remove the blue colored cleaning brush.

1 7 Pull up the lock lever on the left side of the printer, and
open the left cover 1.

1 8 Clean the separator by moving the cleaning brush from
left to right along with the separator.

1 9 Replacing of toner and cleaning of the internal parts of
the printer are completed. Close the front cover and the
left cover 1.

Allow approximately five minutes before using the
printer until the main charger unit has dried up.



Appendix A Fonts

This appendix explains the types of fonts you can use with the printer. A font is a set of characters of a particular design. The design is
referred to as a typeface. Several characteristics identify a font. These include the code set (For details on the code sets, read the Pro-
gramming Manual on the supplied Kyocera Mita Digital Library CD-ROM and Kyocera Mita Network Library CD-ROM), spacing, pitch,
height, style, stroke weight, and typeface family.

List of Fonts

This section contains a full list of the printer’s internal fonts. The printer has 80 PCL fonts and 136 PostScript Level 3 compatible fonts.
You can print the font list from the printer by using the printer's operator panel key. To print a list of fonts, refer to Printing a List of Fonts
on page 3-26. Font may be downloaded to the printer's memory from a option memory card or hard disk.
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B PCL (Scalable and Bitmap) Fonts

AlbertusMd
ABCDEabcde?*‘012345’
AlbertusExtBd
ABCDEabcde?*‘012345”
AntiqueOlive
ABCDEabcde?*'012345'
AntiqueOlive-Bd
ABCDEabcde?*'012345’

AntiqueOlive-It

ABCDEabcde?*'012345’

Arial
ABCDEabcde?*'012345’
Arial-Bd
ABCDEabcde?*012345’
Arial-It
ABCDEabcde?*012345’
Arial-Bdlt
ABCDEabcde?*012345’
CGOmega
ABCDEabcde?*'012345’
CGOmega-Bd
ABCDEabcde?*‘012345’
CGOmega-It
ABCDEabcde?*'012345”
CGOmega-BdIt
ABCDEabcde?*012345’
CGTimes
ABCDEabcde?*012345°
CGTimes-Bd
ABCDEabcde?*¢012345’
CGTimes-It

ABCDEabcde?* ‘012345
CGTimes-BdIt
ABCDEabcde?*012345°
Clarendon-Cd
ABCDEabcde?*‘012345°

Courier
ABCDEabcde?**012345"
Courier-Bd
ABCDEabcde?*'012345”

Courier-It
ABCDEabcde?*'012345"
Courier-BdIt
ABCDEabcde?*'012345"
CourierPS
ABCDEabcde?**012345"
CourierPS-Bd
ABCDEabcde?*'012345"
CourierPS-Ob
ABCDEabcde?*'012345"
CourierPS-BdOb
ABCDEabcde?*'012345"/
Coronet

ABCDEdbede? 012345
GaramondAntiqua
ABCDEabcde?*012345
Garamond-HIb

ABCDEabcde?*012345°

Garamond-Krsv

ABCDEabcdes*012345°

Garamond-HIbKrsv

ABCDEabcdes*012345°

Helvetica

ABCDEabcde?*'012345’

Helvetica-Bd

ABCDEabcde?*012345’

Helvetica-Ob

ABCDEabcde?*012345°

Helvetica-BdOb

ABCDEabcde?*012345’

Helvetica-Nr

ABCDEabcde?*012345’

Helvetica-NrBd
ABCDEabcde?*012345’
Helvetica-NrOb
ABCDE abcde?*012345°

Helvetica-NrBdOb

ABCDEabcde?*012345°

ITCAvantGardeGothic-Bk

ABCDEabcde?*'012345°

ITCAvantGardeGothic-Dm

ABCDEabcde?*‘012345’

ITCAvantGardeGothic-BkOb

ABCDEabcde?*'012345°

ITCAvantGardeGothic-DmOb

ABCDEabcde?** 012345’

ITCBookman-Lt

ABCDEabcde?*012345’

ITCBookman-Dm

ABCDEabcde?*'012345’

ITCBookman-Ltlt

ABCDEabcde?*012345°
ITCBookman-Dmlt
ABCDEabcde?*012345’
ITCZapfChancery-MdIt

ABCDEabedes* 012345
ITCZapfDingbats

Gl b Okt @ FTooee /X

LetterGothic

ABCDEabcde?**012345°

LetterGothic-Bd

ABCDE abcde?* 012345’

LetterGothic-It

ABCDEabcde?* 012345

Marigold

ABCDEnbede?*012345’
NewCenturySchoolbook-Rom

ABCDEabcde?*012345

NewCenturySchoolbook-Bd

ABCDEabcde?#012345

NewCenturySchoolbook-It

ABCDEabcde?*012345°

NewCenturySchoolbook-BdIt

ABCDEabcde?*012345’

Palatino

ABCDEabcde?* (012345

Palatino-Bd

ABCDEabcde?*012345’

Palatino-It

ABCDEabcde?*' 012345’

Palatino-BdIt

ABCDEabcde?*012345’

Symbol

ABXAEofy0e?+012345

SymbolPS

ABXAEoBy0e?+:012345

TimesNewRoman

ABCDEabcde?*°012345°

TimesNewRoman-Bd

ABCDEabcde?*°012345°

TimesNewRoman-It
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AlbertusMT

ABCDEabcde?*012345’

AlbertusMT-Italic

ABCDEabcde?*°012345

AlbertusMT-Light
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AntiqueOlive-Bold

ABCDEabcde?*'012345’
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ABCDEuabhcde?*'012345"

AntiqueOlive-ltalic

ABCDEabcde?*'012345’

AntiqueOlive-Roman

ABCDEabcde?*'012345’

Apple-Chancery
ABCDEabcde?*012345’
Arial-BoldItalicMT
ABCDEabcde?*012345’
Avrial-BoldMT
ABCDEabcde?*'012345’

Arial-ltalicMT

ABCDEabcde?*012345’

ArialMT

ABCDEabcde?*'012345’

AvantGarde-Book

ABCDEabcde?*'012345°
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GillSans-Boldltalic

ABCDEabcde?*012345’

GillSans-Condensed

ABCDE abede?™ 012345

GillSans-ExtraBold

ABCDEabcde?*‘012345°

GillSans-Italic

ABCDEabcde?*012345’

GillSans-Light

ABCDEabcde?*012345’

GillSans-Lightltalic

ABCDEabcde?*'012345
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ABCDEabcde?*012345’
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O
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Expansion Memory

This appendix first explains how to remove the main circuit board
and then how to install a DIMM (Dual In-line Memory Module) on
the main circuit board.

Expanded printer memory enables you to print more complex
pages, download more fonts, and define more macros.

1. Removing the Main Circuit Board

The main circuit board of the printer is equipped with two sockets
for memory expansion. Expansion memory is available in the
form of DIMMs.

NOTE

The expansion memory should be installed only by a Kyocera
Mita authorized dealer or Kyocera Mita certified technician. Ky-
ocera Mita shall not be liable for damage due to improper instal-
lation of the expansion memory.

The following instructions are intended for the technician only.

1.1 Notes on Handling the Main Circuit
Board and DIMM

Protect the electronics by taking these precautions:

* Before touching the main circuit board and DIMM, touch a wa-
ter pipe or other large metal object to discharge yourself of
static electricity. While doing the work, it is recommended that

you wear an antistatic wrist strap.

* Touch the main circuit board and DIMM only at the edges.

B-1

1.2 Removing the Main Circuit Board from
the Printer

Remove the main circuit board completely from the printer as fol-
lows:

Turn off the printer and disconnect the power cord and
printer cable.

2 Remove the two screws from the printer.

(<o)
AN

jh
e

@@S\V {

3 Pull the main circuit board all the way out of the printer.

NOTE

Before pulling the main circuit board out, clear away the area,
behind the printer. Foreign objects, accidentally sticking to the
back of the main circuit board, can cause serious damage to the
printer.
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2. Installing DIMMs

H DIMMs to be used

See your Kyocera Mita dealer for purchasing information of the
DIMMs that are best suited for use with this printer. 16 MB, 32
MB, 64 MB, and 128 MB DIMMs can be used for memory ex-
pansion.

Insert the DIMM into the socket as shown below.

1 Remove the DIMM from its package.
2 Open the clips on both ends of the DIMM socket.

3 Insert the DIMM into the socket, so that the notches on
the DIMM align with the corresponding protrusions in
the socket.

4 Close the clips of the DIMM socket to secure the
DIMM.

5 When you finish installing the DIMM, reinsert the main
circuit board into the printer by reversing the removal
procedure.

2.1 Removing DIMM

To remove a DIMM, carefully pull the end clips outwards, then
pull the DIMM out of the socket.

Return the main circuit board to the printer by reversing the pro-
cedure explained in Removing the Main Circuit Board from the
Printer on page B-1.

2.2 Testing the Expansion Memory

After you finish installing DIMMs in the printer, test the printer to
see if the installation was successful. To test the expansion
memory, proceed as follows:

1 Make sure the printer is turned off. Plug the power cord
into the printer and turn the printer on.

Press the MENU key on the operator panel.

Press the A or v key repeatedly until Print Status
Page appears.

Press the ENTER key twice.

If the installation was successful, the amount of memo-
ry shown on the status page will correspond with the
amount of expanded memory. (The factory installed
memory size is 32 MB.)

a A~ O DN



Host Computer Interface

Appendix C

in the table indicate signals that are low active. The table also in-
dicates whether each signal is incoming or outgoing with respect
to the printer.

This appendix explains the signals used in the printer’'s parallel
and RS-232C interfaces. It also lists pin assignments, signal
functions, timings, connector specifications, and voltage levels.
The RS-232C protocols are also covered. Finally, it explains how

to use the printer in a multi-computer environment. Parallel Connector Pin Assignment

This appendix explains the following topics: Pin In/out Description
1 In Strobe* [nStrobe]
* Parallel Interface 2 In/Out | Data 0 [Data 1]
* Serial Interface 3 In/Out | Data 1 [Data 2]
* RS-232C Protocol . 4 In/Out | Data 2 [Data 3]
* RS-232C Cable Connection 5 In/Out | Data 3 [Data 4]
6 In/Out | Data 4 [Data 5]
7 In/Out | Data 5 [Data 6]
1. Parallel Interface 8 In/Out | Data 6 [Data 7]
9 In/Out | Data 7 [Data 8]
1.1 Parallel Interface Communication 10 Out | Acknowledge” [nAck]
Modes 11 Out Busy [Busy]
12 Out Paper Empty [PError], returns paper
The printer features fast data transmission with the parallel inter- empty status if FRPO 02=2
face. The parallel interface mode can be activated from the op- 13 Out | Online (Select)[nSelect], returns off-line
erator panel. status if FRPO 02=2
See Changing Parallel Interface Modes on page 3-18. 14 In Auto-feed [nAutoFd]
15 - Not connected
NOTE 16 - ovDC
Use a parallel printer cable that complies with the IEEE1284 17 - Chassis GND
standard. 18 - +5VDC
19 - Ground
Nibble (high) [default] 20 - | Ground
High speed data communication is used in compliance with the 21 - Ground
IEEE1284 standard. Ordinarily, you should leave this setting un- 22 - Ground
changed. 23 - Ground
24 - Ground
Auto 25 - Ground
The printer automatically changes its communication mode to 26 - Ground
the one the host computer is currently using. 27 - Ground
28 - Ground
Normal 29 - Ground
The printer uses the standard communication method pre-
scribed for Centronics interfaces. 30 _ Ground -
31 In Ignored [nlnit]
High-speed 32 Out Error*, returns error status if FRPO
Thgi’s m(?de enables faster data transmission between the printer 022 [nFaul]
and the host computer. (Select this mode if printing problems oc- 33 - Not connected
cur when the printer is connected to a workstation.) 34 - Not connected
35 Out Power Ready
1.2 Interface Signals 36 In Ignored [nSelectin]

The pins of the parallel interface connector carry the signals list-
ed in the table in Parallel Connector Pin Assignment. Asterisks

C-1
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Signal names in the Auto mode and Nibble (high) mode (IEEE1284).
In the Auto mode and Nibble (high) mode, these signals are bi-
directional.
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Detailed descriptions of the signals follow.

Strobe* [nStrobe] (Pin 1)
A negative-going Strobe* pulse causes the printer to read and
latch the data on the Data 0 [1] to Data 7 [8] signal lines.

Data 0 [1] to Data 7 [8] (Pins 2 to 9)
These eight signals form the data byte sent from the host com-
puter to the printer. Data 7 [8] is the most significant bit.

Acknowledge* [nAck] (Pin 10)
This negative-going pulse acknowledges the previous character
received by the printer.

Busy [Busy] (Pin 11)
This signal is high when the printer is busy and low when it is
able to accept more data.

Paper Empty [PError] (Pin 12)
This signal goes high when the printer has received a print job
and run out of paper.

Online [Select] (Pin 13)

This signal is high when the printer is online and low when the
printer is offline. It goes low when the GO key is pressed to set
the printer offline.

+5V DC (Pin 18)
This line is connected to the printer's +5V DC line (+5V £0.5V,
maximum 400 mA [Serial and Parallel total], fused).

Error* [nFault] (Pin 32)
When the high-speed parallel line control is on (FRPO 02=2),
this line returns error status.

Power Ready (Pin 35)
This signal is high when the printer is turned on.

NOTE

The Paper Empty, Online, and Error signals are not used unless
enabled by the FRPO command (O2 parameter).

2. Serial Interface

2.1 Interface Signals

The pins of the printer's RS-232C interface connector carry the
signals listed in the table below. The table also indicates whether
each signal is incoming or outgoing with respect to the printer.

RS-232C Signal Pin Assignment

Pin In/out Signal Description
1 - FG Frame ground
2 Out TXD Transmit Data
3 In RXD Receive Data
4 Out RTS Request To Send
5 In CTS Clear To Send
6 In DSR Data Set Ready
7 - SG Signal Ground
11 - +5VDC | Reserved
20 Out DTR Data Terminal Ready

Brief descriptions of the signals follow.

FG - Frame Ground - (Pin 1)
This pin is connected directly to the printer frame.

TXD - Transmit Data - (Pin 2)
This output carries asynchronous data sent by the printer to the
computer. It is used mainly in handshaking protocols.

RXD - Receive Data - (Pin 3)
This input carries serial asynchronous data sent by the computer
to the printer.

RTS - Request To Send - (Pin 4)
This output is always held high (above 3 volts).

CTS - Clear To Send - (Pin 5)
DSR - Data Set Ready - (Pin 6)
Unused.

SG - Signal Ground - (Pin 7)
All signals can transmit between the printer and the host compu-
ter to send each signal with a signal ground.

+5V DC - (Pin 11)
This line is connected to the printer's +5V DC line (+5V £0.5 V,
maximum 250 mA, fused).

DTR - Data Terminal Ready - (Pin 20)
This output is used as a buffer nearly-full handshake line. It is
held high (above 3 volts) when the buffer can accept more data.

B RS-232C Interface Voltage Levels

The voltage levels of the interface signals conform to EIA RS-
232C specifications. SPACE is from 3 volts to 15 volts. MARK is
from —3 volts to —15 volts. Voltages between —3 volts and 3 volts
are undefined.

H SERIAL Connector

The connector marked 10101 (RS-232C) on the rear panel is a
DB-25S connector. Use a DB-25P connector (or equivalent) for
the connector on the cable.
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3. RS-232C Protocol

A protocol is a set of rules the computer follows in sending data
to the printer. They are indicated on the status page. Parameters
can be changed from the operator panel. See Changing Serial
Interface Modes on page 3-19. The parameters and their identi-
fication codes are given below.

H1: Baud rate

Parameter value Baud rate
12 1200
24 2400
48 4800
96 9600
19 19200
38 38400
57 57600
11 115200

The factory default setting is 9600 baud.

NOTE

Some computers may not be compatible with a baud rate of
115200 bps. If you set the baud rate to 115200 and communica-
tion problems occur, lower the baud rate.

H2: Data bits
7 or 8; the factory default setting is 8.

H3: Stop bits
1 or 2; the factory default setting is 1.

H4: Parity
Parameter value Meaning
0 None
1 Odd
2 Even
3 Ignore

The factory default setting is None (0 on the status printout).

C-3

H5: Protocol logic

Parameter value Meaning
0 Combination of 1 and 3 below
1 DTR, positive logic
2 DTR, negative logic
3 XON/XOFF
4 ETX/ACK
5

XON/XOFF recognized only as protocol

The factory default setting is 0.

H6: Buffer nearly-full threshold
This is a percentage from 0 to 99. The factory default setting is
90.

H7: Buffer nearly-empty threshold

This is a percentage from 0 to 99. The factory setting is 70.
The factory default settings of the buffer nearly-full and nearly-
empty thresholds (H6 and H7) are subject to change without no-
tification.

The gap between the nearly-full and nearly-empty thresholds al-
lows the computer to send a fairly large amount of data in a con-
tinuous stream.

H8: Received-data buffer size
This is the size of the input buffer, specified in units of 10 Kbytes.
The factory default setting is 6, meaning 60 Kbytes.

PRESCRIBE FRPO D0 command

The PRESCRIBE FRPO D0 command is provided to allow ma-
nipulating XON/XOFF when an error has occurred on the serial
interface. The following table summarizes the error status corre-
sponding to different DO values.

Serial interface error
Timing of XON transfer to host
while Ready or Waiting Error Error
not handled handled
XON sentevery 3to5seconds | D0=0 DO=1
(default)
XON not sent D0=10 DO0=11
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4. RS-232C Cable Connection

4.1 Preparing an RS-232C Cable

After obtaining an RS-232C cable, check that it is wired correct-
ly, referring to the table in RS-232C Signal Pin Assignment on
page C-2. If you have an IBM communication adapter cable type
1502067, you will have to resolder the wiring at the printer end
of the cable. The procedure is as follows.

1

8

Remove the plastic cover from the printer end of the
cable.

Next to each of the wires inside the cable is a bare
shield wire. Solder all these shield wires together into a
single bundle.

Using a section of flat wire about 3 mm wide and 15
mm long, connect the bundle of shield wires to the met-
al facing of the connector. Check that the solder con-
nections are secure.

Desolder wires 2 and 3, then resolder them in crossed
configuration. Solder wire 2 to pin 3 and wire 3 to pin 2.

Cover the solder joints with thermofit tube.

Cut wires 4, 5, 6, and 20.
Solder wires 5 and 6 together and connect them to pin
20. Cover the solder joints with a thermofit tube. Leave

wire 4 unconnected.

Tape all remaining loose ends, or seal them with a ther-
mofit tube.

Attach the plastic cover back on.

4.2 Connecting the RS-232C Cable

Check that the power of both the printer and the computer is
switched off.

1

Discharge yourself of static electricity by touching a
metal object such as a doorknob.

Plug the printer end of the RS-232C interface cable
into the printer’'s RS-232C connector and attach it in

place.

Plug the other end of the cable into the computer’s RS-
232C interface connector.

Turn on the printer.

The printer RS-232C parameters are factory-set to the
following values:

Baud rate=9600 bps, data bits (character length)=8
bits, stop bits=1, parity=none

The two RS-232C protocols are XON/XOFF and DTR.
The printer performs both of them simultaneously,
using positive logic for DTR.

If you are uncertain as to the printer's current
parameter settings, you can reset them to the values
listed above by following the procedure explained in
Printer Resetting on page 3-49.

Set the computer to the same parameters as the printer.
On many computers this can be done by setting DIP
switches before the power is turned on. Another method
is as follows:

4.3 Setting the RS-232C Parameters

Bl Windows 95/98/ME

1

4

Click on the Start button in the Windows 95/98/ME
task bar and align the cursor with Settings, then click
on Control Panel from among the items displayed.

The control panel folder opens. Double click on
System.

System Properties opens. Click on the Device
Manager tab, then click on the COM port to be used.

System Properties [ 7]]

General Device Manager | Hardware Profles | Performance |

& Viewdevicesbylype " View devices by connestion

[= Computer

+ &4 COROM

+ =D Disk diives

+ (@ Display adapters

1 42 Floppy disk controllers

#%2 Hard disk controllers

+ % Keyboard

& ;_J Manitar

#77y Mouse

+ B3 Network adapters

= & Ports (COM & LPT)

Communications Port (COM1)
- Communications Port [COM2)
- Piinter Port ILFT1)

+ 3 System devices

Remove | P |

Cancel

Pupaties | Refiesh |

Click on the Properties button.
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5 The Properties sheet is displayed for the selected
COM port. Click on the Port Settings tab and set the
port properties.

Communications Port [COM1) Properties

General  Port Setiings | Driver | Resources |

it per szcanc: FEETCRRGRG— =
baetts 5 =
L T —
st 1 =]

Flow control: |%on / Xaff =

fdvarced.. | Bestore Defauls |

Cancel

6 After setting the properties, click the OK button.

B DOS
1 Enter the following commands:

C:\>MODE COM1:96,N,8,1,P
C:\>MODE LPT1:=COM1

2 To test the interface, enter the following:

CTRL P
C:\>DIR
CTRL P

The software settings made using the above procedures are
temporary. On most computers, permanent settings must be
made with DIP switches.

If you want to use a different baud rate or change any of the other
RS-232C parameters, this can be accomplished from the print-
er's operator panel. See Changing the Interface Parameters on
page 3-18.
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This appendix explains how to install each option unit. Also refer to the manuals of the respective option units.

1. Available Options

The printer has the following options available. For instructions on installing individual options, refer to the documentation included with
the option.

<>

Memory Card (CF)

Network Interface
Card

————————— e —

Expansion Memory
(DIMM 16/32/64/128MB)

Document Finisher

Hard Disk Unit
N
Paper Feeder PF-75 Barcode Reader BC-1
Document Finisher Punch Unit *: For facedown high-speed printing.
DF-75 PH-2A/2B/2B

D-1
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PF-70 Paper Feeder

Holds approximately 500 sheets of A5 to A3 (11 x 17" in Ledger)
size paper. Only one paper feeder can be attached to the bottom
of the printer.

PF-75 Paper Feeder

Holds approximately 3000 sheets of A4, B5 or Letter size

(8.5 x 11") paper. Only one paper feeder can be attached to the
bottom of the printer.

Network Interface Card

Is used to communicate using the network protocols such as
NetWare, TCP/IP or EtherTalk.

DF-70/DF-71 Document Finishers

Provide finishing with about 3,000 sheets at a time with high-
speed and large-capacity processes. DF-71 also provides a
punch function. They are installed at the left side of the printer.

DF-75 Document Finisher

Provides the staple, punch (option), offset and stitch functions. It
is installed at the left side of the printer.

BC-1 Barcode Reader

Reads the barcode (ID code) printed on the paper when
reprinting with the code job function. It is connected to the printer
with the serial interface.

Other Options

» Hard Disk Unit
Enables the electronic sorting and job retention functions. To
be inserted into the slot OPT1/HDD designed for it on the main
circuit board of the printer.

* Memory Card (CF)
This is a microchip card that may contain option fonts, macros,
and forms. Insert the memory card into the memory card slot
located on the right of the printer. See your dealer for
purchasing information regarding the memory Cards that are
best suited for use with this printer.

* Memory DIMM
See your dealer for purchasing information of the DIMM that
are best suited for use with this printer. See Appendix B
Expansion Memory for the installation procedure.
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Appendix D Option Units

2. Installing Option Units

2.1 PF-70/75 Paper Feeders

PF-70 or PF-75 Paper Feeder can be installed below the printer.

PF-70 Paper Feeder holds approximately 500 sheets of A4 to A3
(11 x 17" in Ledger) size paper.

PF-75 Paper Feeder holds approximately 3000 sheets of A4, B5
or Letter size (8.5 x 11") paper.

For details of installing the optional paper feeder in the printer,
see the PF-70/75 Installation Guide.

2.2 DF-70/71/75 Document Finishers

DF-70/71/75 Document Finisher can be installed to the printer.

DF-70/71 DF-75

For details of installing the optional finisher in the printer, see the
DF-70/71/75 Installation Guide.

2.3 Network Interface

The FS-9100DN/FS-9500DN have the standard Network inter-
face. This printer supports the TCP/IP, IPX/SPX, NetBEUI, and
EtherTalk protocols, so the network printing under various plat-
forms such as Windows, Macintosh, UNIX, and NetWare is
available.

An option network interface card can be added by the following
procedure.

1 Turn off the printer and disconnect the power cord and
printer cable.

2 Remove the two screws from the option interface slot
cover (OPT2).

3 Insert the network interface card and secure it with the
screws removed in step 2.

4 Connect the network cable.

5 Set the network address from the printer operator panel
(for details about the modes, see Changing Network In-
terface Parameters on page 3-20).
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2.4 Hard Disk

Insert the hard disk into its slot on the main circuit board of the
printer. If a hard disk unit is installed in the printer, received data
can be rasterized and stored on this hard disk. This enables
high-speed printing of multiple copies using an electric sort func-
tion. Also, you can use the e-MPS functions. For details, see e-
MPS on page 3-11.

For details of available hard disks, see your dealer.

Turn off the printer and disconnect the power cord and
printer cable.

2 Remove the two screws and remove the slot cover
(OPT1/HDD).

/
7

i
y

3

4 Tighten the two screws to secure the hard disk unit to
the main circuit board.

/
4

2.5 Memory Card

Insert the memory card into the memory card slot located the
right side of the printer. A memory card is a microchip card that
may contain option fonts, macros, forms, etc. The printer reads
the contents of the card into its internal memory when printer is
turned on.

For details of available memory cards, see your dealer.

1 Turn off the printer.

NOTE

Do not insert or remove a memory card while the power
is on. If the memory card is removed while the printer is
on, damage could result in the printer’s electronics or
the memory card.

2 Insert the memory card in the slot. Insert it with its label
surface facing toward the outside, connector end first.
Push it in all the way.

AN




Appendix E

Specifications

Specifications

Specifications

Item

Description

FS-9100DN

FS-9500DN

Printing method

Electrophotography, laser scan

Printing speed Ad/Letter : 36 (27) pages/minutes Ad/Letter : 50 (30) pages/minutes
(' ): MP tray B4 :20 (19) pages/minutes B4 : 26 (23) pages/minutes
A3 119 (17) pages/minutes A3 : 26 (20) pages/minutes
Resolution Fast 1200 mode
600 dpi with KIR (Kyocera Image Refinement)
300 dpi with KIR (Kyocera Image Refinement)
First print Approx. 7 seconds or less (During printing) | Approx. 5 seconds or less (During printing)

(A4 or Letter size, depending on input data)

Approx. 40 seconds (During low power
mode)
Approx. 67 seconds (During sleep mode)

Approx. 95 seconds (During low power
mode)
Approx. 135 seconds (During sleep mode)

Warm-up time

Approx. 60 seconds or less (from power on/
sleep mode) at 23 °C, 120 or 230 V

Approx. 130 seconds or less (from power
on/sleep mode) at 23 °C, 120 or230 V

Controller

PowerPC 750 CX (350 MHz)

PowerPC 750 CX (400 MHz)

Main memory

32 MB, expandable up to 288 MB

Operating system

Windows 95/98/ME, Windows NT/2000, Macintosh, Linux

Interfaces

Parallel 1, IEEE1284
Serial 1, RS-232C

Network 1, Protocol support:IPX/SPX, TCP/IP, DLC
Option 2, Network interface card and hard disk (KUIO-LV)

Memory card slot

One Memory card (CF)

Self test

Performed at power-up

Maximum duty cycle

180,000 pages/month

300,000 pages/month

Drum

Amorphous silicon drum

Developer

Mono-component dry developer

Main charger

Positive scorotron charger

Transferring

Negative charger roller

Separation

DC brush separation

Drum cleaning

Blade cleaner

Drum discharging

lllumination by eraser LED array

Fuser

Heat roller and pressure roller

Toner saving

EcoPrint mode

Paper

Plain paper (See Chapter 5 Paper Selection)
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Description
Item
FS-9100DN FS-9500DN
Paper feed trays Cassette : A5 to A3/Ledger size universal cassette. Holds 500 sheets of thickness
0.11 mm
MPtray : 88 x 148 mm (3-1/2 x 5-13/16") to 297 x 450 mm (11-11/16 x 17-3/4") (See
page 5-2). Holds 200 sheets of thickness 0.11 mm
Capacity of output tray Face-down tray — 500 sheets of thickness 0.11 mm

Ambient conditions

Temperature 11010 32.5 °C (5010 90.5 °F)
Humidity :20t0 80 % RM

Optimum conditions :23 °C (73.4 °F), 60 % RM
Altitude : Max. 2,000 m (6500 feet)
llumination : Max. 1,500 lux

Power requirements

120 V, 60 Hz, max. 10.8 A (U.S.A./Canada)
220-240 V, 50 Hz/60 Hz, max. 5.6 A
(European countries)

Max. allowable voltage fluctuation:  +10 %
Max. allowable frequency fluctuation: +2 %

120 V, 60 Hz, max. 10.9 A (U.S.A./Canada)
220-240 V, 50 Hz/60 Hz, max. 5.7 A
(European countries)

Max. allowable voltage fluctuation:  +10 %
Max. allowable frequency fluctuation: +2 %

Power consumption Max.: 1,400 W Max.: 1,400 W
During printing: 680 W During printing: 790 W
During standby: 140 W During standby: 150 W
During low power mode: 99 W During low power mode: 70 W
During sleep mode: 16 W During sleep mode: 16 W

Operating noise (in accordance with ISO During printing: LpA=54 dB(A) During printing: LpA=55 dB

7779 [Bystander Position, sound pressure | During standby: LpA=31 dB(A) During standby: LpA=31dB

level at the front])

During sleep mode: Immeasurably low

During sleep mode: Immeasurably low

Dimensions

585 (23) wide x 615 (24-1/2) high x 639 mm (25-1/8") deep

Weight

67 kg (148 Ib), main unit only
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Glossary

Cassette mode

This is an operation mode for the MP tray. When this mode is
used, approximately 200 sheets of plain paper can be fed con-
tinuously, the same as for the cassette. Cassette mode is spec-
ified as the factory setting, but you can change this setting from
the printer's operator panel.

dpi (dots per inch)
This indicates the number of dots printed per inch, and is the unit
of printer resolution.

EcoPrint

This is a printing mode that controls toner consumption. Pages
printed in the Ecoprint mode are lighter than pages printed in the
normal mode. The default setting is Off.

Emulation

This refers to emulation of manufacturers’ printers. The printer
emulates the operation of the following printers: PCL 6, KC-GL,
Line printer, IBM Proprinter, DIABLO 630, EPSON LQ-850, and
KPDL.

Expansion memory

This option is used to increase printer memory. The printer has
two expansion sockets, into both of which you can install a 16
MB, 32 MB, 64 MB, or 128 MB DIMM (Dual Inline Memory Mod-
ule). See your Kyocera Mita dealer to purchase the DIMM that is
best suited for use with this printer.

First mode

This is an operation mode for the MP tray. If there is paper insert-
ed in the MP tray, the first paper will always feed from there even
if another paper source is selected.

IEEE1284

This is a standard used when connecting a printer to a computer,
and was established by the Institute of Electrical and Electronic
Engineers in 1994.

KIR (Kyocera Image Refinement)

This is Kyocera Mita’s original smoothing function. It uses soft-
ware to enhance the printer’s resolution and produce high-qual-
ity printing. The default setting is On.

Kyocera Mita Digital Library

This is contained on the CD-ROM supplied with the printer. The
contents of the CD-ROM include manuals, printer drivers, and
various utilities.

KM-NET VIEWER

This is a network management tool that can be used with the
Kyocera Mita FS series. You can view information for printers
connected to the network using SNMP commands. KM-NET
VIEWER is contained on the Kyocera Mita Digital Library CD-
ROM supplied with the printer.

MB (mega byte)
This unit is used to express data quantities and memory capac-
ities. 1 MB is equivalent to 1024 kB, or 1,048,576 bytes.

MP tray

This is an abbreviation for Multi-Purpose tray. The MP ftray is
used instead of the cassette when printing on envelopes, post-
cards, transparency sheets, and labels.

Offline
The printer can receive data, but cannot print. Turn the printer
online if you want to print.

Online
The printer can output received data.

Operator panel

This is located on the top of the printer. The panel consists of the
message display, three indicators and eight keys. The message
display shows the printer’s status. Press the keys when you want
to switch the printer between online and offline status, or to can-
cel printing.

Outline font

With outline fonts, characters’ outlines are represented by nu-
merical expressions, and fonts can be enlarged, reduced, or
painted in different ways by changing the numeric values of
those expressions. Printing remains clear even if you enlarge
fonts, since the letters are defined by an outline. You can specify
font size in steps of 0.25 points up to 999.75 points.

Parallel Interface

With this interface, data transfer between the printer and the
computer takes place on 8-bit chunks. The printer can perform
IEEE1284 compatible bi-directional communications.
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Glossary

Printer driver

The printer driver makes it possible for you to print data created
using application software. The printer driver for the printer is on
the Kyocera Mita Digital Library CD-ROM supplied with the print-
er. Install the printer driver on the computer connected to the
printer.

RAM disk

This is a virtual disk drive that uses part of the printer's memory.
With RAM disk you can set any memory size arbitrarily, and use
electronic sorting (to reduce print time).

Simple Network Management Protocol (SNMP)
This is a protocol for the management of networks that use TCP/
IP (Transmission Control Protocol/Internet Protocol).

Sleep mode

This mode is activated after a specified amount of time elapses.
The printer goes into economy mode and a minimum amount of
power is consumed. You can change the amount of time before
the printer goes into sleep mode from the printer’s operator pan-
el. The default setting is 30 minutes.

Status page

This lists printer conditions, such as the printer's memory, the to-
tal number of copies printed, and paper source settings.
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Index

A

Access code 3-13, 3-14
Adhesive label 5-4

Alarm (buzzer) setting 3-50
Amorphous silicon drum E-1
Auto continue 3-51

Automatic manual feeding 3-40

B
Barcode reader 3-19, D-1, D-2
Binding 3-43

C

Cassette paper size 3-41

Charger unit 1-2, 4-2, 6-3

Cleaning brush 1-2, 6-4

Cleaning knob 1-2, 6-3

Code job 3-12, 3-15
Permanent code jobs 3-17
Temporary code jobs 3-17

D
DIMM B-1
Document finisher 3-44, D-1, D-3
Drum 4-2, 4-3

Refresh drum 4-2, 4-3
Duplex 3-43, 3-46, 5-5

Binding 3-43

E

EcoPrint 3-30, 1-1

e-MPS 3-11, 3-16
Code jobs 3-15
Private job 3-13
Proof-and-hold 3-13
Quick copy 3-12
Stored job 3-14
Virtual mailbox 3-15

Emulation 3-22, 1-1

Envelopes 2-3, 5-4

Error messages 4-6

Expansion memory B-1, 1-1

F

Face-down tray 1-2, 3-44
Font 3-24, A-1

Font list 3-26, A-1

Front cover 1-2

G
Grid cleaner 6-1, 6-3

H

Handles for transport 1-2
Hard disk 3-31, D-4

|

Indicators 3-2, 3-3, 4-4
Interface 3-2, 3-18, C-1
Internal fonts 3-24, A-1

J
Job retention 3-11
Job storage 3-12

K

Keys 3-1, 3-3

KIR 3-30, 1-1

KM-NET VIEWER 1-1

KPDL 3-22, A-3

Kyocera Mita Digital Library 1-1

L
Left cover 1 1-2, 4-10
Lock lever 1-2, 4-11, 6-4

M
Main charger unit 1-2, 4-2
Main circuit board B-1, D-4
Main switch 1-2
Maintenance 6-1

Charger wire 4-2, 4-3

Grid cleaner 6-3

Separator 6-4
Maintenance messages 4-4
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Index

Memory card 3-36, D-4

Memory expansion B-1

Menu map 3-10

Menu selection system 3-4, 3-10

Message display 3-1, 3-2

Message language 3-47

MP (multi-purpose) tray 1-2, 2-2, 4-9, 5-2, 5-5
Cassette mode 3-40, 1-1
First mode 3-40, 1-1
Paper guide 2-1

MP transport 4-8

N
Network 3-11, D-3
Network interface 1-2, 3-2, 3-20, D-3

(0)

Online help messages 3-3, 4-5, 4-8
Operator panel 1-2, 3-1, 3-4, 1-1
Operator panel indicators 4-4
Option units D-1, D-3

Orientation 3-28, 3-43

P
Paper cassette 1-2, 2-1, 4-9
Paper feeder 4-8, D-2, D-3
Paper grain 5-3

Paper size 3-3, 3-41, 5-2
Paper size indicator 3-1, 3-3
Paper size plate 2-2

Paper specifications 5-1

Paper stopper 1-2, 2-1

Paper type 3-3, 3-45, 5-5
Paper type indicator 3-1, 3-3
Paper weight 3-46, 5-2

Parallel interface 3-18, C-1, 1-1
Partition 3-32, 3-33, 3-35, 3-38, 3-39
PCL fonts A-1

Plastic bag 6-1, 6-2

Preprinted paper 5-3, 5-4
PRESCRIBE 4-3, C-3

Print density 3-31, 4-3

Print quality 3-30, 4-2

Printer driver 3-11, 1-2
Protocol 3-19, C-1, C-3

Punch unit 4-4, D-1

R

RAM disk 3-34, 4-7, 1-2
Recycled paper 5-4
Index-2

Reduced print 3-27
Resolution 3-31, E-1
Resource protection 3-50
RS-232C 3-2,C-2,C-3,C-4
RS-232C Cable C-4

S

Separator 6-4

Serial interface 3-2, 3-19, C-2
Service status page 3-52

Simple Network Management Protocol (SNMP)
1-2

Sleep mode 3-2, 3-49, 1-2

Sleep timer 3-2, 3-48, 3-49
Special paper 2-2, 5-3
Specifications 5-1, E-1

Status page 3-10, 3-21, 3-52, 1-2
Stitch position 3-44

T
TK-70 4-2, 4-3, 4-6, 6-1
Toner container 1-2, 3-11, 6-1
Toner kit 6-1
Transfer roller 4-3
Troubleshooting 4-1

Interface 4-1

Vv
Virtual mailbox (VMB) 3-12, 3-15, 3-18

w
Waste toner box 1-2, 6-1
Wiper cloth 6-1
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Notice

The information in this guide is subject to change without
notification. Additional pages may be inserted in future
editions. The user is asked to excuse any technical inac-
curacies or typographical errors in the present edition.

No responsibility is assumed if accidents occur while the
user is following the instructions in this guide. No
responsibility is assumed for defects in the printer’s
firmware (contents of its read-only memory).

This guide, any copyrightable subject matter sold or
provided with or in connection with the sale of the page
printer, are protected by copyright. All rights are reserved.
Copyingorotherreproduction of all or part of this guide, any
copyrightable subject matter without the prior written
consent of Kyocera Corporation is prohibited. Any copies
made of all or part of this guide, any copyrightable subject
must contain the same copyright notice as the material from
which the copying is done.

Regarding Tradenames

PRESCRIBE is a registered trademark of Kyocera Cor-
poration. Microsoft, and Windows are registered trade-
marks of Microsoft Corporation. PCL is a registered
trademark of Hewlett-Packard Company. PostScript is a
registered trademark of Adobe Systems Incorporated.
CompactFlash is a trademark of SanDisk Corporation.

This guide contains information on how to install, config-
ure, and use the printer drivers for the Kyocera Mita
FS-9100DN and FS-9500DN printers. The printer drivers
and other utility software are supplied on the Kyocera
Mita Digital Library CD-ROM, other additional CD-
ROM, and from the Internet. The driver CD-ROM'’s is
included with the printer.

The CD-ROM'’s supports different printer drivers for the
following operating systems:

¢ Microsoft Windows 95, Windows 98, and
Windows ME

Microsoft Windows NT 4.0, and Windows 2000
» Apple Macintosh OS 7 or greater
IBM OS/2 Version 2.0 or greater

.

¢ Linux

The guide focuses on using the printer driver on Win-
dows 95 and Windows 98.

The latest Kyocera Mita printer drivers and utilities are
readily available at the following web site:

http://www.kyocera.com/w2k.

NOTE

For improvement purposes, the user interface design and
functionalities of the printer driver may vary depending on
the version. The diagrams used throughout this guide are
only for examples.
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Chapter 1

Installing the Printer Driver

Kyocera Mita Digital Library CD-ROM will automatically start to
play its installation menu which guides you through the installa-
tion of the printer driver.

To make CD-ROMSs play automatically when inserted in the CD-
ROM drive, the Auto insert notification for the CD-ROM drive
must be activated. This feature is activated by default for all
Windows platforms. For details, refer to Windows Help.

To install, proceed as follows:

1

11

Set the Kyocera Mita Digital Library CD-ROM in your
PC’s CD-ROM drive. After awhile, the Kyocera Mita
Digital Library splash screen appears.

Click Install Drivers. The Kyocera Mita Setup Wizard
window begins.

Click Next.

In the Select a device model window, click FS-
9100DN or FS-9500DN.

Setup X
Sefect a device mode!

If wour model i not listed., click on the Classic Models button for
additional selections

Available models:

F5-7000+ =
F5-7028M _I
F5-8000C
- £ SRR
— = FS-91000MN )
> | |

Model description:

w
" ' e 36-PPh High speed network lager printer

Classic Models | < Back I Mest » I Exit

Click Next.

In the Select a driver language window, click on the
desired language.

Setup [ %]
Select a driver language

Select the driver language, then click Mest.

Lovailable languages:

< Back I Next > I Exit

Click Next.

Check the contents, and then click Next.

Setup B
Select a driver type

Select the driver type pou wish ta use with this device, and click
Mext.

Available drivers:

< Back I Next » I Exit




Chapter 1 Installing the Printer Driver

1 1 Continue to follow the rest of the wizard and complete

In the End user license agreement window, check the

contents, and then click Accept.

In the Select driver options window, check the True

Type screen fonts.

To use Kyocera Mita printer command language PRE-
SCRIBE as module, check the Prologue/Epilogue

Module if you use it, and then click Next.

Setup X

Select driver options

Select from the list below the options that you want to install with
thiz driver. Multiple options may be zelected.

-y fl 1t
kil o This option will install TrueType screen fants that match the
resident printer fontz. This will insure that the fonts displayed on
the gcreen and the fonts on the printed page will look the same.

< Back I Mest » Exit

the installation.



Chapter 2 Setting the Defaults

This section explains how to set defaults on option devices in-
stalled on the printer. Settings made in this way will become ef-
fective for all application software. To temporarily change the
settings, make printer settings from the application. See Chap-
ter 3 Printing Through Application Software.

2.1 Adding Option Devices (Setup)

The Device Settings tab enables you to setup option devices
such as the paper feeder so that the printer can recognize them.
Each printer has a unique set of options that are listed in the
Device Settings window. If you have attached one or more
printer options, check that option.

2.1.1 Installing the Paper Feeder (PF-70)

Check that the option paper feeder (PF-70) is installed on the
printer correctly.

1 Browse Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-9100DN KX or
Kyocera Mita FS-9500DN KX icon and then click
Properties.

The Properties dialog box is displayed.

21

3 Click the Device Settings tab.

Kyocera Mita F5-3100DN KX Properties

Prologue/Epiogue

Output

General | Detals | ColrManagement | Shaiing Mo~ Levout | Imaging |
| Device Setfings | About

I S

Devics Options

%7 Paper Fesder (Cassette 1. 2]
[IPaper Feeder [Cassette 3, 4]
[Large Capacity Feeder
OFinisher

CIBooklet Stitcher

[Hard Disk.

CIRAM Disk

User, (T T
Adhministiator, Fa Disk.  [GMB jl

ok | Cancel Eepl Hels

4 Check Paper Feeder (cassette 3, 4) in the Device

Options list box.

Kyacera Mita FS-9100DN KX Properties HE

General | Detals | ColurMansgement |  Shaing | Meda | Layout | Imaging |

Prologus/E pilogue |

Output

Device Settings | About

Device Options.

OFinisher
[IBocklet Stitcher
[JHard Disk..
CIR&M Disk

T (T |
Administrator, s B ME il

ok | Cancel Eepll Hel

5 Click the OK button.
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2.1.2 Installing the Paper Feeder (PF-75)

Check that the optional paper feeder (PF-75) is installed on the

printer correctly.

1 Browse Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-9100DN KX or
Kyocera Mita FS-9500DN KX icon and then click

Properties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita F5-9100DN KX Properties

General | Detsls |  ColorManagement | Shar

Prologue/Eplogue

Devics Options:

[ Paper Feeder (Casselte 1. 2
[Paper Feeder [Cassette 3, 4]
[OLarge Capacity Feeder
OFinisher.

CIBooklet Stitcher.

[IHard Disk.

CIRAM Disk

| Lalyout | Imaging |

g Medid
Device Settings

K E3

About

User.
Adkvinistrator.

Mooy [F2M8 =
Reroe [PVEL =

0K I Cancel

Epply Help.

Check Large Capacity Feeder in the Device Options

list box.
Kyocera Mita FS-9100DN KX Properties 2]
General | Detals | ColurMansgement |  Shaing | Meda | Layout | Imaging |
Prologus/E pilogue | Output Device Settings About

Device Options.

AP aper Feeder [Cassette 1, 2)

[IBocklet Stitcher
[JHard Disk..
CIR&M Disk

User.
Administiator,

(T |
BE sk 5 ME ﬂ

Ok I Cancel

Lopl) Help

Click the OK button.
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. .. Check Finisher in the Device Opti list box.
2.1.3 Installing the Document Finisher 4 ~neckTinisherinihe Device Dptions fst box

(DF-70/DF-71)

Check that the optional document finisher (DF-70/DF-71) is in-
stalled on the printer Correctly_ Gerersl | Detail | Colrbanagement | Shaing | Meda | Lalyuul | imeging |

Frologue/Epilogue | Output Device Settings About

Devics Options

B Paper Feeder [Cassette 1.2)
[IPaper Feeder [Cassette 3, 4)

E. hok
[JHard Disk.
CIRAM Disk

Memas 208 2
Repise [MB |

User
Administrator...

o KYOCER

DF-70/DF-71

o | Cancel ol Help

1 Browse Start > Settings > Printers.
5 Click the OK button.

2 Right click on the Kyocera Mita FS-9100DN KX or
Kyocera Mita FS-9500DN KX icon and then click
Properties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita FS-9100DN KX Properties HE

General | Detals |  ColorManagement | Shaiing Media Layout | Imaging |
Prologue/Epilogus | Output Device Settings | About

Device Options:

[E2 P p

OPRaper Feeder [Cassette
[OLargs Capacity Feeder
Finisher.

[CJBonklet Stitcher
[CIHard Disk.

CIR&M Disk

S
34

= Mooy [F2M8 =
Adrinistrator. s 2 ME ﬂ

0K | Concel Bl Help

2-3
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21.4 Installing the Document Finisher (DF-75) 4 Check Booklet Stitcher in the Device Options list

box.
Check that the optional document finisher (DF-75) is installed on
the printer correctly. Kyocera Mita FS-9100DN KX Properties HE
General | Detals | ColurMansgement |  Shaing | Meda | Layout | Imaging |

Prologus/E pilogue | Output Device Settings About

Device Options.

WP aper Feeder (Cassette 1, 2]
[IFaper Feedr (Cassette 3, 4]
Capacily Feeder
rer
- )
i

T (T |
Administrator, s B ME il

ok | Cancel Eepll Hel

1 Browse Start > Settings > Printers.
5 Click the OK button.

2 Right click on the Kyocera Mita FS-9100DN KX or
Kyocera Mita FS-9500DN KX icon and then click Prop-
erties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita FS-9100DN KX Properties HE

General | Detals |  ColorManagement | Shaiing Mem~ Laout | Imagng |
Prologue/Epilogus | Output Device Settings | About

Device Options:

[Large Capachy Fesder
[Finisher.

[IBooklet Stitcher..
[IHard Disk...

CIRAM Disk

Mooy [F2rE =
R [BNE o

User
Adrministratar.

o6 | Cancel Bl Help
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2.1.5 Installing the Hard Disk

Check that the optional hard disk is installed in the printer correct-
ly.

1 Browse Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-9100DN KX or
Kyocera Mita FS-9500DN KX icon and then click Prop-
erties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita F5-9100DN KX Properties EHE

General | Detals | ColorManagement | Shaiing Hedia Lapout | Imaging |
Prologue/Epilogue | Output Device Settings | Ahout

Devics Options:

[ Paper Feeder (Casselte 1. 2
[Paper Feeder [Cassette 3, 4]
[OLarge Capacity Feeder
OFinisher.

CIBooklet Stitcher.

[IHard Disk.

CIRAM Disk

T, Mooy [F2M8 =
ot e RA Diske [BME ::I

0K | Concel EERl Help

4 Check Hard Disk in the Device Options list box.

NOTE

When installing hard disk, make sure to remove the
check mark of the RAM Disk.

Kyocera Mita FS-9100DM KX Properties (2| x]
Genersl | Detals | ColorManagement |  Shaing | Meda | Layout | Imagng |
Prologue/E pllogue | Dutput Device Settings About

Device Options

#APaper Feader [Cassette 1, 2]
[CIPaper Feeder [Cassette 3, 4]

CLarge Capacity Feeder
CFinisher...

User Memory: 32 ME il
Admirishator, N FTE |

¥ KYDCERD

K| Cancel ol Help

5 Click the OK button.

2-5

2.1.6 Using the RAM Disk

Turn the RAM disk mode On and set its size using the printer's
operator panel beforehand.

1 Browse Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-9100DN KX or
Kyocera Mita FS-9500DN KX icon and then click Prop-
erties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita F5-3100DN KX Properties 7]

General | Detals | ColrManagement | Shaiing Media Lapout | Imaging |
Frologue/Epilogue | Dutput Device Settings | About

Devics Options

%7 Paper Fesdsr | 1 9]
[IPaper Feeder [Cassette 3, 4]
[Large Capacity Feeder
OFinisher

CIBooklet Stitcher

[Hard Disk.

CIRAM Disk

User, (T T
Adhministiator, Fa Disk.  [GMB jl

ok | Cancel Eepl Hels

4 Check RAM Disk in the Device Options list box.

NOTE

When using RAM disk, make sure to remove the check
mark of the Hard Disk.

Kyocera Mita F5-9100DN KX Properties 7]
General | Defals |  ColorManagement |  Shaing | Meda | Lapowt | Imaging |
Frologue/Epilogue | Output Device Settings About

Devics Options

[ Paper Feeder [Cassette 1. 2)
[Paper Feeder (Cassstre 3, 4]
[OLarge Capacity Feeder
DOFinisher...

CIBooklet Stitcher

)

User Hemory: 32 ME jl
_ edwedo | ok 7B il

o KYOCER

o | Cancel ol Help
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Set the same RAM disk size as the printer’s operator

2.1.7 Selecting the User Name

panel.
You can register your name to the printer driver. After registra-
—rE e T tion, you can select the name from the operator panel when
oo |[ oo [ ey [ Som L e 1 wa [ nows | printing using the e-MPS function.
Prologue/E pllogue | Cutput Device Settings | Abaut

Device Options: . .
B Fote Toae T 3 1 Browse Start > Settings > Printers.
[IPaper Feeder (Cassatte 2, 4]

[Large Capacity Feeder
OFinisher.

2 Right click on the Kyocera Mita FS-9100DN KX or
Kyocera Mita FS-9500DN KX icon and then click
Properties.

User Mernory
Adrinistrator., RAM Disk:

The Properties dialog box is displayed.

=
3 Click the Device Settings tab.
[ ok | concel Tl Help
Click the OK button. Kyocera Mita F5-3100DN KX Properties 2]

General | Detals | ColrManagement | Shaiing Mo~ Levout | Imaging |
Frologue/Epilogue | Dutput Device Settings | About

Devics Options

7 L. 1, 2f
[IPaper Feeder [Cassette 3, 4]
[Large Capacity Feeder
OFinisher
CIBooklet Stitcher
[Hard Disk.

CIRAM Disk

User, (T T
Adhministiator, Fa Disk.  [GMB jl

0k | Cencel | o0 | He |

Click the User botton. The User Settings dialog box is
displayed.

Kyocera F5-9100DN KX Properties (7]

General| Detais | Color Managemert | Sharing | Media | Layout | Imaging | Output Devies Settings | Abaut |

Devics Dptions:

il
CIPaper Feeder (Casssite 3, 4]
ClLarge Capacity Feeder
CFinisher..

CIBooklet Stitcher

[CIHard Disk.

L CIRAM Disk

] ,
‘ User !
A |

Memory: 328 :I
Rew s [BVE <

User Settings T |
0] KYOCERE i
@ User Name: ,‘7
|- Page Desctiption Languag:
[recxC =] G0l compatble mode
SEHinTE)

[




Chapter 2 Setting

the Defaults

5 Enter the User Name and Department name, and click

the OK button.

User Settings

Jd E3

Identification

User Mame:

Department:

—Page Description Languag
PCL®L ~| I GDI compatible mods
PCL 5e Seftings...
KFDL
= Uni
" Inches © Millmeters

6 Click the OK button.
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2.1.8 Selecting the Printer Description
Language

Select the printer description language adequate for the data to
be printed from among PCL XL, PCL 5e and KPDL (PostScript
compatible). When using the virtual mailbox function, select PCL
XL or PCL 5e. The default setting is PCL XL.

1 Browse Start > Settings > Printers.

2 Right click on the Kyocera Mita FS-9100DN KX or
Kyocera Mita FS-9500DN KX icon and then click
Properties.

The Properties dialog box is displayed.

3 Click the Device Settings tab.

Kyocera Mita F5-3100DN KX Properties 7]

General | Detals | ColrManagement | Shaiing Mo~ Levout | Imaging |
Frologue/Epilogue | Dutput Device Settings | About

Devics Options

%7 Paper Fesder (Cassette 1. 2]
[IPaper Feeder [Cassette 3, 4]
[Large Capacity Feeder
OFinisher

CIBooklet Stitcher

[Hard Disk.

CIRAM Disk

User, (T T
Adhministiator, Fa Disk.  [GMB jl

0k | Cencel | o0 | He |

Click the User botton. The User Settings dialog box is
displayed.

[ F5-9100DN KX Properties

General| Detais | Color Managemert | Sharing | Media | Layout | Imaging | Output Devies Settings | Abaut |

C | Daptmert —

|- Page Deescription L:

quagy
PCLXL =] I~ GDI compatible mode
SEHinTE)
Corcel
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Select PCL XL, PCL 5e, or KPDL in the Page Descrip-
tion Language drop down list, and click the OK button.

User Settings 2

Identification

User Mame: I

Department: I

Settings...

Uni
(ﬁ‘ Inches © Millimeters

toca |

Click the OK button.
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Chapter 3

Printing Through Application Software

This section uses a document created using Microsoft Word as
an example of how to print from applications.

3.1 Setting the Paper Size

1

Set paper of the size specified for the document in the
application into the printer’'s paper cassette. (For de-
tails on how to set paper sizes, refer to the Installation
Guide.)

Be sure that the document is correctly formatted with
the paper size you intended to use. To do this, from the
Word task bar, select File, Page Setup, Paper Size
and select the paper size.

Browse File > Print. The Print dialog box will be dis-
played.

Print K
~Printer
Hame: [ <5 Kyorera bits FS-91000N KX _‘J Properties
Status: Idle 3
Type: Kyocera Mita FS-5100DN K
Where: LPT1: ™ Print ka File
Comment: ™ Manual duplex
4 ~Page rang: . Copi
i« all Numbar of copies: =l 5
" Current page  Selection
" Pages: 11 11 ¥ Collate
Enter page numbers andjor page ranges AL
separated by commas. For example, 1,3,5-12

3-1

_ Fages per sheet: |1 page hd
Prink: all pages in range - S Rer =
Scale to paper size: [No Scaling hd

— coce

Print what: [Document - (”“'

Click on the Name drop down list, all the printers in-
stalled under Windows are listed. Select Kyocera Mita
FS-9100DN KX or Kyocera Mita FS-9500DN KX.

Select the range of the pages you want to print in the
document, All or Current page in Page range. To print
part of the document, check Pages, then enter page
numbers separated by commas.

Specify the number of copies you want to print in the
Number of copies combo box in Copies.

Click the Properties button in the Print dialog box. The
Properties dialog box is displayed.

Kyocera F5-3100DN KX Properties 7]

Media | Layout | Imaging | Output | About |

Page Size: A4 - 2100 297 mm
o] con.

Print Size: 84 - 210 % 297 mm

Same 5 Page Size -

Oriertation
& Portrait
I™ Rotated
© Landscaps

Source: Auto Source Selection a
edia Type: Auto Media Selection B

Seftings.. | Restore Defauts |

0K | Caedd | Hep |

7 Click on the Page Size drop down list. Select the proper

page size. A5 was selected for the following example.

- _ _
Kyocera F5-3100DN KX Properties HE

Media | Layout | Imaging | Output | About |

Page Size Letter- 85 % 11 in.

[Leva = Custom.

Tedger 5
Statement

Execulive J
A3

= Porhait
I~ Rotated
" Landscaps

Source: Auta Source Selection a
Media Type: Auto Media S election B

Settings.._ | rezEneze|

0K | Caed | Hep |




Chapter 3 Printing Through Application Software

8 Select Same as Page Size in the Print Size drop 10 Select the desired media in the Media Type drop down
down list, and then click the OK button. list. Paper will be fed from the paper feeder to which
the selected Media Type is set.

Kyocera F5-9100DN KX Properties 2x]

- |
Media |Layout| Imaging | Output | About | Kyocera FS-9100DN KX Properties 2]

Page Size: A5-148% 210mm Media |Layout| Imaging | Output | About |

25 = Custom...
Page Size: AB-148 2 210mm
Print Size: 45-143 £ 210mm 25 = Custorn..
Print Size: 45-143 £ 210mm
Same as Page Size -
™ Rolated Dirientation:

& Portrait
™ Rotated
" Landscape

Source: Autn Source Selection B

Media Typs:

Source: Autn Source Selection B
Media Type: Auto Media Selection B

O KYOCERE

Settings.._| Restorz Defauks |

Transparency

| DIKYOCERE
(o D Cancel | Heln | mita —'E;zllwgted

Settings.

Bond
Recycled

=

NOTE

When printing with the different print size from the page
size, select the desired size in the Print Size drop down

11 The Print dialog box is displayed again. Click the OK
button to start printing.

list.
Print
. . . . [ Printer

When printing using non-standard size paper, see Cus- Name:  [<3Kyouera RaF 310000 -
tom Size Settings on page 3-3. Status: 1de

Type: Kyocera Mita F3-91000M KX

Yhere: LPTL: F Print ko File

. Lol b Manual duplex
9 Normally, select Auto Source Selection. Then, the —
Qe rangs Copi

paper will be fed from the paper feeder in which the pa- &l Mombsrof copiss:  [1 =]

€ Current page £ sSelection
per with the selected Paper Size (step 7) is installed. s ;age;w% ﬁ ﬁ ® Colate

Enter page numbers andjar page ranges
sepatated by commas. For example, 1,3,5-12

T s rZoom
| Kyocera FS-9100DN KX Properties 7] %] Print what:  [Document -] Eee
; Pages pet sheet: -
Media | Layout | Imaging| Dutput | About | Pint: Al pages I range = ges per she 1 page

Scale ko papet size! i -
Page Size: 51484 210 mm B " >
o5 = Custom
Optians. .. ak Close

Pririt Size: A5 -148 % 210 mm

Same 25 Page Size -
Oriertation;

& Partrait I Rtatd NOTE

€ Landscape

Settings made from applications are not saved when

the application is closed. The default settings are re-
stored when the application is opened the next time. To
Sotings.._| Fastos Dotauls_| change the printer driver default settings, make printer
settings from Windows.

Source:

Media Type:

0 | Ceneal | Hep |
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3.1.1 Custom Size Settings

The MP tray can feed non-standard paper sizes. It can accom-
modate sizes ranging from 88 to 297 mm in width and 148 to 450
mm in length. The procedure for setting custom sizes from the
printer driver is explained below.

1 Display the printer driver's Properties dialog box from
the application software, then click Custom button.

Kyocera F5-8100DN KX Properties HE

Media | Layout ] Imaging| Dutput | About |

Page Size: A5 -148 5 210 mm
- o)

N~——
Frint Size: &5 -148 = 210 mm

Same 45 Page Sice -

Orientatior:
& Potrait
I™ Rotated
© Landscape
Source; | Buta Source Selection a
Auto

Media Type

Settings... Restare Defaults
0K | Caed | Hep |

2 The Custom Page Size dialog box will appear, then
click the Add button. The Edit Paper Size dialog box

will appear.
Custom Paper Sizes EHE
Customized Paper Sizes
= 1
Edit Paper Size EHE

—MName
fl

— Size
Height |11.DD ﬂ ‘width IS.SD ﬂ

[ o

& |nches © Millimeters

0], I Cancel

3 Enter a name for your custom size in Name.

Edit Paper Size EE3

Name settings

—Mame

IKYD CERA-MITAD

{oize
= = Paper size
Height [2000 = widh [150 =
(et o0 f wan T
(Uit =
" Inches & Milimeters Units

A

Ok I Lancel |

3-3

7

10

Select the unit of measurement, Inches or Millime-
ters.

Enter the height and width of the custom size in Size.

Click the OK button. The custom paper size is added to
the Customized Paper Sizes list.

Custom Paper Sizes EE3

Customized Paper Sizes

8- TADT

Bemove |
Edit... |

Qg Lancel

Click the OK button. The Properties dialog box is dis-
played again.

Kyocera F5-9100DN KX Properties HE
Media | Layout | Imaging | Output | About |

Page Size: KYOCERA-MITADT -150.0 & 200.0 mm

[kvDCERAMITAM i [

Pririt Size: KYOCERA-MITADT - 150.0 % 200.0 mm

Same 25 Page Size -

Oriertation
& Potrait
I™ Rotated
€ Landscape

Source: 4uta Souice Selection =
Media Type: Auto Media Selection =

Saltings.. | Restore Defauts |

0k | ceneal | Hep |

Select the Custom Size from the Paper Size drop
down list.

In the printer’'s operator panel, press the MENU key
and press the A or V key until Paper Handling >
appears. Next, press the > key followed by the A or v
key until >MP Tray Size appears. Then, get the MP
tray size to Custom.

Set the selected size of papers in the MP tray. In the
Print dialog box, click the OK button to start printing.
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3.1.2 Advanced Media Settings

You can use the advanced media setting mode. There are three
advanced media settings: Cover Mode, Page Insert, and Trans-

parency Interleaving.

Display the printer driver's Properties dialog box from
the application software, then click the Settings button.

Kyocera FS-9100DN KX Properties 2l

Media | Layout | Imaging | Output | About |

Page Size: Ad-210% 297 mm

<] __cwn
Print Gize: Ad - 210 297 mm

Same as Page Size -

Orierkation:

= Portrait
™ Botated
" Landscaps

Source: |4uto Source Selection B
Media Type: [Auto Media Selection B

Settings.. Restore Defaults |

0k | Camcel | Hen |

The Advanced Media Settings dialog will appear. Se-
lect Cover Mode, Page Insert or Transparency Inter-
leaving.

Cover Mode:

Print the cover with another paper. You can also print on
the back side of the cover. In the Source for Cover drop
down list, select the paper cassette in which the paper
for cover is installed.

Advanced Media Settings 2l
- Cayver Modg
1 Front ™ Print Dutside Cover
 Front and Back. J= | Pt i Coyer
Sowce for Cover: | Cassetie 1 =l
~I" Page Insert
J= | Brirt e ot J= | Brirtor B ack

I Befare Rages) |

Souise o Page |Eassena 1 |

I D [iterEaving

I= | Piint orito Baching

Souree for Backing |Eassettaw =
Lercel

Page Insert:

Different type of paper can be inserted before the pag-
es. You can also print on the inserted page. Enter the
page to be inserted in the Insert Before Pages box,
and then select the paper cassette in the Source for
Page drop down list.

Advanced Media Settings 2l
T Gayer Modg
) Front 1= | Bt Otside Eoyer
€ Frorf end Bk I | Rl e Gover
Source forGaver, |Cassetie ] =
~I¥ Pagelnsett

ﬂ I~ Print on Front J= | Brirtor B ack

Inserl Before Pages |

Source for Page: |Eassena 1 =l

I D [iterEaving

I= | Piint orito Baching

Souree for Backing |Eassettaw =
Lercel

Transparency Interleaving:

Backing can be inserted into transparency from the des-
ignated paper feeder. You can also print on the inserted
backing. In the Source for Backing drop down list, se-
lect the paper cassette in which the paper to be inserted
is installed.

Advanced Media Settings 2l
== | Govertdode
) Front 1= | Bt Otside Eoyer
€ Frorf end Bk J= | Pt i Coyer
Souee (o Caver Cassetle | =
= | Eage et
J= | Brirt e ot J= | Brirtor B ack

I Befare Rages) |

Souise o Page |Eassena 1 |

F

L ™ Piint onto Backing
Source for Backing |Eassettaw =l
Lercel

3 Click the OK button.
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3.2 Setting the Duplex Printing

1 Browse File > Print. The Print dialog box will be dis-
played.

Print
Printer
Hame: | <8 Kyacera bita FS-9100DN KX = Propstties
Status: Idie
Type: Kyocera Mita FS-8100DK KX
Where: ™ Print ka file
Comment: ™ Manual duplex
~Page rang ~Copi
©al Humber of copies: =
" Current page € Selection
" Pages: 11 M Collate
Enter page numbers andfor page ranges I:
separated by commas. For example, 1,3,5-12

Print what: [Document -
Prink: All pages in rangs -

~Zoom

Pages per sheet:  [1 page -

Scals ko paper sizet (Mo Scaling -
T ==

2 Click on the Name drop down list, all the printers in-
stalled under Windows are listed. Select Kyocera Mita
FS-9100DN KX or Kyocera Mita FS-9500DN KX.

3 Select the range of the pages you want to print in the
document, All or Current page in Page range. To print
part of the document, Check Pages, then enter page

numbers separated by commas.

4 Specify the number of copies you want to print in the
Number of copies combo box in Copies.

5 Click the Properties button in the Print dialog box. The
Properties dialog box is displayed.

6 Click the Layout tab.

3-5

Click Print on Both Sides (Duplex) and then check
the Flip on Long Edge or Flip on Short Edge radio
button. The graphic icon will change to illustrate your
selection.

Kyocera F§-3100DN KX Properties 2] x]

Media  Layout | Imaging | Qutput | about |

Pages per Sheet  [1 ~| I Print Borders

.&' Layout: Auto -
Scaling (20 - S00%) [100% :I

¥ Fiint on Both Sides [Duples}:
 Fiip on Long Edge
& Fiin on Shait Edrel

T~ Booklet Mods:
et Edie Elnding
! Rigt Edge Birding

lglﬁl] Restore Defaulls
it -

T ——
[ ok | concel | Hep |
— Portrait,

) short-edge
Portrait, Binding
long-edge ——

Binding
Landscape,
3 short-edge
ST Binding
Landscape,
long-edge
Binding
NOTE

When you select Booklet Mode, double-sided pages
will be printed as aligned in the stitching mode. See Us-
ing the Booklet Mode on page 3-6.

Click the OK button.

To change the default setting to duplex printing, make
this setting from Windows.

The Print dialog box is displayed again. Click the OK
button to start printing.
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3.3 Using the Booklet Mode

If you select Booklet Mode, double-sided pages with the stitch-
ing areas will be printed. When selecting Booklet Mode with the
document finisher DF-75, double-sided stitching print will be
done.

NOTE

Stitching print supports the print sizes: A3, Ledger, B4, A4-R and
Letter-R.

1 In the Print dialog, click the Properties button and
then click the Output tab.

2 Select Finisher [Face-down] as Output to.

3 Click the Layout tab, and then check the Booklet
Mode box, then select Left Edge Binding or Right
Edge Binding.

Kyacera FS-9100DN KX Properties EE

Medis  Layout | Imaging | Dutput | bout |
Fagespenstests [2 =] IF| EirtBoders
Lyt |

Scaling (20 - 500x2); [{EE ﬂ

I | Frirt or Bt Sides (Dl
) i or Lo Edae
% FlipcriShort Edae

I¥ Booklst Mode
& Left Edge Binding
 Bight Edge Binding

:gKim Fstore Disfaus
0K | Cercel | Hep |

4 Click the Output tab, and then check the Staple box.
Booklet is automatically selected.

Kyocera FS-9100DN KX Properties EE

Medis | Lapout | Imaging Dutput | sbout |

Dutput to: Copies

Finishing Options:

¥ Collste ﬂ .!]
SimarelE s

" Upper Left
" Upper Right
& Booklet

I | offeet

2l
™ Bunch ) 2
0l

] KYDCERE Job Sitinge
i[3 I Cancel Help

5 Click the OK button. The Print dialog box is displayed
again.

6 Click the OK button to start printing.

3-6
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3.4 Using the Document Finisher

(DF-70/DF-71)

DF-70 provides the staple function, while DF-71 provides the

punch function.

1 Browse File > Print. The Print dialog box will be dis-

played.
Print 2]
Printer
Hame: [ <5 kyocers biita FS-3100DH KX T ‘ D
—
Status: Idle 2
Type: Kyocera Mita FS-91000M KX
Where: LPTL: I Print ko file
Comment:: I~ Manual duplex
3 ~Page range ~Copi
(o] Number of copies: 1 = 4
" Current page  Selection
" pages: 11 ¥ Callate
Eniter page numbers andfor page ranges '
separated by commas. For example, 1,3,5-12

Frink what: [Document -
Fink: ll pages in range -

Zoom

Fages per sheet: |1 page hd

N OO o A

3-7

Scale ko paper sizet (Mo Scaling ad
oK Close

Options...

Click on the Name drop down list, all the printers in-
stalled under Windows are listed. Select Kyocera Mita
FS-9100DN KX or Kyocera Mita FS-9500DN KX.

Select the range of the pages you want to print in the
document, All or Page range. To print part of the docu-
ment, check Pages, then enter page numbers separat-
ed by commas.

Specify the number of copies you want to print in the
Number of copies combo box in Copies.

Click the Properties button in the Print dialog box. The
Properties dialog box is displayed.

Click the Output tab.

Select Finisher [Face-down] or Finisher [Face-up]
as Output to drop down list, and click the OK button.

Kyocera F5-9100DN KX Properties 2]

Media | Layout ] Imsging  Dutput | sbout |

Output to Copies

Printer Dfouit h—|
Top Tray [Face-down) s
[Tenli . u=
I Fieimrse an e,

Ui

([« D Cancel | Hep |

Restore Defats |

8

9

If you want to collate the output pages, check the
Collate box.

Kyocera F5-3100DN KX Properties 7]

Media | Layout | Imaging Outpt | About |

Output to
Finisher [Face-down]

Finizhing Options:

[

FEverse Fagz Uids

o lper Left
L Bk =1 pger Hight
| Boaklt
™ Dffset
€ 2Hol
™ Punch ) 2Hale
L)

Job Setlings
ok | Cancel Help

Finishing Options
Collate: sets whether the pages are collated or
not.
Reverse
Page Order: prints in the reverse page order.

Staple: selects the staple position: Upper Letft,
Upper Right or Booklet (stitching posi-
tion).

Offset: Outputs pages while shifting them alter-
nately for each document.

Punch: selects the hole punch type: 2-Hole, 3-

Hole or 4-Hole.

Click the OK button in the Properties dialog box. The
Print dialog box is displayed again.

1 0 Click the OK button to start printing.
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3.5 Using the Document Finisher

(DF-75)

DF-75 provides the staple, punch and double-sided stitching
print functions.

Browse File > Print. The Print dialog box will be dis-
played.

Print 2]

Printer
[Hame: |($ Kyocera Mita F5-9100DN KX 'F i Properties |
Skatus: Idie 2
Type: Kyarera Mika FS-910000 KX
Where: LPTL: ™ Print to file
Comment: ™ Manual duplex

~Page rangs rCopi
o al Murnber of copies: 1 = 4
" Current page = Selection

 pages: I 11 ¥ Collate
Enter page numbers andfor page ranges '

ceparated by commas, For example, 1,3,5-12

Prink what: m Zaom
Pages per shest: 1

Print: All pages in range - 085 per s I page ‘I

Scale to paper size: INQ Scaling 'I

Options. .. oK Close

Click on the Name drop down list, all the printers in-
stalled under Windows are listed. Select Kyocera Mita
FS-9100DN KX or Kyocera Mita FS-9500DN KX.

Select the range of the pages you want to print in the
document, All or Current page only in Page range.
To print part of the document, check Pages, then enter
page numbers separated by commas.

Specify the number of copies you want to print in the
Number of copies combo box in Copies.

Click the Properties button and then click the Output
tab.

Click on the Output to drop down list. Select Finisher
[Face-down] or Finisher [Face-up]. To use the staple
or punch function, select [Face-down].

Kyocera F5-9100DN KX Properties B
Media | Layout] Imaging Dutput | about |
Dutput to; Copies:
Finishing Options:
F Cgllate .!.! .!.!
I | eyerse Page Order
X -  lppen Left
Staple 4= e Hight
; | Boaklet
™ Difset
€1 2ol
™ Punch 1 2l
1 e
Job Settings.

o6 | Cancel Help

Finishing Options

Collate: sets whether the pages are collated or
not.

Reverse

Page Order: prints in the reverse page order.

Staple: selects the staple position: Upper Left,
Upper Right or Booklet (stitching posi-
tion).

Offset: outputs pages while shifting them alter-
nately for each document.

Punch: selects the hole punch type: 2-Hole, 3-

Hole or 4-Hole.

Click the Layout tab, check the Booklet Mode check-
box, and then select Left Edge Binding or Right Edge
Binding.

Kyocera F5-3100DN KX Properties 7]

Medi @D aging | Output | About |

Fages penbhest |2 =l | EintEorders

Layaut: | |
Sealing (20 - 500%); [IIE il

¥ | Fiintior Bt Sides [DUplE7);
£l o (Lo Edge
') Fl o Siort Edge

¥ EBooklet Mode:
@ Left Edge Binding
 Right Edge Binding

® %E!’E Riestors Detaks
0K | Caedd | Hep |

l kyocera FS-9100DN KX Properties B

Click the Media tab, and then click on the Page Size
drop down list. Select the proper page size. A5 was se-
lected for the following example.

@' ayout | Imaging | Dutput | About |

Page Size: A4 - 210 % 297 mm

BE
& Portrat
I™ Rotated
© Landscape

Souce: | Auta Source Selection n
Media Type: | Auto Media Selection [

Settings... | Restore Defauts |

0K | Caed | Hep |

3-8
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9 Select Same as Page Size in the Print Size list, and
then click the OK button.

Kyocera Mita FS-9100DN KX Properties (7] x]

Medi | Lapout | Imaging | Prologue/Epique | Duput ] Abaut |

Page Size: Letter - 86111 in

Letter - Custom

Print Size: Letter-8.5x 11 in.

~

™ Rotated

Saurce: | Auto Source Selection B
Media Type | &uito Media Selection 2

Y KYOCER

Fistore Defauits |

QDK ) concel | Help |

seltings.. |

NOTE

When printing with the different print size from the page
size, select the desired size in the Print Size drop down
list.

When printing using non-standard size paper, See Cus-
tom Size Settings on page 3-3.

1 0 Once you finish making paper size settings, the Print
dialog box is displayed again. Click the OK button to
start printing.

Print 7]
[Prinker
Mame: | i kyocera Mita FS-91000M KX =l .Properties |
Status: Idie
Type: Kyocera Mika FS-91000N K#
Where: LPT1: I Print to file
Comment: ™ Manual duplex
FPage rang ~Zopi
& al Number of copies: 1 =
" Current page € Selection
™ Pages: 11 [¥ Callate:
Enter page numbers and/or page ranges '
separated by commas. For example, 1,3,5-12
Print what: |Document sl NEEE
. Pages per sheet! 1 vI
Prink: All pages in range - BEBEErEL page
Scale to paper size! Mo Scaling -
Options... I m Close

Settings made from applications are not saved when
the application is closed. The default settings are re-
stored when the application is opened the next time. To
change the printer driver default settings, make printer
settings from Windows.

3.6 e-MPS

e-MPS provides the following three types of functions.
» Job Retention
« Virtual MailBox
» Code Job (Temporary and Permanent)

If you use any of the e-MPS functions, you can quickly multiple
prints with one document data stored in the hard disk, saving you
more times than performing the same printing several times.

Job Retention

This function allows you to save print jobs to the option hard disk
and print them out as desired at the operator panel.
When printing, select a Job Retention mode at the printer driver.

The following four modes are available:
* Quick Copy Printing See page 3-10
* Proof and Hold Printing See page 3-11
* Private Printing See page 3-12
« Job Storage Printing See page 3-13

For how to make the settings, see the pages of the respec-
tive modes.

Four Job Retention modes have the following benefits:

* Quick Copy: When you need another copy of a finished print
job, you can print it out at the printer operator panel. There is
no need to print from the computer again.

* Proof and Hold: When printing multiple copies, this mode first
prints only one copy for proofing, allowing you to decide
whether to continue printing the remaining copies or cancel
printing at the operator panel. In this way, you can reduce the
waste of paper.
Private Print: Confidential print jobs can be printed out when
you are at the printer. This mode saves print jobs in the printer
without printing until you instruct the printer to do so at the op-
erator panel. Printing using this mode requires the 4-digit ac-
cess code you set using the printer driver.
Job Storage (Stored Job): This mode allows you to store
print jobs that are frequently needed, such as fax cover pages,
checklists, and order forms, for printing later. Using the opera-
tor panel, you can then print them out as required at anytime
and at any number of copies. You can set the 4-digit access
code, if necessary.

Virtual MailBox

Virtual mailbox is the ability to store print jobs in the virtual mailbox-
es on the hard disk, enabling you to retrieve and print it later from
the printer’s operator panel or the option barcode reader (BC-1).

You can later print out only the jobs you desire using the operator
panel on the printer.

When printing, make the settings at the printer driver. For how to
make the settings, see Using Virtual Mailbox Printing on page 3-
15.

You can send a print job either to all the virtual mailbox trays at
the same time or to the desired trays only.

Since you perform printing by selecting the desired trays using
the operator panel, you can print out only the jobs you desire.
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Code Job (Temporary and Parmanent)

Code Job reduces the time to print multiple copies and enables
the use of option barcode reader (BC-1) to print jobs stored on
the hard disk.

When printing, select a type of code job at the printer driver. The
following two types of code jobs are available:

» Permanent Code Job

» Temporary Code Job
For how to make the settings, see Using Code Job on page 3-
18.

You can print out frequently needed print jobs, such as fax cover
pages, checklists, and order forms, using the option barcode
reader.

If you store a print job and print it out with a barcode ID attached,
you can print that job any time later by simply reading the bar-
code ID. You can print a list of code jobs at the operator panel.
There are two types of code jobs: permanent code job and tem-
porary code job. When the storage memory becomes insuffi-
cient, temporary code jobs will be automatically deleted in order
from the oldest and permanent code jobs will not.

3.6.1 Using Job Retention

Quick Copy Printing

This allows you to print as many additional copies as you want
until the printer is turned off, it is useful in cases such as when
there are sudden increases in the required number of copies
during a meeting.

To print, proceed as follows.

1 Browse File > Print. The Print dialog box will be dis-
played.

Print 2]
[Printer
Mame: I 3 Kyocera Mita F5-21000H KX j Froperties
Status: Idle
Type: Kyocera Mita FS-9100DN Kx
Where: LPTL: I Print to file:
Camment: ™ Manual doplex
~Page rang rCopie
= gl Mumber of copies: |[| E‘
™ Current page = Selection
£~ pages! | W cCollate
Enter page numbers and/or page ranges
separated by commas. For example, 1,3,5-12

Print what: |Document ~| Zoom

Pages per sheet: Il a0e hd
Print: Al pages in range - e pag

Scale ko paper size:  [Ma Scaling -
Options. .. Cancel

2 Click on the Name drop down list, all the printers in-
stalled under Windows are listed. Select Kyocera Mita
FS-9100DN KX or Kyocera Mita FS-9500DN KX.

Print 7]
[Printer
[ame: 5 Kyocera Mita FS-91000M KX - Eroperties |
Status: @ Acrobat Distiller =
Types ot PO YrteT )
Where: — T o ™ Print to file
Comment: [ Manual duplex
~Page range—| =
Lo TIOMBEr oF COpIES T |1 E‘
£ Currgnt page £ Sglection
£ Pages: I # # ¥ Collate
Enter page numbers and/or page ranges ' '
separated by commas. For example, 1,3,5-12
Prirt what:  |Document - | Zoom

. Pages per sheet: Il
Prink: 4l pages in range = 955 per = page z
Scale to paper size: IND Scaling hd

Cancel

Options. .,

3 Select the range of the pages you want to print in the
document, All or Current page in Page range. To print
part of the document, check Pages, then enter page
numbers separated by commas.

4 Specify the number of copies you want to print in the
Number of copies combo box in Copies.

5 Click the Properties button. The Properties dialog box
is displayed. Click the Output tab and then click the
Job Settings button.

Kyocera Mita FS-9100DN KX Properties

Media | Lapaut | Imaginf About |

Output to Copiss:

3

Finishing Otions:

I Callate ﬂ ﬂ

lob Setings.. |

oKk | cencel | hHep |

Fizstore Dereuts. |

3-10
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The Job Settings dialog box will appear.

ki 3

Job Setti

I b Storage feHPSE

) Temmarary

) Eermanent:
it B BRI HE]
& Guick Copy

=1 Fioof and Held

) Fiivate Print

) /b Storage

A% Ennlication Defined

) Custom

6 Check the Job Storage checkbox and then check the
Quick Copy.

Job Settings H 3

(I ob Stoiags [=MPS]

‘@Eﬁ

® TopaEp

" Permanent:

o it S IE G (V]
" Procf and Held

" Private Print

€ Joh Stogage

i~ Job Nam

" Application Defined

" Custom:

7 Click the OK button. The Print dialog box is displayed
again. Click the OK button to start printing. The print
job will be saved to the hard disk as it is printed.

If additional copies are required, print using the Quick
Copy sub menu in the e-MPS menu at the printer oper-
ator panel. For details, see Chapter 3 in the Operation
Guide.
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Proof and Hold Printing

You can check the first copy before printing the remaining cop-
ies, paper wastage can be avoided. The print jobs will be deleted
when the printer is turned off.

To print, proceed as follows.

1 Browse File > Print. The Print dialog box will be dis-

played.
[ K
Printer
[Hame: |($ Kyocera Mita F5-9100DN KX =l i Properties |
Status: Idle
Type: Kyacera Mita FS-91000M KX
Where: LPTL: ™ Print to file
Comment: ™ Manual duplex.
~Page rangs rCopi
o al Mumnber of copies: 1 5‘
" Current page  Selection
 pages: I qﬁ ¥ Collate
Enter page numbers andfor page ranges '
separated by commas, For example, 1,3,5-12

Prink what: m Zaom
Pages per shest: 1

Print: Al pages in range - BEELEr e page -

Scale ko paper sizéi | No Scaling =

Options. .. oK I Close

2 Click on the Name drop down list, all the printers in-
stalled under Windows are listed. Select Kyocera Mita
FS-9100DN KX or Kyocera Mita FS-9500DN KX.

Print 2]

[Printer

Mame: 3 Kyocera Mita F5-2100DH KX - Properties |

Sratus: @ icrobat Distiler -

rrTohatPORET

Type: i )

Where: e M- b [ Print to file:

Camment: ™ Manual doplex
Page range—| -

= gl TUTIFETESF O CAieEsT 1 E‘

™ Current page = Selection

£ Pages: I @ @ ¥ Collate

Enter page numbers and/or page ranges ' 1

separated by commas. For example, 1,3,5-12

Prirt what:  |Document - | Zoom

. Pages per sheet: Il
Print: All pages in range hd Bl page u
Scale to paper size: IND Scaling hd

Options. ., Cancel

3 Select the range of the pages you want to print in the
document, All or Current page in Page range. To print
part of the document, check Pages, then enter page
numbers separated by commas.

4 Specify the number of copies you want to print in the
Number of copies combo box in Copies.
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Click the Properties button. The Properties dialog box
is displayed. Click the Output tab and then click the

Job Settings button.

Kyocera Mita F5-3100DN KX Properties

Media | Layout | Imagin About |

Output to Copies:

B
ER
W Callate ].! ﬂ

Frinter Default

o KYDCERD

0k | Cancel | Hep |

reseneae|

The Job Settings dialog box will appear.

ki 3

I b Storage feHPSE

) Temmarary
) Eermanent:
)it A B o (V]
& ek Copy

7 Click the OK button. The Print dialog box is displayed
again. Click the OK button to start printing. The print
job will be stored to the hard disk as it is printed.

The printer will first print only one copy if you set to
print multiple numbers of copies, allowing you to check
the printouts. If there is no problem, resume printing
the remaining copies using the Quick Copy sub menu
in the e-MPS menu at the printer operator panel. For
details, see Chapter 3 in the Operation Guide.

Private Printing

You need to enter a password to retrieve the job, confidentiality
is assured even if you share the printer with others. Print jobs will
be deleted when they are printed or when the printer is turned
off.

To print, proceed as follows.

1 Browse File > Print. The Print dialog box will be dis-

=1 Fioof and Held
) Fiivate Print
) /b Storage

A% Ennlication Defined

) Custom

—

played.
Print
[Printer
Mame: | 8 yacers Wik F5-91000M K2 =1 Properties
Status: Idle
Type: Kyocera Mita F3-91000M Kx
Where: LPTL: ™ Print to file
Comment:
~Page rangs Copi
o al Humber of copies: B
© Current page " Selection
 pages: | ¥ Callate
Enter page numbers andjar page ranges
sepatated by commas. For example, 1,3,5-12
Print what:  [Document = e
. Pages per sheet: 1 -
Prink: Al pages inrange - EBEEraL page
Scale to paper size! |mo Sicaling A
Optians. .. Cancel

2 Click on the Name drop down list, all the printers in-
stalled under Windows are listed. Select Kyocera Mita
FS-9100DN KX or Kyocera Mita FS-9500DN KX.

Check the Job Storage checkbox, and then check the
Proof and Hold.

Job Settings 2l
Print 7]
¥ Job Storage [e-MPS) v
’ﬁ — [ame: 5 Kyocera Mita FS-91000M KX - Eroperties |
L& [: =i - 58 fcrcbat Dstler =
D Trpe: . [1liks F3-010000 kX
Wwhere: TTerS S Fo-ToUUnT T, [ Frint to il
" Temporary Comment: [ Manual duplex
" Bermanent: ekl e
B Lo TIOMBEr oF COpIES T 1 E‘
Vittual = B oA HE] £ Currgnt page £ Sglection
€ Buick Copy  Pages: 11 11 W Collste
Enter page numbers and/or page ranges ' '
separated by commas. For example, 1,3,5-12
" Private Print
" Job Storage Print what! [Document = N
. Pages per sheet: I
Print: All pages in range hd Bl L page u
—Job Mams Scale to paper size: [1a Scaling -
" Application Defined
i Custom: Options. .. Cancel

3 Select the range of the pages you want to print in the
document, All or Current page in Page range. To print
part of the document, check Pages, then enter page
numbers separated by commas.
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4
5
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Specify the number of copies you want to print in the
Number of copies combo box in Copies.

Click the Properties button. The Properties dialog box
is displayed. Click the Output tab and then click the
Job Settings button.

Kyocera Mita F5-8100DN KX Properties HE

Hedia | Layout | Imagi boutl

Output fo: Copies:

-

Fiishing Options:
W Cglats ﬂ ﬂ

Frinter Default

0K | Caed | Hep |

i |

The Job Settings dialog box will appear.

Job Settings 7]

) Temmarary

) Eermanent:

4= it ol Bl [VHE]
& Huick Copy

=1 Fioof and Held

) Fiivate Print

) /b Storage

A% Ennlication Defined

) Custom

Check the Job Storage checkbox, and then check the
Private Print.

Job Settings 7] %]

¥ Job Storage [=-MPS)

" Temparary
" Permanent:
o it S IE G (V]
" Quick Copy

7 Proof and Hald

g Access Code:
1~ Job Storage oooo
i~ Job Nam
" Application Defined
" Custom:

Set the desired 4-digit access code using any numbers
between 0 and 9. This number is synonymous with the
user ID which is required to enter at the printer opera-
tor panel when retrieving.

Click the OK button. The Print dialog box is displayed
again. Click the OK button. The print job will be stored
to the hard disk without printing.

To print, use the Private/Stored sub menu in the
e-MPS menu at the printer operator panel. For details,
see Chapter 3 in the Operation Guide.

Job Storage (Stored Job Printing)

Select this if you want to store frequently needed print jobs, such
as forms, to print them later as required. The print jobs will not

be deleted when the printer is turned off.

To print, proceed as follows.

1 Browse File > Print. The Print dialog box will be dis-

played.
Print K
rPrinter
Hame: I 5 Kyocera Mita F5-9100DN KX LI Eroperties
Status: Idle:
Type: Kyocera Mita FS-3100DM KX
where: LPT1: ™ Print to file
Comment; I manual duplex
rPage rangs rCopi
& all Murnber of copies: =
€ Current page € Selection
" Pages: IV Collate
Enter page numbers andfor page ranges
separated by commas. For example, 1,3,5-12

Print what: IDntument | [Zoom
Pages per sheet: 1

Print: |A\| pages in range - 1955 per s page vl

Scale ko paper sizge: | o Scaling 'I

Options... Cancel

Click on the Name drop down list, all the printers in-
stalled under Windows are listed. Select Kyocera Mita
FS-9100DN KX or Kyocera Mita FS-9500DN KX.

Print 2]
[Printer
Mame: 3 Kyocera Mita F5-2100DH KX - Properties |
Sratus: @ Acrabat Distiler -
Type: AR )
Where: o et “ [ Print to file:
Camment: ™ Manual doplex
Page range—| -
= gl TUTIFETESF O CAieEsT 1 E‘
™ Current page = Selection
£ Pages: I @ @ ¥ Collate
Enter page numbers and/or page ranges ' 1
separated by commas. For example, 1,3,5-12

Print what: |Document ] [Zeom
. Pages per sheet: Il

Prink: 4l pages in range = 955 per = page z

Scale to paper size: IND Scaling hd

Options. ., Cancel

Select the range of the pages you want to print in the
document, All or Current page in Page range. To print
part of the document, check Pages, then enter page
numbers separated by commas.



Chapter 3 Printing Through Application Software

Specify the number of copies you want to print in the
Number of copies combo box in Copies.

Click the Properties button. The Properties dialog box
is displayed. Click the Output tab and then click the
Job Settings button.

Kyocera Mita F5-9100DN KX Properties

Media | Layout | Imagi bout |

Copies

-
Fiishing Options:
| Colate .!.H .!.H

JobSeltings.. |

0K | Cancd | Hep |

rerenzE|

The Job Settings dialog box will appear.

Job Settings 7] x|

) Temmarary

) Eermanent:

4= it ol Bl [VHE]
& Huick Copy

=1 Fioof and Held

) Fiivate Print

) /b Storage

A% Ennlication Defined

) Custom

Check the Job Storage checkbox, and then check the
Job Storage.

Job Settings 7] %]

—————————
(¥ Job Stoiage [MPS)

oha)

" Temparary

" Permanent:

o it S IE G (V]
" Quick Copy

" Procf and Held

" Private Prirt ™ Access Code:
 Hph Storong Haow
~Job N,
" Application Defined
" Custom:

7

You can add security to the print job. To do so, check
the Access Code checkbox and enter the desired 4-
digit access code using any numbers between 0 and 9.
You must enter this number at the printer operator pan-
el when printing.

Job Settings

¥ Job Starage [e-PS)

oS-

£ Temporary
" Permanent

O [ ittuasl I i B (B

" Quick Copy
£ Pracf and Hold
£ Private Print v iccess Code
& Job Stopage ((|oom
~Job Mam:
& Application Defined
€ Custam; I

Click the OK button. The Print dialog box is displayed
again. Click the OK button. The print job will be stored
to the hard disk without printing.

To print, use the Private/Stored sub menu in the

e-MPS menu at the printer operator panel. For details,
see Chapter 3 in the Operation Guide.
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3.6.2 Using Virtual Mailbox Printing

NOTE

The VMB function is available only when PCL 5e or PCL XL is
selected as emulation.

Virtual mailbox is the ability to store print jobs in the virtual mail-
boxes on the hard disk, enabling you to retrieve and print it later
from the printer's operator panel or the option barcode reader
(BC-1). A maximum of 255 virtual mailboxes can be set up, mak-
ing it possible to allocate documents not just for individual de-
partments or groups, but even for individual people. The print
jobs will not be deleted when the printer is turned off.

B Before Using VMB

To use the VMB functions, select PCL XL or PCL 5e and then
set the Mailbox Name and Virtual Output Tray beforehand.
Follow these procedures.

1 Browse Start > Settings > Printers.

i JS[=1E3
Fle Edt View Go Favoies Hep |ﬁ
™ »
« 5w B3| w
Back  Forend Up C Cop  Paste | Undo
Address [[) Printers =l
T3
= '
AddPirler  Aoiobal  Aciobal  Kyocera
: Disler  PDFwiler  FS9100
Printers
i folder Kyscera bits

information about F5-31000.

your current
printers and &
wizard to help
you install new
ones.

To get
information about
a printer that's
already installed,
right-click the
printer's icon,

|

2 Right-click on the Kyocera FS-9100DN KX, and then
select Properties.

i -[Of]
Fle Edt View Go Favoites Help ‘ﬁ
« = G| ¥ S| @
Back | Formd Up Tt Copy  Paste | Undo
Address [[3) Printers =l
@
v o
LddPrinter  Acrobat Acrobat =Beh
Printers Distiler  PDFwiiter Pause Frining
L i Sat a5 Defaul
B corn F5- Purge Prirt Dacuments
Kyocera Mita
P100DN KX F5.5100D Shaiing
Gocuments: 0 Create Sharteut
Delste
Fiename

=) Displays the properties of the selected items.

3 Select the Device Settings tab.
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Click the User button.

The User Settings dialog box is displayed.

Kyocera F5-9100DN KX Properties 7]

General| Detais | Color Management | Shaiing | Media | Layout | Imaging | Output Devies Settings | Apout |

Device Dptions:

Pap: ssatte 1. 2]
CIPaper Feeder [Cassette 3, 4)
CLarge Capaciy Feeder
CFinicher.

CIRAM Disk.

User Settings

Memar: ,Wﬂ
Admiistrator, (Y |

[2[x]

— User Name: |
JI= —

[~ Page Desciiplion Language

PLLXL ~] I~ GDI compatible mode

Vit

=

Select PCL XL or PCL 5e in the Page Description

Language drop down list.

User Settings 2] %]

User Hame
Dipartment:

~Page Desoiption Languag

PCLEL ~| I GDI campatible mode
T
KFDL

Double-click Hard Disk in the Device Options list.

Kyocera F§-3100DN KX Properties

General | Detais | Color Management | Sharing | Media | Layout | Imaging| Output  Device Settings |Abuul|

Device Options

S

W Paper Feeder [Cassette 1, 2)
DIPaper Feeder [Cassette 3, 4]
[DLarge Capacity Feeder
OFinisher

L‘ Memary;
Ldmivistrater FH Dsk

0] KYOCERE

oK | Concel Sl

Help

The Hard Disk Settings dialog box will be displayed.

Hard Disk Settings EE

~ Virtual Mail Bow (¥ME)

Mailbow Mame: Defined Names:

Virtual Dutput Tray:

—_

Enter iay numbers and/or biay ranges
separated by commas.
For example: 1, 3,512

DEEE Save

Coree
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Enter the mailbox name under Mailbox Name, and the
tray number in the Virtual Output Tray, and then click
the Save button.

Hard Disk Settings 2[x]

~Vitual Mail Box [VMB]

Mailoo Hare: Defined Names:

Kyoceratitant

Virtual Dutput Tray:

(e —

Enter ray numbers andfor tray ranges
separated by commas,
For example: 1,3, 5

NOTE

The Multiple virtual mailbox tray number can be speci-
fied at a time using commas (,) and hyphen (-).

The Mailbox Name will be displayed in the Defined
Names list box.

Hard Disk Settings [x]

[~ Wintual Mail Box [VMB)
Mailbiox Mame: Defined Mames:

[ ([kyosers-Hital )

Wirtusl Output Tray:

——

Enter hay numbers and/or bay ranges
separated by commas
For example: 1.3, 512.

oo

" goma

Click the OK button to quit the Hard Disk Settings dia-
log box.

In the Kyocera FS-9100DN KX Properties dialog box,
click the OK button.

Click the X button in the upper-right side of the dialog
box.

To print, proceed as follows.

B Using VMB Printing

1

Browse File > Print. The Print dialog box will be dis-
played.

Print K

rPrinter
Properties

Hame: | <S8 kyocera Mita F5-9100DN K =l

Status: Idle:

Type: Kyocera Mita FS-9100DM KX
where: LPT1:

Comment;

I™ Print to File
I manual duplex

rPage rangs rCopi
& all Murnber of copies:
€ Current page € Selection
" Pages: l— ¥ Collate
Enter page numbers andfor page ranges
separated by commas. For example, 1,3,5-12
Print what: IDntument | [
Pages per sheet:
Prink: IA\I pages in range hd LS

1 page 'I
Scale ko paper sizge: | o Scaling VI

Cancel

Qptions. .,

Click on the Name drop down list, all the printers in-
stalled under Windows are listed. Select Kyocera Mita
FS-9100DN KX or Kyocera Mita FS-9500DN KX.

Print 7]

[Printer
Mame: 58 Kyocera Mita F5-0100DM KX

-
@ Acrobat Distiller =
O FOFTVTIET )

Properties |

Skatus:
Type: (
Where:

Comment:

™ Print to file
[ Manual duplex

(|
11 ¥ Collate

e Pt

~Page range—|
Lo TIOMBEr oF COpIES T
£ Currgnt page £ Sglection
£ Pages: I— @

Enter page numbers and/or page ranges
separated by commas. For example, 1,3,5-12

Print what! [Document =] [Foom
. Pages per sheet:
Print: All pages in range hd e

Il page |
Scale to paper size: IND Scaling hd

Cancel

Options. .,

Select the range of the pages you want to print in the
document, All or Current page in Page range. To print
part of the document, check Pages, then enter page
numbers separated by commas.

Specify the number of copies you want to print in the
Number of copies combo box in Copies.
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5

3-17

Click the Properties button in the Print dialog box. The
Properties dialog box is displayed. Click the Output
tab and click the Job Settings button.

Kyocera Mita F5-9100DH KX Properties HE

Media | Lapout | \mag\r\boul |

Output to: Copiss:

Firisting Optiors

¥ Clate !] @

Printer [ etault

€ KYDCERE () Restoe Defos_|

oKk | cencel | hep |

The Job Settings dialog box will appear.

Job Settings EHE

T dsbsiarage [EHPS]

) Tempoary.

=1 Bermancht,

£ Wil et oz (AB]
4% ok Copy

£ st e Lold

£ Brivate Frinh

LGt iage

ok

451 Lpplication Defned

= Bustor

Check the Job Storage checkbox, and then check the
Virtual Mail Box [VMB].

Job Settings EHE

[ ¥ Jab Storage (e-MPS)

Ql-=-7n

" Temporary

1 Permanent:

£ Niriual Mal Bos MHER
£ Quick Copy
 Proof and Hold

" Private Print
€ Job Stopage Selection.
~dob

% Application Defined

" Custom:

Click the Selection button. The Virtual Mailbox Se-
lection dialog box will appear. Select one or more mail-
boxes from the list of Defined Names.

21|

¥ Job Storage [e MPS)

El-=-Ja

 Temporaty

" Pemmanent
 Wirtual Mail Bow (VMB)
" Quick Copy

" Proot and Hold

 Pigate Print

 Job Stojage ( Selection. >

Virtual Mailbox Selection 7| %

Defined Names:

[ Job Name

& Application Defined
F
 Custom: Farold

Cance

Click the OK button. The Print dialog box is displayed
again. Click the OK button. The print job will be stored
to the hard disk without printing.

To print, use the Print VMB Data sub menu in the
e-MPS menu at the printer operator panel and specify
the virtual mailbox numbers. You can also print the list
of virtual mailbox trays. For details, see Chapter 3 in
the Operation Guide.
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3.6.3 Using Code Job

A unique number and barcode is automatically assigned to each
job as it is stored on the printer. The number appears when jobs
are listed in utilities such as KM-NET Printer Disk Manager or
KM-NET VIEWER. The number is also printed, together with its
barcode, on the code Job List. The code Job List can be printed us-
ingthe 1ist of Code Job menu of the printer. Barcode printing
jobs will be displayed as code jobs on the printer operator panel.

The barcode and number can also be printed on the original doc-
ument that is printed when the job is stored on the hard disk. This
barcode can be printed on the first page as a code for the whole
document, or on every page, so that each individual page of the
document can be accessed with the barcode reader.

To print, proceed as follows.

1 Browse File > Print. The Print dialog box will be dis-

played.
Print 2]
rPrinter
Name: [ <8 kyocera Mita F-9100DM Kx =1 Properties
Status: Idle
Type: Kyocera Mita F3-91000N KX
‘Where: LPTL: ™ Print to file
Comment: ™ Manual duplex
[Page rang: [Capi
Lo Number of copies: |[| 5‘
£~ Current page £~ Selection
£ Pages: I W cCollate
Enter page numbers and/or page ranges
separated by commas, For example, 1,3,5-12
Print what: |Document = |
. Pages per sheet: I -
Ptint: Al pages in range - 955 Rer S L page
Stale ko paper size: ||\|E| Scaling -
Options. .. Cancel

2 Click on the Name drop down list, all the printers in-
stalled under Windows are listed. Select Kyocera Mita
FS-9100DN KX or Kyocera Mita FS-9500DN KX.

Print 2] x]
rPrinter
Mame: < Kyocera Mita F5-91000M KX = Propertizs |
Status: @i Acrobat Distiller -
robEtFEFriter
Type: )
‘Where: " ™ Print ko file
Tkt B
Cormment: ™ Manual duplex
(Page range | =
i« al HUmGer of Copiest ]t 5‘
i~ Current page 1~ Selection
" Pages: 11 11 ¥ Callate
Enter page numbers andfor page ranges 1 1
separated by commas, For example, 1,3,5-12
Print what: | Document VI e
. Pages per sheet: 1 -
Print: Al pages in range VI 1955 L S page
Scale to paper size! [Mo Scaling -
Options... | Cancel |

3 Select the range of the pages you want to print in the
document, All or Current page in Page range. To print
part of the document, check Pages, then enter page
numbers separated by commas.

4 Specify the number of copies you want to print in the
Number of copies combo box in Copies.

5

Click the Properties button. The Properties dialog box
is displayed. Click the Output tab and click the Job

Settings button.

Kyocera Mita F5-9100DN KX Properties

Media | Layout | Imaginf]

DOulput to

Finter Default

Copies:

4

Finishing Options

F Callste

[

Job Setfings.._ |

ia el

Help

The Job Settings dialog box will appear.

Job Sellings

6 —— ok Storage e hiPE}

) Temmarary

) Eermanent:

& [0k Gy

) Fiivate Print
) /b Storage

)it A B o (V]

%) Bioof and Hold

ki 3

) Custom

A% Ennlication Defined

—

Check the Job Storage checkbox and then the Tem-
porary or Permanent radio button.

When using the option barcode reader, click the Op-

tion button.

The Job Storage Option dialogbox will appear

Job Storage Dptions

% | Bririt i first page. arily

| Britit ari 2l pages.

I= | Frint Barcads 1D

Fosition

LIpper Left vl

[riestatr

Horizontal [Picket Fence] 'I
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Check the Barcode checkbox, and then do the set-
tings.

Job Storage Options 7] %]

IV {Haicndd

" Print on first page only

™ Print Barcode |D
" Piint on all pages »
Position:

D Upper Left ~

Orientation

Haorizantal [Picket Fence] -

9 Set whether or not to print the barcode on the printouts.
The barcode can also be printed in various positions on
the page, with or without its code number as shown
here by selecting its position in the printer driver.

Lower right Lower right Upper right Upper right
(horizontal) (vertical) (vertical) (horizontal)
I
1 2 3 4
T =
Upper left Upper left Lower left Lower left
(horizontal) (vertical) (vertical) (horizontal)
I
5 6 7 8
LTI

1 0 Click the OK button. The Print dialog box is displayed
again. Click the OK button to start printing. The print
job will be stored to the hard disk as it is printed.

The option barcode reader can be used to reprint the

document by reading the barcode from the Job List or
from the original document.
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